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Preface

The Oracle MICROS Simphony Cloud Service, Essentials Edition, is the point-of-sale solution
for small- and medium-sized restaurants.

Purpose

This Configuration Guide explains the setup of Simphony Essentials using the Enterprise
Management Console (EMC) and Simphony Home.

Audience

This document is intended for system administrators of Simphony Essentials.

Customer Support

To contact Oracle Customer Support, access the Customer Support Portal at:

https://iccp.custhelp.com/

When contacting Customer Support, please provide the following:

• Product version and program/module name

• Functional and technical description of the problem (include business impact)

• Detailed step-by-step instructions to re-create

• Exact error message received and any associated log files

• Screen shots of each step you take

Documentation

Product documentation is available on the Oracle Help Center at https://docs.oracle.com/en/
industries/food-beverage/.

Revision History

Date Description of Change

September 2021 Initial publication for Release 19.3.

September 2022 Updated publication for Release 19.4.

October 2022 Updated Enable Fiscal Reports.

November 2022 Updated Preface and Add a Workstation.
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Date Description of Change

January 2023 Created new chapter called Paid In and Paid
Out Operations, and moved the following topics
out of the Payments chapter and into this new
chapter:
• Create Tender/Media Records
• Create Pickup Reasons
• Create Loan Reasons
Added Enable a Third Party Mobile Device
Management (MDM) to Distribute Simphony
POS Client Software to the Hardware chapter.

March 2023 Updated publication for Release 19.5.

April 2023 Added New Locations chapter.

June 2023 Re-organized and updated chapters 1 through
11.

January 2024 Updated publication for Release 19.6.

May 2024 Added the following topics to the Personnel
chapter:
• Labor Management
• People Management
• Add a Person
• Grant Access to Point of Sale Operations
Updated Personnel and Create Employee Roles
and Grant Privileges.

September 2024 Updated publication for Release 19.7.

February 2025 Updated publication for Release 19.8.
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1
System Overview

Simphony Essentials supports the Point-of-Sale (POS) client devices listed in the following
table. The Microsoft Windows operating system is not supported on a POS client device for
Simphony Essentials.

Table 1-1    Supported Workstations

Property Client Device Operating System

Oracle Linux MICROS Compact Workstation
310

Oracle Linux for MICROS

Oracle Linux MICROS Workstation 6 Series Oracle Linux for MICROS

Oracle Linux MICROS Workstation 8 Oracle Linux for MICROS

Table 1-2    Supported Peripherals

Peripheral Device Operating System

Adyen Castles S1F2 (SATURN1000) payment
device

Android Version 10.0

Android Tablets/Phones Android Versions 10.0, 11.0, and 12.0

Lenovo K10 Tablet Android Versions 10.0, 11.0, and 12.0

Oracle MICROS HH500 Android Versions 10.0, 11.0, and 12.0

Table 1-3    Kitchen Display Hardware

POS KDS Hardware Operating System

Oracle Linux MICROS Kitchen Display
Controller 210

Oracle Linux for MICROS

Oracle Linux MICROS Express Station 4 Series Oracle Linux for MICROS

Oracle Linux MICROS Workstation 625E Oracle Linux for MICROS
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2
Initial Setup Using Enterprise Management
Console (EMC)

The Enterprise Management Console (EMC) is the primary configuration application in
Simphony Essentials.

Download and Install the Enterprise Management Console
(EMC)

1. Sign in to the SimphonyApp website at https://[ServerName]/SimphonyApp. You will
need your Username, Company, and Password. If this is your first time signing in to
SimphonyApp, you will be prompted to change your password.

Figure 2-1    SimphonyApp Sign In Page

See Enterprise Management Console (EMC) Authentication for more information about
passwords.

2. After signing in, a red message prompts you to set up security questions if they have not
already been set. Click User Profile, and then complete the security questions.

2-1



Figure 2-2    User Profile Link

Figure 2-3    Security Questions

3. Click the Downloads link, and then select Enterprise Management Console (EMC).

Figure 2-4    Downloads Link

Chapter 2
Download and Install the Enterprise Management Console (EMC)

2-2



Figure 2-5    EMC Download Selection

4. Click Download to start the EMC client setup package download process.

It may take a moment for the download process to commence. This process downloads a
file called EMCSetup.exe.

5. After the download process is complete, run EMCSetup.exe to install the EMC client.

EMCSetup.exe contains all files required by EMC to function.

6. Select Yes for the question: Do you want this app to make changes to your device?

7. Leave the default option (Modify) checked, and then click Next.

Figure 2-6    InstallShield Wizard Welcome Dialog

8. Click Next on the Select Features dialog, leaving EMC Clent checked.

Chapter 2
Download and Install the Enterprise Management Console (EMC)
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Figure 2-7    

Files and libraries will be installed. The default installation path for the EMC client is
C:\Program Files\Oracle Hospitality.

9. Click Finish at the Maintenance Complete prompt.

10. The process will create an EMC desktop icon. Double-click the icon on the desktop to open
the EMC sign in page.

Enterprise Management Console (EMC) Passwords
Each user has a unique username and must enter it along with their valid password to access
the Enterprise Management Console (EMC). Passwords must adhere to the system’s
complexity requirements, as follows:

• The password must be a minimum of 8 characters and a maximum of 20 characters.

• The password must contain letters, numbers, and special characters like: ! " # $ % & ' ( ) *
+ , - . / : ; < = > ? @ [ \ ] ^ _ ` { | } ~

• The user must not choose a password equal to the last 4 passwords used.

Sign in to Enterprise Management Console (EMC)
1. To sign in to EMC, enter your User Name, Company, and Password, and then click Sign

In.

Chapter 2
Enterprise Management Console (EMC) Passwords
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Figure 2-8    EMC Sign In

2. If a newer version exists, EMC automatically downloads the latest files, and then updates
itself. A progress bar indicates the duration of the login and update operation. You will be
prompted to log in again after completion of the updates as shown in the following figure.

Figure 2-9    EMC Sign In After Updates

3. To sign out of EMC, select File, and then click Exit.

EMC Basics
This section describes the basic functions in EMC.

Chapter 2
EMC Basics
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EMC Configuration Hierarchy

The Simphony Essentials EMC has three areas that allow you to choose where to define
certain definitions and records in the EMC’s hierarchy tree. In EMC, modules are configured (in
order from highest to lowest) on the enterprise, property, or revenue center levels.

An employee’s assigned role determines whether users have full or partial access to specific
modules on certain levels.

EMC Home Page

After you sign in, EMC defaults to the Home Page. The Home Page shows a navigation tree in
the Locations pane based on the EMC levels. Modules appear to the right of the Locations
pane and filters based on the location you select from the Locations navigation tree.

Figure 2-10    EMC Home Page

You can use the filters beneath the Locations pane to easily search for properties and revenue
centers within an enterprise.

Figure 2-11    EMC Home Page Filters

Chapter 2
EMC Basics
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• Filter: Enter the name of a property or revenue center to filter the navigation tree.

• Coll: Click to collapse the navigation tree. If the navigation tree is collapsed when filtering,
the search returns the top most level. For example, when you search for a revenue center,
the navigation tree shows the property to which it belongs.

• Exp: Click to expand the navigation tree.

• #: Select to show the object number in front of properties and revenue centers in the
navigation tree.

EMC remembers each users state at the time of exit. Therefore, the next time you log in, the
EMC Home Page defaults to the location that was last viewed by you when EMC was closed.

Table View and Form View

Table view and form view are two views used to show information within modules.

Most modules open to table view, which is a grid view showing all records sorted by object
number. Typically, the first two columns are the object number and name of the record. Table
view is generally used when making bulk changes. When a record is changed, table view
highlights the record in yellow.

Form view shows the same content that is available in table view, but for a single record.
Depending on the data, sometimes form view shows more information than table view. For
example, the Employee Roles module, which contains only object number and name in table
view, contains several configurable tabs in form view. Form view includes a navigation bar that
shows the object number and name of each record available, making record-to-record
navigation easier. To navigate to a specific record, simply select the record within the
navigation bar and the corresponding form view tabs populate with the selected record’s
information.

Three methods are available for switching between table view and form view:

• Click the Toggle Table/Form View icon on the EMC toolbar.

• While in table view, double-click the Object Number column to open form view.

• While in form view, double-click the object number/name in the navigation bar to open
table view.

Module Record Filters

By default, most modules in EMC show all of the available records when opened. You can
remove unwanted records from view using the filters available in table view. The filters appear
above the table and is set to Show All Records.

Figure 2-12    EMC Filter Section in Table View

When records are filtered,

• Form view shows only the records that appear in table view. While in form view, the
navigation buttons (next, previous, first, and last) change to only the records that appear in
table view.

• The Option Bit Comparison Dialog shows only the records that appear in table view.

Chapter 2
EMC Basics
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The Menu Item Maintenance module provides additional filters for streamlining the records.
See Searching and Filtering Menu Items for more information.

Sorting Records

In EMC, you can sort records presented in tables by one of the columns. By default, records
are sorted by object number. To sort by another column, click the column header.

EMC Toolbar

EMC uses common controls that are familiar to most users. For example, the top of the screen
includes a menu bar with the standard File, Edit, and View options. Additionally, a number of
navigational icons are available on the toolbar.

The following table describes the icons on the EMC toolbar. You can also access the functions
performed by these icons within the menu bar.

Table 2-1    EMC Toolbar Icons

Toolbar
Icon

Name Function Available in
Table View?

Available in
Form View?

Refresh Performs a refresh of the data in the
current module.

Yes Yes

Close Closes the currently active module. Yes Yes

Close All Closes all open modules. Yes Yes

Location
Selector

Opens the current module in another
property or revenue center. This icon
is enabled only if you open a module
from the property or revenue center
level.

Yes Yes

Language
Translation

Opens the EMC Record Translation
dialog. This icon is enabled only when
the current GUI control is a
translatable text field.

Yes Yes

Print Opens a dialog that allows you to print
records from table view.

Yes No

Save Saves changes to records in the
currently active module. This icon is
enabled only when changes have are
made to the current module.
When you insert a new record to a
module, the application automatically
saves that record. To invoke this icon,
you must make initial entries or
modify an existing record entry.

Yes Yes

Save All Saves changes to records in all open
modules. This icon is enabled only
when any open module has its records
change.

Yes Yes

Chapter 2
EMC Basics
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Table 2-1    (Cont.) EMC Toolbar Icons

Toolbar
Icon

Name Function Available in
Table View?

Available in
Form View?

Insert Adds a new record to the module. This
icon is enabled only when the current
module supports the Insert
functionality and only when the
logged-in user has Employee Role
permissions to add new records to the
module.

Yes Yes

Delete Deletes records. This icon is enabled
only when the current module
supports the Delete functionality, and
only when the logged-in user has
Employee Role permissions to delete
records from the module.

Yes Yes

Distribute Distributes records. This icon is
enabled only when the EMC user is
associated with an Enterprise Role
with the option Distribute enabled,
and only when the current module
supports distribution.

Yes Yes

Copy Record(s) Copies records while in table view. Yes No

Undo/Redo Performs the undo/reload function.
You cannot undo the addition or
deletion of a record. EMC uses a
record-level undo, where all changes to
a single record are undone. You cannot
undo a previous change because the
flow and layout of EMC make this an
impractical option. The standard Ctrl+Z
functionality exists to undo changes to
a text field.
In the Employee Maintenance and
Menu Item Maintenance modules,
undo is available through the right-
click menu only.

Yes Yes

Paste Record(s) Pastes records while in table view. Yes No

Toggle Table/
Form View

Switches the current module between
table view and form view.

Yes Yes

First Record Navigates to the first record in the
module.

No Yes

Previous Record Navigates to the previous visible
record in the module.

No Yes

Next Record Navigate to the next record. No Yes

Last Record Navigates to the last record in the
module.

No Yes

Go To Opens a dialog that allows you to enter
an object number and navigate to the
specified record.

Yes Yes

Chapter 2
EMC Basics
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Table 2-1    (Cont.) EMC Toolbar Icons

Toolbar
Icon

Name Function Available in
Table View?

Available in
Form View?

Find Opens a dialog that allow you to find a
record based on text comparison in
any column.

Yes No

Go To Previous In some modules, go to links are
provided to quickly open other
modules.

N/A N/A

Navigation Bar Switches the visibility of the navigation
bar in form view.

No Yes

Change Location Information
One location, called Location 1, is already created in the Simphony Essentials organization.

To change information, such as name and address, for Location 1:

1. Select the Enterprise level, click Setup, and then click Properties.

2. Double-click the Location 1 property.

3. Change the information as needed.

4. Click Save.

Change Revenue Center Information
One revenue center, called Operations, is already created in the Simphony Essentials
organization. Only one revenue center per location is supported.

To change information, such as address, for Operations:

1. Select the property, click Setup, and then click RVC Configuration.

2. Double-click the Operations revenue center.

3. Change the information as needed.

4. Click Save.

Add Order Type, Order Channels, and Menu Levels to Revenue
Center

A default order type and default menu levels must be configured in the Operations revenue
center. There are two order types already created in Simphony Essentials: Dine In and Take
Out.

An order channel can be assigned to a revenue center, but an overall default is used if the
order channel is not configured for the revenue center. Managing Order Types and Channels
contains more information.

Chapter 2
Change Location Information
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Menu levels allow different prices for one menu item and determine which sales items are
available in a transaction. Defaults have been set up for Simphony Essentials called Main and
Sub. Introduction to Menu Levels contains more information.

To add order types, order channels, and menu levels:

1. Select the Operations revenue center, click Setup, and then click RVC Parameters.

2. Double-click the Operations revenue center.

3. On the General tab, select a Default Order Type, Default Order Channel, Default Main
Level, and Default Sub Level.

Figure 2-13    Select Default Order Type, Order Channel, Main and Sub Levels

4. Click Save.

Add a Workstation
Simphony Essentials supports up to five POS workstation client devices per location/property.
Simphony Essentials is supported on POS workstation client devices running Linux and
Android operating systems. The Microsoft Windows operating system is not supported on a
POS client device for Simphony Essentials.

1. Select the property, click Setup, and then click Workstations.

2. Click the Insert icon ( ) on the toolbar.

3. In the Insert Record dialog, enter the Record Name, and then click OK.

4. Double-click the new workstation record.

5. On the General tab, enter information in the following fields:

Chapter 2
Add a Workstation
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Table 2-2    General Workstation Settings

Field Description

Type Select the type of workstation from the drop-down list:
• 2 - Workstation Client: Workstations and Android

devices
Select this option for the Oracle MICROS Workstation 6
Series, the Oracle MICROS Workstation 310, and
Android devices.

• 3 - POSAPI Client: Simphony Transaction Services
• 7 - Castle S1F2: Adyen Castles S1F2 Android payment

devices

Language Select the default language of the workstation. This is the
language that appears on the workstation’s Sign On screen.
If an employee has a different default language set, the
employee sees their default language after signing in to the
workstation.

Log Verbosity Select the logging verbosity for the workstation. Select 0
(zero) for minimal logging. Higher log verbosity provides
more information in the log file, which may be helpful in
troubleshooting issues.

Workstation Class Select the service type:
• 1 - Table Service Restaurant: Workstations and larger

Android landscape tablet devices
• 2 - Quick Service Restaurant: Workstations and larger

Android landscape tablet devices
• 3 - Bar: Workstations and larger Android landscape

tablet devices
• 4 - Mobile Table Service Restaurant: Adyen Castles

S1F2 Android payment devices and smaller Android
portrait devices (such as mobile phones)

• 5 - Mobile Quick Service Restaurant: Adyen Castles
S1F2 Android payment devices and smaller Android
portrait devices (such as mobile phones)

If a workstation is incorrectly configured (for example,
Workstation Class 1 - Table Service Restaurant is selected
for a mobile phone device), the page Configuration Error
Incorrect Workstation Class configured appears before the
sign in page on the POS client device. This error also
appears on workstations and tablets if an incorrect
Workstation Class is selected. Workstations and tablets use
the non-mobile Workstation Classes. To resolve this error,
correct the Workstation Class, and then click Update
Database And Redraw Page on the POS Client device.
Alternatively, close the application on the device and
change the Workstation Class at a later time.

Enable Simphony Transaction
Services

These options become active after you select 3 - POSAPI
Client from the Type field. Select the appropriate option to
enable Simphony Transaction Services.

Database Update Frequency Enter the number of seconds for the workstation to receive
changes.
The value in this field overrides the Property Parameter’s
Database Update Frequency setting.

Chapter 2
Add a Workstation
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Table 2-2    (Cont.) General Workstation Settings

Field Description

Check Inactivity Timeout Enter the number of seconds before the workstation shows
the message (Do you need more time?), prompting the
workstation operator to cancel the transaction. When you
enter 0 (zero), the message does not appear.

Check Inactivity Dialog
Timeout

Enter the number of seconds that the workstation shows the
Inactivity dialog before automatically cancelling the
transaction. This field is inactive when you set the Check
Inactivity Timeout value to 0 (zero).

Report Timeout Enter the number of seconds the workstation waits for a
response from the Reporting and Analytics server before
showing a communication failure notice.

Offline Threshold Enter a number between 0 and 99 to represent the signal
strength percentage at which devices go offline. Devices will
go offline when the signal strength is at or below this
percentage value. For example, if the Offline Threshold is
set to 90 (90%), and the device’s current signal is 89%, the
device will go offline. When the signal is detected above
90%, the device reconnects online.

Reconnect Threshold Enter a number between 0 and 99 to represent the signal
strength percentage at which devices recover online after
being in an offline state. Devices will go online when the
signal strength is at or above this percentage value. For
example, if the Reconnect Threshold is set to 80, and the
device’s signal strength is 85%, the device will go online.

Service Host ID This field become active after you select 3 - POSAPI Client
from the Type field. Select the service host on which the
POS API client runs.

Address / Host Name Enter the IP address or host name of the service host where
the workstation application runs.

Subnet Mask Enter the subnet mask of the service host where the
workstation application runs.

Default Gateway Enter the default gateway of the service host where the
workstation application runs.

Is Windows Service Select this option to allow the service host to start as a
Windows service. The service host service starts on
Microsoft Windows startup with other Microsoft Windows
services. The workstation starts only when the workstation
operator signs on to the operating system.
If you select this option, you need to change the ports of the
services being run (for example, Check and Posting Service
(CAPS) and Kitchen Display System (KDS) Controller) in
addition to the workstation. Use the EMC modules to change
the ports.
If a non-POS workstation is required to run on the service
host, it must run on a different port than the workstation
port.
You can also set the service host to run as a Microsoft
Windows service from the Service Host module (rather than
from the Workstations module). If you set this option in the
Service Host module, you do not need to change the ports of
the services being run as the device is not intended to run
the workstation.
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Table 2-2    (Cont.) General Workstation Settings

Field Description

Resolution Cols Enter the number of Resolution Columns for the
workstation’s display. The default value is 0 (zero).

Resolution Rows Enter the number of Resolution Rows for the workstation’s
display. The default value is 0 (zero).

Location From Top Enter the number of pixels from the top where the
workstation window is placed on the display screen.

Location From Left Enter the number of pixels from the left where the
workstation window is placed on the display screen.

6. Click the Printers tab.

7. Click the Select link next to each printer type that you need to configure, select the printer,
and then click OK.

8. Click Save.

Configure Workstation Database Passwords
To maintain workstation database access control, you must assign unique usernames and
complex passwords in the Simphony EMC.

Simphony allows administrators to configure strong passwords for workstation local databases
at either the Enterprise or property level before installation.

At the Enterprise Level

1. Select the Enterprise, click Setup, click Enterprise Parameters, and then click the
Security tab.

2. In the Enterprise Security section, enable the Use Same Credentials for all Properties
checkbox, and then select any arbitrary property from the drop-down list.

3. In the User Admin Credentials section, enter a username and a desired password that
complies with your password complexity policy.

4. In the User Database Credentials section, enter a username and a desired password that
complies with your password complexity policy.

5. Save the changes.
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Figure 2-14    Enterprise Level Configuration

At the Property Level

1. Select the property, click Setup, click Property Parameters, and then click the Security
tab.

2. In the User Admin Credentials section, enter a username and a desired password that
complies with your password complexity policy.

3. In the User Database Credentials section, enter a username and a desired password that
complies with your password complexity policy.

4. Save the changes.

Chapter 2
Configure Workstation Database Passwords

2-15



Figure 2-15    Property Level Configuration

Currency
You can configure the types of currencies in circulation for exchange at workstations (for
example US Dollars, Canadian Dollars, Euros, Pounds Sterling, Pesos, or Yen).

Configure Currency
1. Select the Enterprise or property, click Setup, and then click Currency.

2. Insert a record, enter the name (for example, US Dollars), and then click OK.

3. Double-click the record to open it.

4. Enter the Abbreviation for the currency.

Oracle Food and Beverage recommends using Currency ISO standard 4217 in the
Currency module’s Abbreviation field. For example:

• USD for the US Dollar

• CAD for the Canadian Dollar

• EUR for the Euro

• GBP for Pound Sterling

• MXN for the Mexican Peso

• JPY for the Japanese Yen
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5. Enter the Symbol for the currency record (for example, $).

6. Select the Number of Digits from the drop-down list.

This is the number of digits after the decimal point that the currency allows.

7. Select 1 - On = Print Symbol After Total; Off = Print Symbol Before Total to print the
currency’s symbol after the amount due on guest checks and customer receipts. Deselect
this option to print the currency’s symbol before the amount due.

8. Select 5 - Use Thousands Separator Character to use the thousands separator (comma
as in the example 1,000) when numbers are printed.

9. Click Save.

10. Repeat Steps 2 through 9 for each currency payment allowed.

Configure Base Currency and Alternate Currency
1. Select the Enterprise or property, click Setup, and then click Currency Parameters.

2. Click the Configuration tab.

3. Select the Base Currency from the drop-down list. This is the primary currency for the
location.

Oracle recommends setting the base currency once during initial configuration of a
property, prior to opening guest checks. When you change the base currency after opening
checks, the EMC prompts you for verification twice.

4. (Optional) Select the Alternate Currency from the drop-down list.

This is the other currency used at the location. For example, a restaurant located near
Niagara Falls might set US Dollars as the base currency and accept Canadian Dollars as
the alternate currency.

5. To use rounding, select 4 - Round Currency. Selecting this option activates the
subsequent options. Select the appropriate options to round the amount due:

• 5 - ON = Round to Nearest 0; OFF = Round to Nearest 5: Select this option to round
currency amounts to the nearest 0 (for example, 163.336 rounds to 163.340). Deselect
this option to round currency amounts to the nearest 5 (for example, 163.336 rounds to
163.335).

• 6 - ON = Round to Second-Least Significant Digit; OFF = Round to Least
Significant Digit: Select this option to round currency amounts based on the second
least significant digit (for example, in 100.45, the second least significant digit is 4).
Deselect this option to round currency amounts based on the least significant digit (for
example, in 100.45, the least significant digit is 5).

6. Click Save.

7. Select the Enterprise or property, click Setup, and then click Currency Availability.

8. If you selected the Enterprise level, for each record, select the non-base currency (foreign
or alternate currency) for conversion in the Currency field.

9. Select the appropriate alternate currency options:

• 2 - Issue Change In Other Currency: Select this option to issue change from a
currency conversion in the currency. Deselect this option to issue change only in the
base currency.

• 3 - Prompt For Issuing Change: Select this option to ask the workstation operator
with a Yes/No prompt whether change is required in the alternate currency. Deselect
this option to issue change only in the base currency without prompting.
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• Select options 4, 5, and 6 as appropriate for the alternate currency. These options are
described in Step 4.

10. Click Save.
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3
Initial Setup Using Simphony Home

Simphony Home is the configuration application used to set up employee information for
Simphony Essentials.

Sign in to Simphony Home
To access Simphony Home, use the URL that was provided by Oracle.

To sign in to Simphony Home, enter your Email or User Name, Enterprise Name, and
Password. Then click Sign In.

If you have forgotten the password, click Can’t Sign In to initiate an email with a time
expiration link that allows you to set a new password.

To sign out of Simphony Home, click Logout.

Enable Labor Management
You need to enable Labor Management for the location.

1. Sign in to Simphony Home with the credentials supplied by Oracle.

2. From the Dashboard, click the application navigation icon
(

) at the top left of the page to view the side panel menu.

Figure 3-1    Dashboard

3. Click Configuration, click Portal Admin, click Organizational Structure, and then click
Locations.
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4. Select the location.

5. Click Edit.

6. Select Enable Enterprise Labor.

Figure 3-2    Enable Enterprise Labor

7. Click Save.

Configure Organization Wide Unique Magnetic Cards
1. Sign in to Simphony Home with your credentials.

2. From the Dashboard, click the application navigation icon
(

) at the top left of the page to view the side panel menu.

3. Click Labor Management, click Human Resources, click Admin, and then click
Organization Configuration.

4. Select Enforce unique POS Password.

5. Select Enforce unique MagCard Number.
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Figure 3-3    Check Boxes for Magnetic Cards

6. Click Save.

Assign Templates
Human Resources templates are used to tailor the information shown when setting up
employees as not all fields are required. Default templates have been created which need to
be assigned to your location.

1. Sign in to Simphony Home with your credentials.

2. From the Dashboard, click the application navigation icon
(

) at the top left of the page to view the side panel menu.

3. Click Labor Management, click Human Resources, click Admin, and then click
Template Assignment.

4. For all roles, assign the Simphony Default Home Location template to the following:

• Home Store Template

• Home Store Edit Template

5. For all roles, assign the Simphony Default Away Location template to the following:

• Away Store Template

• Away Store Edit Template
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Figure 3-4    Assign HR Templates to Roles Page

6. Click Save.

Add Job Definition
Job definitions group employees into Salaried and Hourly Paid. One job definition, called
Default, is already created in the Simphony Essentials organization for Salaried employees.

To add a job definition for Hourly Paid staff:

1. Sign in to Simphony Home with your credentials.

2. From the Dashboard, click the application navigation icon
(

) at the top left of the page to view the side panel menu.

3. Click Labor Management, click Human Resources, click Admin, and then click Job
Definitions.

4. Click Add.

a. Set the following in the General tab:

• Job Name: Enter Hourly.

• Labor Category: Select the default labor category.

• Revenue Center: Select the Operations revenue center.

• Job Category: Select the default job category.

• Employee Roles: Select a role.

• Clock In Privilege: Select 1.

b. Set the following in the Type tab:

• Job Type: Select Hourly.

• Effective From: Select the date. (Tomorrow’s date is the earliest possible.)

• Default Pay Rate: Enter the default hourly pay rate.

5. Click Save.

Assign Pay Period Calendar to Location
1. Sign in to Simphony Home with your credentials.

2. From the Dashboard, click the application navigation icon
(

) at the top left of the page to view the side panel menu.
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3. Click Labor Management, click Payroll Preprocessing, click Admin, and then click
Location Configuration.

4. Select Corporate from the tree (top node).

5. Enable Pay Period Calendar.

a. Select the default calendar from the drop-down list.

b. In the Effective From field, select the starting effective date. (Tomorrow’s date is the
earliest possible.)

6. Click Save.

7. Click OK.
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4
New Locations

A location is a place of business—usually a restaurant or food outlet. A location can support up
to five point-of-sale (POS) workstation client devices. Each location has separate sales figures,
tax information, and other configuration specific to the location. When Simphony Essentials is
installed, one location is created by default. If additional locations are required, you can create
them manually.

Add New Location
To add a new location in Simphony Essentials:

1. Sign in to EMC.

2. Select the Enterprise, click Setup, and then click Properties.

3. Click the Insert icon ( ) on the toolbar.

4. In the Add Property dialog, enter or select the appropriate values as described in the
following table, and then click OK:

Table 4-1    Add Property Fields

Field Description

Property Number Enter a unique location number.

Property Name Enter the location name.

Simphony Reporting Location Leave the defaults as is.

Enable Enterprise Labor Management Select this option to enable Labor
Management for the location.

Source Property Leave this option disabled to use enterprise
information for the location.

Time Zone Select the time zone for the location.
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Figure 4-1    Add Property Dialog

5. Click OK, close the Properties tab, and then re-open it.

6. Double-click the new location record.

7. Enter a Phone Number for the location.
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Figure 4-2    Edit Property

8. Enter the Address of the location.

9. Select the Country from the drop-down list.

10. Select the state or region from the State/Region drop-down list.

11. Enter the ZIP or Postal Code for the location.

12. Leave the other defaults, and click Save.

13. Add workstations for the location. See Add a Workstation for more information.

Add Order Type, Order Channels, and Menu Levels to Revenue
Center

A default order type and default menu levels must be configured in the Operations revenue
center. There are two order types already created in Simphony Essentials: Dine In and Take
Out.

An order channel can be assigned to a revenue center, but an overall default is used if the
order channel is not configured for the revenue center. Managing Order Types and Channels
contains more information.

Menu levels allow different prices for one menu item and determine which sales items are
available in a transaction. Defaults have been set up for Simphony Essentials called Main and
Sub. Introduction to Menu Levels contains more information.
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To add order types, order channels, and menu levels:

1. Select the Operations revenue center, click Setup, and then click RVC Parameters.

2. Double-click the Operations revenue center.

3. On the General tab, select a Default Order Type, Default Order Channel, Default Main
Level, and Default Sub Level.

Figure 4-3    Select Default Order Type, Order Channel, Main and Sub Levels

4. Click Save.

Add a Workstation
Simphony Essentials supports up to five POS workstation client devices per location/property.
Simphony Essentials is supported on POS workstation client devices running Linux and
Android operating systems. The Microsoft Windows operating system is not supported on a
POS client device for Simphony Essentials.

1. Select the property, click Setup, and then click Workstations.

2. Click the Insert icon ( ) on the toolbar.

3. In the Insert Record dialog, enter the Record Name, and then click OK.

4. Double-click the new workstation record.

5. On the General tab, enter information in the following fields:
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Table 4-2    General Workstation Settings

Field Description

Type Select the type of workstation from the drop-down list:
• 2 - Workstation Client: Workstations and Android

devices
Select this option for the Oracle MICROS Workstation 6
Series, the Oracle MICROS Workstation 310, and
Android devices.

• 3 - POSAPI Client: Simphony Transaction Services
• 7 - Castle S1F2: Adyen Castles S1F2 Android payment

devices

Language Select the default language of the workstation. This is the
language that appears on the workstation’s Sign On screen.
If an employee has a different default language set, the
employee sees their default language after signing in to the
workstation.

Log Verbosity Select the logging verbosity for the workstation. Select 0
(zero) for minimal logging. Higher log verbosity provides
more information in the log file, which may be helpful in
troubleshooting issues.

Workstation Class Select the service type:
• 1 - Table Service Restaurant: Workstations and larger

Android landscape tablet devices
• 2 - Quick Service Restaurant: Workstations and larger

Android landscape tablet devices
• 3 - Bar: Workstations and larger Android landscape

tablet devices
• 4 - Mobile Table Service Restaurant: Adyen Castles

S1F2 Android payment devices and smaller Android
portrait devices (such as mobile phones)

• 5 - Mobile Quick Service Restaurant: Adyen Castles
S1F2 Android payment devices and smaller Android
portrait devices (such as mobile phones)

If a workstation is incorrectly configured (for example,
Workstation Class 1 - Table Service Restaurant is selected
for a mobile phone device), the page Configuration Error
Incorrect Workstation Class configured appears before the
sign in page on the POS client device. This error also
appears on workstations and tablets if an incorrect
Workstation Class is selected. Workstations and tablets use
the non-mobile Workstation Classes. To resolve this error,
correct the Workstation Class, and then click Update
Database And Redraw Page on the POS Client device.
Alternatively, close the application on the device and
change the Workstation Class at a later time.

Enable Simphony Transaction
Services

These options become active after you select 3 - POSAPI
Client from the Type field. Select the appropriate option to
enable Simphony Transaction Services.

Database Update Frequency Enter the number of seconds for the workstation to receive
changes.
The value in this field overrides the Property Parameter’s
Database Update Frequency setting.
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Table 4-2    (Cont.) General Workstation Settings

Field Description

Check Inactivity Timeout Enter the number of seconds before the workstation shows
the message (Do you need more time?), prompting the
workstation operator to cancel the transaction. When you
enter 0 (zero), the message does not appear.

Check Inactivity Dialog
Timeout

Enter the number of seconds that the workstation shows the
Inactivity dialog before automatically cancelling the
transaction. This field is inactive when you set the Check
Inactivity Timeout value to 0 (zero).

Report Timeout Enter the number of seconds the workstation waits for a
response from the Reporting and Analytics server before
showing a communication failure notice.

Offline Threshold Enter a number between 0 and 99 to represent the signal
strength percentage at which devices go offline. Devices will
go offline when the signal strength is at or below this
percentage value. For example, if the Offline Threshold is
set to 90 (90%), and the device’s current signal is 89%, the
device will go offline. When the signal is detected above
90%, the device reconnects online.

Reconnect Threshold Enter a number between 0 and 99 to represent the signal
strength percentage at which devices recover online after
being in an offline state. Devices will go online when the
signal strength is at or above this percentage value. For
example, if the Reconnect Threshold is set to 80, and the
device’s signal strength is 85%, the device will go online.

Service Host ID This field become active after you select 3 - POSAPI Client
from the Type field. Select the service host on which the
POS API client runs.

Address / Host Name Enter the IP address or host name of the service host where
the workstation application runs.

Subnet Mask Enter the subnet mask of the service host where the
workstation application runs.

Default Gateway Enter the default gateway of the service host where the
workstation application runs.

Is Windows Service Select this option to allow the service host to start as a
Windows service. The service host service starts on
Microsoft Windows startup with other Microsoft Windows
services. The workstation starts only when the workstation
operator signs on to the operating system.
If you select this option, you need to change the ports of the
services being run (for example, Check and Posting Service
(CAPS) and Kitchen Display System (KDS) Controller) in
addition to the workstation. Use the EMC modules to change
the ports.
If a non-POS workstation is required to run on the service
host, it must run on a different port than the workstation
port.
You can also set the service host to run as a Microsoft
Windows service from the Service Host module (rather than
from the Workstations module). If you set this option in the
Service Host module, you do not need to change the ports of
the services being run as the device is not intended to run
the workstation.
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Table 4-2    (Cont.) General Workstation Settings

Field Description

Resolution Cols Enter the number of Resolution Columns for the
workstation’s display. The default value is 0 (zero).

Resolution Rows Enter the number of Resolution Rows for the workstation’s
display. The default value is 0 (zero).

Location From Top Enter the number of pixels from the top where the
workstation window is placed on the display screen.

Location From Left Enter the number of pixels from the left where the
workstation window is placed on the display screen.

6. Click the Printers tab.

7. Click the Select link next to each printer type that you need to configure, select the printer,
and then click OK.

8. Click Save.

Configure Check and Posting (CAPS) Workstation
Every location must have a check and posting (CAPS) workstation; otherwise information will
not post to the Enterprise.

1. Sign in to EMC.

2. Click the Home page tab, and then highlight the new location name in the hierarchy on the
left.

3. Click Setup, and then click Property Parameters.

4. Click the Workstations tab.

5. In the Service Hosts section, click the ellipsis (...) point button for the Check and Posting
row, and then select a workstation (not a mobile device) that will be used to post
information in real-time from the POS to the Enterprise.

Figure 4-4    CAPS Workstation Selection
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6. Click the ellipsis (...) point button for the Check and Posting Backup row, and then select a
workstation (not a mobile device) that will be used as a backup in case the Check and
Posting workstation is not working.

If you do not have another workstation to use as a backup at this location, leave this field
blank.

7. Click the Options tab.

8. Select the following time and date format options if required:

• 2 - Use DDMMYY date format

• 3 - Use 24 Hour Clock

9. Leave the other defaults, and click Save.

Configure Begin Future Order
You can configure checks to be sent to the kitchen at a specific date and time for Table Service
Restaurant operations. These are called Future Orders (sometimes called Autofire checks).

By default, the future orders feature is not active for Simphony Essentials. When you enable
future orders, the following changes occur in POS Operations:

• The Begin Future Order button appears on the POS Functions page.

• The Pickup Check dialog shows the Future Checks button.

• The Future Open Check Report button appears on the POS Reports page.

To enable Begin Future Order:

1. Select the revenue center, click Setup, and then click RVC Parameters.

2. Click the Autofire tab, and then configure the fields as described in the following table:

Figure 4-5    Autofire Tab
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Table 4-3    Automatic Check Firing Fields

Fields and Options Description

(Optional) Autofire Employee To allow a specific employee to become the
owner of all checks, including those placed
using Transaction Services after the orders
fire, select a workstation operator, and then
click OK.
• If you select an Autofire Employee, all

sales totals post to the designated
workstation operator and the checks
appear under the Autofire Employee in
the Open Check Report.

• If you do not select an Autofire
Employee, the check operator remains
the owner of the check after the order
fires.

Autofire Workstation Select the workstation from which the orders
fire and print. The application uses this value
to determine the order output devices and
workstation printers to use when an order
fires.

Default Autofire Tender/Media Select a service total that workstation
operators can use with Future Orders.
This service total must be the same as the
Default Service Total Tender/Media set in
the Tender Parameters module, Simphony
Essentials tab. Create Payment Buttons
contains more information.

Backup Autofire Delay (Mins) Enter the amount of time (in minutes) that
the Future Orders workstation must try to
fire the orders.
After the Backup Autofire Delay time elapses,
if the Future Orders workstation is
unsuccessful at firing the order, the
workstation at which the check was
originally created tries to fire the order. If
both workstations fail, a memo chit prints
and a workstation operator must manually
fire the order.

(Optional) Maximum Days Enter the maximum number of days for
which workstation operators can schedule
orders to fire automatically.

(Optional) 2 - Print Guest Check at Time of
Autofire

Select this option if you want a guest check to
print when an order automatically fires to
order devices.
If you select this option, guest checks print at
the guest check printer assigned to the
autofire workstation.

3 - Enable Autofire in this Revenue Center Select this option to allow the revenue center
to create orders that fire automatically.

3. Click Save.

4. Select the Enterprise level, click Configuration, and then click Roles.

5. Double-click the role type for the employee who needs privileges to assign future checks.
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6. Click the Operations tab, and then select the appropriate options.

7. Click the Guest Checks subtab, and then select the following privileges. The following
table describes the privileges corresponding to automatic check firing.

Table 4-4    Employee Guest Check Privileges for Automatic Check Firing

Privilege Description

183 - Begin Autofire Check using [Begin
Autofire Check] Key

Select this option to allow employees in this
role to create checks with orders that
automatically fire at a preset time using the
Begin Autofire Check function key.

184 - Authorize/Perform Pickup of Autofire
Check Belonging to Another Operator

Select this option to allow employees in this
role to pick up and edit checks with orders
that fire at a preset time from other
employees.

185 - Authorize/Perform Edit of Autofire Date/
Time

Select this option to allow employees in this
role to modify the date and time that orders
are set to automatically fire.

8. To allow employees in this role to generate the Autofire Open Check Report from the
workstation, click the Ad Hoc Reports subtab, and then select 31030 - Run Autofire
Open Check Report.

9. Click Save.

10. Select the Enterprise, property, or revenue center, click Descriptors, and then click
Autofire Check Offline Header.

11. From the Text column, enter the header lines to print on memo chits when future orders
fail to fire automatically.

12. To add a logo to the header, select Use Logo, click the ellipsis point (...) button from the
Logo column, select the logo from the list, and then click OK.

13. Click Save.

Assign New Location in Simphony Home
1. Sign in to Simphony Home with the system administration credentials that you have been

provided with.

Figure 4-6    Simphony Home Sign In Page

2. From the Dashboard, click the application navigation icon
(
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) at the top left of the page to view the side panel menu.

3. Select Configuration, select Warehouse Admin, select Reporting Hierarchies, and then
select Relationships.

4. Highlight the organization name, and then click Select.

5. Click Assign Location.

6. In the Location Name drop-down list, select the new location.

7. In the Parent Level Name drop-down list, select Region.

8. ClickAssign Location to return to the main page.

9. Click Back twice.

Add Employees for New Location
1. Sign in to Simphony Home with the system administration credentials that you have been

provided with.

2. From the Dashboard, click the application navigation icon
(

) at the top left of the page to view the side panel menu.

3. Follow the steps in Personnel for People Management or Labor Management.

Configure Location Gift Card Login and Password
Complete these steps if gift cards are used at the location.

1. Select the new location in the property level hierarchy, click Setup, and then click Stored
Value Driver.

2. Right-click to the left of the object number of the iCare SVC record, select Override
Record, and then select Use Existing Record.

If there is no record for iCare SVC, you need to set up gift cards. See Gift Card Setup for
Organizations Pre 19.5 Release for more information.

3. Select iCare SVC, and then click Yes.

4. Double-click the iCare SVC record to open it.

5. Click the Configuration tab.

6. Scroll to the end of the page, and then enter the iCare Login and Password for the
location.

These fields are specific to the property, not the Enterprise.

7. Click Save.

8. Select the Enterprise, click Setup, and then click Interfaces.

9. Double-click the Stored Value record to open it.

10. Click the Properties tab.

11. Select the new location.

12. Click Save.
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Sync Gift Card Information for New Location
Complete these steps if gift cards are to be used at the location on the same day they have
been set up.

1. Sign in to Simphony Home with the system administration credentials that you have been
provided with.

2. From the Dashboard, click the application navigation icon
(

) at the top left of the page to view the side panel menu.

3. Select Gift and Loyalty, select G&L Gift, Payment, and Loyalty Configuration, and
then select Initial iCare GPL Setup and Configuration.

4. Select DB Sync Schedule.

5. Select Sync RTA Org Levels, and then click Edit.

Figure 4-7    Sync RTA Org Levels

6. Select Sync Now.
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Figure 4-8    Sync Now

7. Click Save.

8. Sign out and then sign in.

9. Click the application navigation icon
(

) at the top left of the page.

10. Select Gift and Loyalty, select G&L Gift, Payment, and Loyalty Configuration, and
then select Initial iCare GPL Setup and Configuration.

11. Select DB Sync Schedule.

12. Ensure that the Sync RTA Org Levels job ran by looking at the last executed date and
time.

13. Select Sync RTA Org Levels, and then click Edit.

14. Deselect Sync Now, select 04:00AM in the Sync Time drop-down list, select the Sync
Time Zone, and then select Daily from the Sync Frequency drop-down list.
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5
Personnel

This chapter describes how to add employees in Simphony Home. This is done through Labor
Management until your system is upgraded to People Management. Use People Management
if there is no Employee option in the EMC under the Personnel section.

• Labor Management:

– Add an employee

– Assign user names and passwords to EMC users

• People Management:

– Add a person

– Specify employment details

• Grant Access to Point of Sale Operations

• Create Employee Roles and Grant Privileges

Labor Management
Oracle MICROS Labor Management lets you manage employees for Simphony Essentials. It
can be used to add and edit employees until your system is upgraded to People Management.

Add Employee
Employees need to be set up in Simphony Home, but you can view information and change
roles in the EMC.

To create Point of Sale and EMC employees:

1. Sign in to Simphony Home with your credentials.

2. From the Dashboard, click the application navigation icon
(

) at the top left of the page to view the side panel menu.

3. Click Labor Management, click Human Resources, and then click Employee.

4. Click Add.

5. Select a Home store (if not already selected).

6. On the General tab, enter basic employee information, such as Name, Date of Birth, and
Language. Complete the form as follows:

Table 5-1    Employee Information

Field Description

First Name Enter the employee’s first name.

Last Name Enter the employee’s last name.
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Table 5-1    (Cont.) Employee Information

Field Description

Date of Birth Enter the employee’s date of birth.

Language Enter the employee’s primary language.

Employee Role Select the employee’s role at the location.
• 2000 - Waiter
• 2500 - Bartender
• 2500 - Supervisor
• 4000 - Manager
• 1 - Super Super
If the employee is an EMC user, select
Manager or Super Super. Managers can view
EMC information. Super users can add and
edit EMC information, such as menu items.
You can set the employee role when creating
the employee, but you cannot make changes
through Labor Management.

Employee Level Enter the employee’s level for EMC users
only.
Employee Level is used to control the access
of other employee records when a user is
logged into the EMC. Level 0 is highest and 9
is the lowest. An employee assigned Level 4
cannot see records for employees with Levels
0-3.

Figure 5-1    General Tab

7. On the Status tab, enter the employee’s hiring information.

• Hire Date: Select today’s date.

• Hire Status: Select Hired.
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Figure 5-2    Status Tab

8. On the Location Configuration tab, enter pay rate, job rate, and point-of-sale (POS)
configuration information. Complete the form as follows:

Table 5-2    Location Configuration

Field Description

Is Salaried Leave unchecked for an Hourly paid
employee.
Enable this field for a salaried employee and
complete the following:
In the Effective From field, select today’s
date.
In the Monthly Rate field, enter the monthly
salary amount.
The Annual Rate field is automatically
calculated.

Job Rates tab In the Location Name field, select your
restaurant.
In the Job Code Name field, select the
relevant job code.
In the Effective From field, select
tomorrow’s date.
In the Override Pay Rate field, enter an
hourly pay rate for hourly paid employees.
Click Update List.
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Figure 5-3    Location Configuration Tab

9. For POS users (not EMC users), click the POS Configuration tab.

For EMC users, a user name and password must be configured in the EMC after the user
is created in Simphony Home. See Assign User Names and Passwords to EMC Users for
more information.

Figure 5-4    POS Configuration Tab

a. Select your restaurant from the list.

b. In the Employee Class field, select Employee.

c. In the Magnetic Card Number field, enter the code to access the Simphony
Essentials POS. It can be a magnetic card number or a manual code.

d. Click Update List.

10. Click Save.

11. Click OK.

Assign User Names and Passwords to EMC Users
To enable users set up in Simphony Home to access the EMC:
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1. Sign in to EMC by entering your User Name, Company, and Password, and then click
Sign In.

2. Select the Enterprise hierarchy level in the left section of the page.

3. Click the Configuration tab.

4. Click Employee Maintenance under the Personnel section.

5. Select your property, and then click Search to display existing users who are set up in
Simphony Home for the property.

6. Double-click the user that you want to set up to use the EMC.

7. On the General tab in the EMC Login section, enter the User Name the user will use to
sign in to the EMC, and then click Save.

Figure 5-5    Set EMC Login User Name

8. Click Password, and enter the password twice. Click Accept and then click OK.
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Figure 5-6    Change Password Dialog

See Enterprise Management Console (EMC) Passwords for more information on
passwords.

9. Click the Roles tab, and select the Manager role if it is not already selected.

Figure 5-7    Set Employee Role

10. In the EMC Visibility section, add a record and select Enterprise to see all the properties.

11. Click Save.

People Management
Oracle MICROS People Management lets you manage employees and their roles after
upgrading from Labor Management. After the upgrade to People Management, the Employee
option is no longer available in the EMC under the Personnel section.

For more information about People Management, see the Oracle MICROS Reporting and
Analytics User Guide at https://docs.oracle.com/en/industries/food-beverage/back-office/20.1/
rause/index.html.
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Add a Person
To create POS and EMC employees:

1. Sign in to Simphony Home with your credentials.

2. Click the application navigation icon

at the top left of the page to view the side panel menu.

3. Click People, and then click Add Person.

4. Specify basic information to uniquely identify the person in the system, such as name, user
name, and email address.

Fields with an asterisk are required.

Figure 5-8    New Person Page

5. Select the Enterprise Role and Enterprise Level from the drop-down lists.

• Enterprise Role: If the employee is an EMC user, select System Administrator and
enter an email address. If the employee is a POS user, select Only POS access.

• Enterprise Level: If the employee is an EMC user, select Corporate. If the employee
is a POS user, select their location or revenue center.

6. Click Save and Continue. If System Administrator was selected in Step 5, the user will
have access to Simphony Home and an email will be sent to the email address with
instructions on how to set a password.

7. On the Employment tab, click Add Employment Information.

8. On the General tab, select the Home Store if not already selected.

9. Enter the employee’s Date of Birth and Language. You can enter other information, but it
is not required.
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Figure 5-9    Employee Date of Birth and Language

The following tabs are used for Payroll and are not required for Simphony Essentials:

• Contact Information: Enter contact details, such as the employee address.

• I9 Information: Enter employment eligibility verification information, such as the
passport number.

• Exemptions: Enter tax exemption information.

• Payroll Information: Enter direct deposit information.

10. On the Status tab, enter the employee’s hiring information.

• Hire Date: Select when the employee is starting work.

• Hire Status: Select Hired.

Figure 5-10    Hiring Information

11. On the Location Configuration tab, set the following options:

a. Disable Is Salaried for an hourly paid employee.

b. Enable Is Salaried for a salaried employee, and then complete the following:
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• Effective From: Select today’s date.

• Monthly Rate: Enter the monthly salary amount.

• The Annual Rate field is automatically calculated.

Figure 5-11    Location Configuration Information

12. On the Job Rates tab, set the following information, and then click Update List.

• Location Name: Select your restaurant.

• Job Code Name: Select the relevant job code.

• Effective From: Select tomorrow’s date.

• Override Pay Rate: Enter an hourly pay rate for hourly paid employees.

Figure 5-12    Job Rates Information

13. On the POS Configuration tab, set the following information for POS users only (not EMC
users), and then click Update List.

• Select your restaurant in the location list.

• Employee Class: Select Employee.

• Magnetic Card Number: Enter the code to access the Simphony Essentials POS.
This can be a magnetic card number or a manual code.
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Figure 5-13    POS Configuration Information

14. Click Save, and then click OK.

Grant Access to Point of Sale Operations
1. In Reporting and Analytics, click the application navigation icon

, and then click People.

2. Click the name of the person you want to edit.

3. Click the Point of Sale tab.

Figure 5-14    Point of Sale Settings

4. Click the Settings page and then complete the following fields:

a. Select the POS language.

b. Select the Employee level.

The employee level is a layer of security that gives an employee access to some
employee records but not others. This field allows a one-digit entry, where 0 gives the
most access and 9 gives the least access. For example, an employee with level 2
access can see all employees with levels 3 through 9 but can’t see employees with
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levels 0 through 2 (including themselves). Level 0 should be reserved for System
Administrators while a level like 8 or 9 to be used for cashiers or servers.

c. Enter the Employee group.

The employee group is another level of security that controls employee access to other
employee records. This field is more restrictive than the Employee level field, which is
more commonly used. The Employee group field allows a three-digit entry. If you set
the employee group number to 0, the employee can view all other employee records.
Any other number restricts the employee to view only employees with that same
number as their employee group. For example, an employee with a group number of
17 can only view other employees from group number 17.

d. Enter the POS Client PIN.

e. For EMC users, click Set EMC Password, enter and confirm the new password, and
then click Submit.

Figure 5-15    Set EMC Password

5. Click the Roles page and then complete the following fields:

a. Click Assign Roles.

b. Select the EMC role or roles for the user, and then click Assign.

Click Expand Entities to view all locations and revenue centers or click Zone to view
roles by regional zone.

See Create Employee Roles and Grant Privileges for more information about EMC
roles.
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Figure 5-16    Manage Roles

6. Click the Visibility page, and then click Assign Visibility.

If the person you are setting up has EMC access, you can configure what they can see at
specific enterprise levels.

• Select the locations and revenue centers that the user can access, and then click
Assign.

You can view options by Enterprise, Location, or Zones.

Figure 5-17    Manage Visibility

7. Click Update.

Create Employee Roles and Grant Privileges
A role is a group of privilege options defining what an employee can do. Employee roles
determine the EMC modules a user can access, and they also determine what types of
operations a POS user can perform (for example, privilege to perform voids or open the cash
drawer).

The following employee roles are already created in the Simphony Essentials organization:

• Waiter

• Bartender
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• Supervisor

• Manager

• Super Super (This is the Administrator role for the EMC and cannot be changed.)

Each role has already been assigned privileges, such as being able to perform returns or voids
at the POS level, although you can change these.

Supervisors and Managers have been given privileges to perform most POS actions, such as
running reports and authorizing the use of functions such as voids. Waiters and Bartenders
have fewer POS privileges.

Manager and Super Super roles are used to access the EMC, and only Super Supers can edit
the EMC records.

You can create additional employee roles and change existing roles and privileges as needed.

To add a role:

1. Add a role:

a. Select the Enterprise level, click Configuration, and then click Roles.

b. Click the Insert icon ( ) on the toolbar.

c. Enter the Record Name for the type of role (for example, Head Waiter), and then click
OK

2. Assign privileges to POS roles:

a. Double-click the POS role (for example, Waiter, Bartender, Supervisor, or Manager),
and then click the Operations tab.

b. Click the sub tabs to see which privileges have been enabled for the role. Check or
uncheck the privileges as required.

For example,

• To allow employees in the role to copy and edit a menu item, select 30026 - Copy
Edit Menu Item.

• To allow employees in the role to access register fingerprint, select 30071 -
Register Fingerprint.

• To allow employees in the role to edit the guest check header and trailer, select
308 - Authorize/Perform Edit Receipt Header Trailer.
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Figure 5-18    Assign Privileges to POS Roles

3. Assign privileges to EMC roles:

a. Double-click the EMC role (for example, Manager), and then click the EMC Modules
tab.

b. Check the modules for which employees with this role can View, Edit, Add, or Delete
information.
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Figure 5-19    Assign Privileges to EMC Roles

4. Click Save.

Time and Attendance
Hourly paid employees can clock in and out of Simphony Essentials POS to log their shift start
and end times. Chits can be configured to print showing the hours worked in the shift. A clock-
in cycle for a workstation operator includes one clock in and the subsequent clock out. A cycle
is the equivalent of a work shift and includes the day, date, and time of the entry and the Job
Code under which the employee clocks in. Clock-in cycles are sequentially numbered from the
start of the current payroll period to the current date on employee time cards and labor detail
reports.

Employee Clock-In and Clock-Out Cycles
You can configure a clock-in button
(
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) to be shown or hidden on the POS client Sign In page, which enables employees to log the
time that their shift starts and ends. The button is visible by default.

1. Select the Enterprise level, click Setup, and then click Enterprise Parameters.

2. Click the Miscellaneous tab.

3. To hide the Clock In/Clock Out icon on the workstation, select 90 - Hide Clock In / Out
Button on Sign In Screen. Deselect this option to show the Clock In/Clock Out icon on
the workstation.

4. Click Save.

The following page appears on the POS after clicking the clock-in button.

Figure 5-20    Click In and Clock Out Page
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Configure Employee Time Card Printing
You can print time card chits for an employee with the total hours worked per shift. The total
labor hours worked are labeled Labor Shift Hours on the printout.

The following figure shows an example of the printed time card chit with the Labor Shift Hours
indicated in red.

Figure 5-21    Time Card Chit

To configure printing for time card chits:
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1. Select the property, click Setup, and then click Property Parameters.

2. Click the Timekeeping tab.

3. Select Print Accumulated Labor Shift Total in Clock In/Out Chits.

4. Click Save.

5. Select the property, click Setup, and then click Workstations.

6. Click the Printers tab.

7. Select the Printer and the Destination Printer Groups for the following print jobs:

• Empl Time Chit Printer

• Empl Time Card Printer

8. Click Save.

When enabled, the system prints single labor shift total hours worked by employees on
final clock-out chits for the shift.
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6
Payments

Patrons pay guest checks with various types of payments or tenders, ranging from paper to
plastic to digital.

Create Default Tender/Media Records
Several default Tender/Media records are already created in the Simphony Essentials
organization.

You need to change or set up default payment (for example, cash and credit card) and service
total tenders for use on the workstation.

The payment type Tender/Media records that you set up here can be linked to buttons on the
Payments page of the workstation. See Create Payment Buttons for instructions to create the
payment tender buttons.

1. Select the Enterprise, click Configuration, and then click Tender/Media.

2. To add a payment tender, click the Insert icon
(

) on the toolbar, enter the record name, and then click OK.

3. Double-click the tender record to open it.

4. On the General tab, select 1 - Payment from the Key Type drop-down list.

5. Select the Print Class to associate with the tender.

Introduction to Print Class Output contains more information.

6. Click the Options tab, and then click the Printing Options subtab.

7. Select 8 - Print Customer Receipt and 21 - Print Summary Totals.

8. To allow reprinting of order chits, select 73 - Reprint Orders.

When this option is selected, order chits are generated with the word REPRINT in the
header.

9. Click the Ops Behavior subtab, and then select the appropriate options as described in
the following table:
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Table 6-1    Amount Options For Payment Tenders

Option Description

2 - Amount Required Select this option to require an amount when using
the cash tender. If the workstation operator presses
the cash tender button at the workstation without
entering an amount, the workstation prompts to
enter the tender amount.
If you deselect option 2 and select option 3, the
tender is used for 0.00, unless the workstation
operator enters an amount before pressing the
tender key.

3 - Assume Paid in Full Select this option to record the exact amount due as
the entry. You must also deselect option 2. If you
deselect both options 2 and 3, the system records
0.00 as the entry.

37 - Partial Tender Not Allowed Select this option to prevent the cash tender from
being used to partially tender a transaction.

53 - Round Tender to Next Highest
Whole Number

Select this option to round the cash tender up to the
next highest whole number dollar amount.

56 - Round Change Due Select this option to accept payments for the exact
amount and to round change due.
Selecting option 56 overrides option 87.

87 - Round Payments and Change Select this option to round change due resulting from
an overtender.

88 - Round Payments and Change To
the Nearest 0

Select this option to round the payment total or
change due to the nearest 0 or 10.
You must also select option 87.
If you select option 88, the least significant decimal
digit is rounded to 0 or 10. Deselect option 88 to
round the least significant decimal digit to 0 or 5.
Tender/Media Amount Options 53 and 88 are
mutually exclusive; you cannot select both.

96 - Round To Second Least
Significant Digit

Select this option to round the payment total or
change due to the nearest .50 or 1.00.
You must also select option 87.
If you select option 88, the payment total and change
due are rounded to the nearest 0. With option 96
enabled, it is rounded to the nearest .00.
If you deselect option 88, the payment total and
change due are rounded to the nearest 0 or 5. With
option 96 enabled, it is rounded to the nearest .00
or .50.

97 - Round Change Due Down Select this option to round change due down when
the unrounded change is exactly half of the rounding
number. For example if the payment given is .25
greater than the amount due, and rounding is to the
nearest .50, the change due will be 0 instead of .50.
Select option 97 to round the change due down.
Deselect option 97 to round the change due up.

10. Click Save.
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Create Payment Buttons
You need to configure the payment buttons that will appear on the workstation. You can also
configure the Send and Print buttons, and the bar Begin Check button.

1. Select the Enterprise, click Setup, and then click Tender Parameters.

Payments use tender records set up in the Tender/Media module (for example, cash) and
you can modify them in the Tender Parameters module using arguments to enable different
payment functionality (for example, Exact Cash or Round Up).

2. Click the Simphony Essentials tab.

3. Select the Default Service Total Tender/Media that is used with the Send function on the
workstation.

4. Select the Default Print Tender/Media that is used with the Print function on the
workstation.

5. Select the Default Credit Card Auth Payment that is used for the Begin Check function
in the bar workflow.

This can only be done after adding a Credit Card Auth Payment record in the Payment
Configuration section (step 6).

To authorize a credit card and prompt for a check name in bar transactions, select 8 -
Credit Auth Prompt & Guest ID.

Figure 6-1    Example of Default Tender/Media Functions

6. To add a payment that will appear in the Payment page on the workstation:

a. Click Add.

b. In the Tender/Media column, click the ellipsis button, select the type of tender (for
example, Cash), and then click OK.
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c. In the Arguments column, click the ellipsis button, select the Payment Type (for
example, Cash:Cash). Select the appropriate function key from the Functions drop-
down list, and then click OK.

To authorize a credit card and prompt for a check name in bar transactions, select
CreditDebit Loadable CreditAuthOnly GuestCheckId ? in the Arguments Payment
Type field.

d. In the Name column, enter the name of the payment button that appears on the
workstation.

e. Select Quick Tender if this payment is a button on the QSR and Bar Transaction
pages, in addition to the Payments page.

You can select a maximum of five payments as quick tenders. The following quick
tender cash payments are already configured:

• Exact Cash

• Payment with 20 note

• Payment with 10 note

• Payment with 5 note

• Round Up

Figure 6-2    Example of Payment Button Name and Quick Tender Configuration

f. Enter the Sort Priority. Payment 1 appears first in the Transactions page for QSR and
Bar. Payment 1 appears first in the Other Payments page for all service types.

g. Repeat Steps 6a through 6f to add records for credit cards and other payments
required for the restaurant.

The following figure shows the Tender Parameters module Simphony Essentials tab
with three sample credit card payments included in the Arguments column. Note that
the Tender/Media records show 0 - None; this means that these tender records default
to the value set in the Configuration tab, Payment Card Tender field.
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Figure 6-3    Example Credit Card Tender/Media and Arguments

Record 6 shows a credit card button configured to pay off a check in full without
numerical entry.

To display a number pad in the credit card workflow to be used for under and over
payments, enter ? in the Argument field. Records 7 and 8 in the previous figure and
the following figure show examples of this configuration. Record 7 is a credit card
payment with an argument to show the number pad. Record 8 is a payment with
multiple arguments: one to show the number pad, and one to add the guest name to
the check. It allows a credit card to be authorized before adding items to the check
(CreditAuthOnly has been entered in the Argument), so it can be used as the Default
Credit Card Auth Payment (in the Tender Settings section).

Figure 6-4    Credit Card Allow Under/Over Payments Number Pad

7. Click Save.

Consumer Payments
Simphony Essentials lets you accept payments from guests. Guests can pay their checks with
a credit card through the handheld terminal that the server uses to take orders.

Configure Guest Pay
Guest Pay is a means for guests to pay their checks with a credit card through the handheld
terminal that the server uses to take orders. To set up Guest Pay, you need to configure
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options in the Tender Parameters module, enable a credit card payment for Guest Pay, and
configure a service charge tender for posting tips.

Next, you can configure suggested tip percentages to be used in the Guest Pay POS to prompt
guests to leave a tip. You can set three suggested tip percentages in EMC for each order type
(Dine In and Take Out). A tip percentage is applied to the check by default. Tip% 1 is applied if
more than 0; otherwise Tip% 2 is applied. If both Tip% 1 and Tip% 2 are 0, then Tip% 3 is
applied. If all Tip%s are 0 (zero), no tip is applied to the check. The default tip is highlighted in
blue in the POS. Tip%s appear in ascending order starting with the lowest entered percentage
value. Tips that are 0% are not shown.

The following figure shows an example of tips configured in the EMC, and the corresponding
appearance in the POS on an Android mobile payment device.

Figure 6-5    Suggested Tip Percentages

Two active order types are already configured in Simphony Essentials: Dine In and Take Out.
You can change these descriptions and configure a default order type in the RVC Parameters
module. Default suggested tip percentages of 18, 20, and 25 are already set up for each order
type parameter. To modify these order types, see Configure Order Type for more information.

1. Set the Tender Parameters options and enable a credit card payment:

a. Select the Enterprise, click Setup, and then click Tender Parameters.

b. Click the Guest Pay tab.

c. To ensure that guests cannot exit Guest Pay and start using the POS system, deselect
(uncheck) 1 - Exit Guest Pay Without ID Prompt.

When exiting from Guest Pay, a dialog prompts for an employee ID, ensuring that only
restaurant servers can use the POS system.

d. To hide the email receipt option, select (check) 2 - Disable Email Receipt.

If you select option 2, guests will not be able to email their receipt.

Email receipts must be set up in the Property Parameters module. See Configure
Email Receipts for more information.

e. In the Payments section, click the ellipsis point (...) button in the Type column, select
Credit Card, and then click OK.

f. Click the ellipsis point (...) button in the Command column, select the following values,
and then click OK.

• Payment Type: Select CreditDebit:Loadable.
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• Functions: Select CreditAuthAndPay.

The following figure shows an example of the Guest Pay credit card configuration in
the EMC Tender Parameters module.

Figure 6-6    Guest Pay Configuration

g. Click Save.

2. Configure a service charge for tips to appear on the Employee Tip Report:

a. Select the Enterprise, click Configuration, and then click Tender/Media.

b. Double-click the SPI Tender/Media record that is being used for Guest Pay.

c. Click the Options tab, and then click the Charge Tip Options subtab.

d. Select a Service Charge from the drop-down list for Guest Pay tips.

e. Select 9 - Charged Tip Required.

f. Click Save.

If there is no service charge set up, the following error appears when Guest Pay is
selected in POS Operations: Please add a charge tip to your credit card tenders to use
Guest Pay.

3. To suppress a prompt for tips each time the Tender/Media record is used outside Guest
Pay:

a. Select the revenue center, click Setup, and then click RVC Parameters.

b. Click the Options tab.

c. Select 46 - Do Not Prompt For Tips (Suppress "Charge Tip Amount is 0.00").

d. Click Save.

4. To configure suggested tip percentages:

a. Select the Enterprise, property, or revenue center, click Setup, and then click Order
Type Parameters.

b. For each Order Type Name, enter a numerical percent value in the following fields:

• Tip% 1

• Tip% 2

• Tip% 3

c. Ensure that each order type has Active enabled.

d. Click Save.
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5. To hide the Custom Tip and No Tip buttons:

a. Select the Enterprise, property, or revenue center, click Setup, and then click Order
Type Parameters.

b. For each Order Type Name, select the following options to hide the buttons in Guest
Pay. If both options are selected and no tips are configured, the Tip page does not
appear in Guest Pay.

• 13 - Hide Custom Tip Button

• 14 - Hide No Tip Button

c. Ensure that each order type has Active enabled.

d. Click Save.

Configure Simphony Payment Interface (SPI) Payment Driver
The Simphony Payment Interface (SPI) simplifies credit card payment configuration by
enabling Simphony Essentials to communicate with payment service providers (PSPs) that
provide credit card processing using a single payment driver.

The SPI Payment Driver is already created with as much information as possible. Consultants
configuring Simphony Essentials need to enter the variable information, such as IP addresses
for the SPI Payment Driver record.

To change the Payment Driver record:

1. Select the Enterprise, click Setup, and then click Payment Drivers.

2. Double-click the SPI record.

3. Click the Configuration subtab.

4. Enter the Machine IP Address in the Primary Host field, as shown in the following field.

Figure 6-7    Payment Drivers Module Fields
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5. Click Save.

Configure Credit Card Authorization to Print Merchant Vouchers
and Customer Receipts

You can configure the printing of credit card vouchers when workstation operators press the
Credit Card Authorization function key on the workstation. Complete the steps below to allow
the following items to print:

• Merchant voucher (for cardholder signature)

• Customer receipt

Confirm the cardholder signature verification with your Payment Service Processor (PSP)
before configuring Quick Service Limits. Cardholder signature verification prompts are forced
by the PSP, and may appear for every transaction, even if the property is configured to not print
merchant vouchers below a certain amount. This could leave a property in a situation where no
signature is present, but the workstation operator is prompted to verify it.

1. Select the Enterprise or property, click Configuration, and then click Tender/Media.

2. Click the Options tab

3. Click the Printing Options subtab, and then select the following options:

• 8 - Print Customer Receipt

• 54 - Print 2 Guest Checks/Receipts

4. Click Save.

5. Repeat Steps 1 through 4 for each credit card tender record.

6. Select the revenue center, click Setup, and then click RVC Parameters.

7. Click the CA/EDC tab (Credit Card Authorization/Electronic Draft Capture), and then select
7 - Print Two Credit Card Vouchers.

8. Click Save.

Configure Credit Card Voucher Headers and Trailers
Credit card headers and trailers are leading and trailing lines that print on credit card vouchers.
You can also set a header or trailer line to print logos rather than text. See Introduction to Logo
Printing for more information.

1. Select the Enterprise or revenue center, click Descriptors, and then click one of the
following modules, depending on whether you want to configure voucher headers or
trailers:

• Credit Card Headers

• Credit Card Trailers

2. Enter the text to appear on the header or trailer in the rows under the Text column.

3. If you want to insert a logo for the header or trailer, select a check box under the Use Logo
column and then select a logo using the ellipsis point (...) symbol in the Logo column.

4. Click Save.
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Configure Email Receipts
1. Select the property, click Setup, and then click Property Parameters.

2. On the General tab, click the Primary SMTP Server subtab.

3. Enter information in the fields as described in the following table:

Table 6-2    Email Receipt Fields

Field Description

Server Enter the email server or service to use. Click
Select to choose from the SMTP Server list of
commonly used mail servers (for example,
Outlook, Gmail, or Yahoo).

Port Enter the port number for the SMTP email
server. A default port of 587 works for most
SMTP servers.

SSL Select this option to require secure Internet
communication.

User Name Enter the user name of the email address that
will send receipts.

Password, Confirm Password Enter the password associated with the email
user name.

Source Email Enter the full email address to appear as the
sender in the emailed receipt. Depending on
the SMTP server, this may not create a copy
of emails sent.

Name Enter the business name or sender name to
appear along with the email in the sender
field. Depending on the SMTP server, this
value may or may not appear in the sent
email (for example, Username = jsmith Name
= John could appear as:
John<jsmith@yourcompany.com>).

BCC List Enter the email addresses to receive a blind
carbon copy of the email receipt that is sent
to the guest. Oracle recommends that you list
the source email in the BCC field so you can
resend copies of email receipts later if
necessary.

4. Click the Send Test Email button to send a test email receipt message to the source email
address. A confirmation appears after the email is successfully sent.

5. Click the Backup SMTP Server subtab.

6. Configure the Backup SMTP Server with the same settings as the Primary SMTP Server or
an alternate server from which to send emails in the event the primary server becomes
unavailable.

7. Click the Text Formatting subtab, and then enter information in the following fields:

• Email Subject: Enter text in rich text format to appear as the subject line of email
receipts.

Chapter 6
Configure Email Receipts

6-10



• Email Body: Enter text in rich text format to appear as the body of email receipts. You
must include @@Check in the body in order to send a copy of the receipt.

8. Click the HTML Formatting subtab, and then enter information in the following fields:

• Email Subject: Enter text in HTML format as the subject line of email receipts.

• Email Body: Enter text in HTML format as the body of email receipts. You must
include @@Check in the body in order to send a copy of the receipt.

9. Select the Send Html Email check box to dim the Text Formatting tab and send only the
HTML format. Deselect this option to dim the HTML Formatting tab and send only the text
formatted email.

10. Click Save.
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7
Paid In and Paid Out Operations

Paid in transactions or “loans” are used when money is added to the cash drawer, such as
from floats and loans.

Paid out transactions or “pickups” are used when money is removed from the cash drawer,
such as tips paid to employees in cash or payments to vendors for products.

Buttons for paid in and paid out operations appear in the POS in a section called Cash
Operations on the POS Functions page. The buttons are created automatically for EMC
Tender/Media records set up with a Key Type of 3 - Pickup or 4 - Loan. The button names are
the same as the Tender/Media record names entered in the EMC, as illustrated in the following
figure. If there are no Pickup and Loan type tenders, the Cash Operations section does not
appear.

Figure 7-1    EMC Pickup and Loan Tender Records Corresponding to Pickup and Loan
Buttons in POS Operations

These transactions appear on the Employee Financial Report and the Property Financial
Report in the configured Report Group section.

Create Tender/Media Records for Paid In/Paid Out Operations
You can configure buttons for paid in and paid out transactions in the EMC.

1. Select the Enterprise, click Configuration, and then click Tender/Media.

2. Click the Insert icon
(

) on the toolbar, enter the record name (for example, Petty Cash), and then click OK.

3. Double-click the tender record to open it.

4. On the General tab, select either 3 - Pickup (this is used for Petty Cash) or 4 - Loan from
the Key Type drop-down list, depending on the tender record you created.
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Figure 7-2    Tender/Media General Settings for Paid In and Paid Out Operations

5. Click the Options tab, and then click the General subtab.

6. To print a validation chit when the workstation operator presses a pickup button, select 6 -
Validation Required.

7. Select the appropriate options as described in the following table:

Table 7-1    Options For Pickup and Loan Tender Key Types

Option Description

1 - Open Cash Drawer Select this option to have the cash drawer open
automatically when a workstation operator presses a
pickup button.

2 - Cash Tips Paid Select this option to establish a pickup key that is
used to record cash tips paid to a server from the
cash drawer. The workstation operator needs to
enter the employee number for the employee being
paid tips.
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Table 7-1    (Cont.) Options For Pickup and Loan Tender Key Types

Option Description

5 - Reference Entry Required Select this option to require the workstation operator
to enter an alphanumeric reference entry when
using the pickup or loan operation.

82 - Prompt for Reason Select this option to have the POS client prompt the
workstation operator to enter a reason for the
pickup or loan operation.
See Create Pickup Reasons and Create Loan Reasons
for more information about configuring the reasons.

8. Click Save.

9. Restart the workstation to have the buttons appear in POS Operations.

Create Paid Out Reasons
You can optionally configure reasons to appear when entering paid out (pickup) transactions
on the workstation.

1. Select the Enterprise, zone, property, or revenue center, click Descriptors, and then click
Pickup Reasons.

2. Place your mouse curser in a Text column row, and then enter a reason for a pickup
transaction.

3. Click Save.

4. To edit a reason, highlight the reason record, change the reason name, and then click
Save.

5. To remove a reason, delete the text in the Text column row. The reason will no longer
appear in POS Operations.

Create Paid In Reasons
You can optionally configure reasons to appear when entering paid in (loan) transactions on
the workstation.

1. Select the Enterprise, zone, property, or revenue center, click Descriptors, and then click
Loan Reasons.

2. Place your mouse curser in a Text column row, and then enter a reason for a loan
transaction.

3. Click Save.

4. To edit a reason, highlight the reason record, change the reason name, and then click
Save.

5. To remove a reason, delete the text in the Text column row. The reason will no longer
appear in POS Operations.
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8
Taxes

A tax is a sum of money imposed by a government, levied upon prepared food and beverages
sold in a restaurant. The following table explains the Simphony Essentials methods of taxation:

Table 8-1    Tax Methods

Tax Method Description

Value Added Tax (VAT) A VAT is a form of sales tax used in some countries. VAT is an
inclusive tax, which means the tax is included in the menu
item price. The global tax type can be set as European or
United States. A VAT is calculated differently, depending on the
global setting. In Europe, only inclusive type tax is calculated.
In the United States, inclusive type tax and add-on type tax can
be used at the same time.
VAT inclusive taxes are broken out from sales totals on
financial related reports (for example, Property Financial
Report), with the inclusive tax reflected in the Tax Collected
totals field.
If your property uses VAT, the following Reporting and
Analytics templates can be applied for the Open/Closed Check
reports:
• EAME_MMRevCtrOpenChecks_VAT
• EAME_MMRevCtrClosedChecks_VAT

U.S. Inclusive Tax U.S. inclusive tax uses the item price and a percent value to
calculate the tax amount. The tax is then included in the price
of each menu item not added to the bill. For example, if the tax
rate is 5% and the item price is $5.00, the inclusive tax method
calculates by the formula: $5.00/(1+5%) = $4.76. The total cost
for the customer remains $5.00, but the net sales price is $4.76
and the tax is $0.24. If U.S. inclusive tax is used, only one
inclusive tax rate can be applied to a menu item.
U.S. inclusive taxes do not appear on the Open Check Report in
Reporting and Analytics, and do not print on Open/Closed
Check reports.
Additionally, inclusive taxes are broken out from net sales
totals on financial related reports (for example, Property
Financial Report), with the inclusive tax reflected in the Tax
Collected totals field.

Add-on Tax Add-on tax uses the item price to calculate tax, which is then
added to the bill. For example, if the tax rate is 5% and the item
is $5.00, the application calculates 5% of $5.00, posting $0.25
tax to the check and making the total due of $5.25.

Breakpoint or Threshold Tax Breakpoints establish the points at which an increase of one
cent in sales increases tax by one cent. For example, a
breakpoint tax might be one percent for sales from zero to
twenty cents and then two percent from twenty-one to forty
cents. Twenty cents would be the breakpoint for this tax.
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Introduction to Tax Rates and Tax Classes
Simphony Essentials uses tax rates and tax classes to assign taxes to menu items, discounts,
and service charges.

A tax rate is the percentage at which taxes are paid to a government. In some jurisdictions,
multiple tax rates apply. Usually these tax rates must be calculated separately for accounting
purposes (allowing each jurisdictional government to collect the appropriate tax amount).

A tax class is a collection of tax rates. Tax classes determine the tax rates that apply to menu
items and service charges, and which tax rates can be reduced by discounts. Consider the
following example: 2% City Tax Rate + 4% State Tax Rate = 6% Sales Tax (tax class
which contains two tax rates). In this example, both the city and state tax rates are active
for the Sales tax class. The total sales tax is 6%. By grouping multiple tax rates into a single
tax class, you can view a record named Sales Tax.

You can associate a tax class with the following types of records:

• Menu Item Class: All menu item definitions in the menu item class are taxed using the tax
class.

• Discount: When you assign a tax class to a discount, the taxes linked to the tax class are
recalculated when the discount is applied using the reduced taxable sales value.

• Service Charge: Some types of service charges are taxed, such as banquet and room
service transactions.

For server convenience, bars often use inclusive taxes.

You can set order types to have the appropriate tax rates in the revenue center. The following
table shows an example configuration using Order Types:

Table 8-2    Example of Inclusive Tax with Multiple Revenue Centers

Revenue Center Order Type Tax Configuration

Bar • Inclusive tax rate enabled
• Add-on tax rate disabled

Dining Room • Inclusive tax rate disabled
• Add-on tax rate enabled

Configure Tax Rates and Tax Classes
1. Select the Enterprise or property, click Setup, and then click Tax Rates.

2. Locate the appropriate tax rate. There are 64 active tax rates.

3. Select the tax rate type from the Type drop-down list. The following table describes the tax
types:

Table 8-3    Tax Types

Type Description

0 - Disabled Tax Rate Select this option if the tax rate is not used.

1 - Add On, Breakpoint Select this option to calculate the add-on tax
using the Breakpoint method.
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Table 8-3    (Cont.) Tax Types

Type Description

2 - Add On, Percentage Select this option to calculate the add-on tax
using the tax percentage rate.

3 - Included, Percentage Select this option to calculate the inclusive
tax using the tax percentage rate to
determine what portion of the sales price is
the tax. The inclusive tax applies differently
depending on the global VAT (European or
United States).
Because the tax is included in the price, the
tax is backed out of gross sales on reports.

4 - Surcharge Select this option to calculate surcharges for
items.

4. Click Save.

5. Select the Enterprise or property, click Setup, and then click Tax Classes.

6. Insert a tax class record with the appropriate name (for example, Soda Tax, Alcohol Tax, or
Surcharge).

7. From the Taxes Enabled field, select the applicable tax rates, and then click OK. The tax
rates you select are active for the tax class.

8. Click Save.

Configure Tax Parameters
Tax Parameters Options contains a list of all tax parameter options.

1. Select the property or revenue center, click the Setup tab, and then click Tax Parameters.

2. Click the International Options tab, enable the appropriate options, and then click Save.

3. Click the Options tab, enable the appropriate options, and then click Save.

4. To set printing lines for the appropriate tax rates, select the VAT Options, and then click
Save.

Tax Parameters Options
The Tax Parameters module lets you configure options related to taxes. You can configure the
Tax Parameters module at the property, zone, or revenue center levels. Configure Tax
Parameters contains more information.

The following tables list all tax parameter options.

Table 8-4    Tax Parameters International Options

International Options Description

1 - ON = Apply Tax as Add-On; OFF = Apply Tax
as VAT

Select this option to treat taxes as add-on.
Deselect this option to treat taxes as a value
added tax (VAT). If you enable VAT, all tax rates
in use must be type Included, Percentage.
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Table 8-4    (Cont.) Tax Parameters International Options

International Options Description

3 - Print Tax Itemizers Select this option to print tax itemizers on guest
checks and receipts. An itemizer is considered a
bucket that holds the sale amount of all items
taxed at a specific rate. At the end of a
transaction, the tax is applied to the subtotal of
all items in the bucket. Menu Item Classes are
linked to Tax Classes, which in turn, are linked
to Tax Rates 1-64. When you link to a tax rate,
you are creating an itemizer bucket for that
item.
You must enable this option for Philippine tax.

4 - Enable Canadian GST Select this option to enable Canadian Goods
and Services Tax (GST).

5 - Enable Japanese Tax Select this option to enable Japanese tax
options.

6 - Enable Thailand Tax Printing Select this option to enable Thai tax options.
Starting with Simphony Essentials release
19.2.1, this option is not in use.

9 - Japanese Tax Rounding: On = Truncate digits
after decimal; Off = Round digits after decimal

Select this option to indicate rounding and digit
appearance.

10 - Print Japanese Amount Due Select this option to print the amount of
Japanese tax due, even if summary totals are
suppressed for the tender media.

12 - Thai Tax Trailer Uses WS Number Instead
of RVC Number

Select this option to print the last two digits of
the workstation number on the Tax Invoice and
Account Record Lines. Deselect to print the last
two digits of the revenue center number.

13 - Truncate Inclusive Taxes This option applies to all inclusive tax
calculations. It determines whether the
inclusive tax amount that is calculated is
rounded or truncated. For example, if a
currency has two decimal places and the tax
calculated is 12.005, the rounded tax is 12.01,
but the truncated tax is 12.00.

14 - Print Item Inclusive Tax Total If the check contains items with inclusive taxes,
this option enables the total inclusive tax to
print on the guest check. The line prints
according to Tax Parameters option 4 - Print
Inclusive Tax Totals when 0.00. The inclusive
tax amount is the sum of the inclusive taxes for
each item on the check. You must also select
Tender/Media Printing Options 21 - Print
Summary Totals and 24 - Print Inclusive Tax
or VAT Lines on Check or Receipt for the
inclusive tax totals to print.
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Table 8-4    (Cont.) Tax Parameters International Options

International Options Description

15 - Print Check Inclusive Tax Total If the check contains items with inclusive taxes,
this option enables the total inclusive tax to
print on the guest check. The line prints
according to Tax Parameters option 4 - Print
Inclusive Tax Totals when 0.00. The inclusive
tax amount is calculated on the total sales for
each tax rate. You must also select Tender/
Media Printing Options 21 - Print Summary
Totals and 24 - Print Inclusive Tax or VAT
Lines on Check or Receipt for the inclusive tax
totals to print.

16 - Print Tax Rate per item Select to print the applied tax rates associated
with the menu item class on guest checks,
customer receipts, and the journal.
For example, the line item for a Grilled Cheese
Sandwich on the printed check appears as
follows:
1 Grilled Cheese 5.99  T2  T4
The guest check and customer receipt indicate
the tax rate applied to each item. The T2 and T4
shown after the item’s price indicate that tax
rates 2 and 4 were applied to a Grilled Cheese.

17 - Enable Tax Labels Select to consolidate tax reporting information
based on the defined Tax Labels configured
under Tax Rates.
Enabling tax labels permits:
• Up to two tax labels and associating each of

them with a specific tax rate
• Associating multiple tax rates with the

same tax labels
• Associating a blank tax label with tax

exempt items (considered non-value-added
tax (VAT))

Table 8-5    Tax Parameters Options

Options Description

1 - Do Not Include Tax in Totals on Tip Reports Select this option to prevent a transaction's
calculated tax amount from posting to the gross
receipts and charged receipts totals on tip
reports.

2 - Require a Reference Entry with Tax
Exemptions

Select this option to require workstation
operators to enter a reference entry when
using an exempt tax function key.

3 - Print Inclusive Tax Lines Before Summary
Totals

Select this option to print inclusive tax total
before summary totals on guest checks and
customer receipts.

4 - Print Inclusive Tax Totals when 0.00 Select this option to print inclusive totals on
guest checks and customer receipts even if the
calculated tax due is 0.00.
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Table 8-5    (Cont.) Tax Parameters Options

Options Description

5 - Print Consolidated VAT Line on Checks and
Customer Receipts

Select this option to print a consolidated VAT
line. If you use this option in conjunction with
individual VAT line printing, the consolidated
line prints last.

6 - Print VAT Net Totals on Guest Checks and
Customer Receipts

Select this option to print a VAT Net Totals line
on guest checks and customer receipts.

7 - Print Tax Exempt Voucher Select this option to print a voucher when any
tax is exempted. The voucher prints when a tax
exempt function key or a tender exempts tax.
The voucher prints at the validation printer
designated for the workstation. Deselect this
option to suppress printing of a tax exempt
voucher.

8 - Post Taxable Sales When the Tax Rate is Zero Select this option to have taxable sales post to
the TAX_DAILY_TOTAL table in Reporting and
Analytics when the tax rate is set to 0.00%. The
taxable amounts can be used for reporting
even though there are no applied taxes.
Deselect this option so that taxable sales do
NOT post to Reporting and Analytics when the
tax rate is set to 0.00%.
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9
Order Channels and Types

Order channels and order types enable the system to determine how a transaction entered the
business and where the consumer received the goods.

A transaction’s order channel indicates where the order was placed:

• Online (website) order

• Mobile app order

• Drive thru

• Dining room

• Front counter

• Delivery app

• Phone in

A transaction’s order type determine where it was picked up or consumed:

• Dining room

• Bar

• Counter

• Drive thru

• Delivery app

• Curbside

When used together, it is possible to differentiate between order flows, such as:

• Mobile app orders that were picked up in the drive thru

• Mobile app orders that were picked up curbside

• Mobile app orders that were picked up at the bar

• Drive thru orders that were picked up in the drive thru

In addition to identifying a transaction’s origin and destination, these features can be used to
configure the way in which the system processes the transaction—routing orders through the
kitchen, formatting receipts and kitchen chits, and setting tax rates.

Order Channels
An order channel is where an order is placed. For example, guests can place an order at a
kiosk, a drive thru window, inside a restaurant, or via a delivery aggregator. These examples
can be set up as order channels and assigned to checks in the POS.

By assigning an order channel to a check, the restaurant can track where orders are coming
from and make decisions about how to drive existing sales and generate new sales.

If order channels are not set up, a channel called Default is assigned to checks.
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You can manually assign channels to revenue centers, workstations, and order types. This is
the order of precedence:

1. Revenue center order channels override the Default channel.

2. Workstation order channels override the revenue center.

3. Order type order channels override the workstation.

4. Manually entered order channels override the order type.

Configure Order Channel
You can configure order channels using the following two EMC modules:

1. Order Channels

Can only be configured at the Enterprise level of the system and are available to be used
in all revenue centers.

2. Order Channel Parameters

Can be configured at the Enterprise, zone, or property levels of the system, so that you
can define standard configurations and override them where necessary.

One order channel, labeled Default, is already created. The default order channel is assigned
to checks automatically if no other channels are set up. You can rename the default channel.
You can also override the default order channel at the revenue center, workstation, order type,
and by manually changing the order channel.

1. Configure the order channel:

a. Select the Enterprise, click Descriptors, and then click Order Channel.

b. Insert an order channel record and open it. (The Record Name maximum is 32
characters.)
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Figure 9-1    Examples of Order Channel Names

c. If there are order channels that are not being used in the Enterprise, deselect Active
for each unused order channel.

d. Click Save.

e. Repeat Steps 1-a though 1-d to add order channels as needed.

2. Configure the order channel parameters for each order channel:

a. Select the Enterprise, property, revenue center, or zone, click Setup, and then click
Order Channel Parameters.

b. Select an order channel record.

c. Set the order channel parameters as described in the following table:

Table 9-1    Order Channel Parameter Options and Fields

Option/Field Description

1 - Print on Customer Receipt and
Guest Check

Select this option to print the order channel name
on customer receipts and guest checks.

2 - Print on Order Printer Select this option to print the order channel name
on order printers.
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Table 9-1    (Cont.) Order Channel Parameter Options and Fields

Option/Field Description

3 - Enable Routing Order by Order
Channel

Select this option to control order routing by the
order channel. The workstation order devices
must be set for all possibilities and use this as an
override to disable order devices. Order channel
routing takes precedence over order type routing
if both are set.
If 3 - Enable Routing Order by Order Channel is
selected, click the ellipsis point (...) button in the
Order Device Mask column, select the order
devices for the order channel, and then click OK.
KDS order devices are not supported.

Service Level Time Set the Service Level Time (in minutes) for each
active order channel.
If defined, the service level time establishes a lead
time that is required before an order can be ready
for pickup. For guests ordering online, the earliest
pickup time they can choose is based on the
current time plus the service level time.
If a check has an order channel and an order type,
both with service level times, the order channel
takes precedence.
Note that the service level time is not the same as
the KDS Prep Time (configured in the Menu Item
Maintenance module).

Active If there are order types that are not being used at
this hierarchy level, deselect Active for each
unused order type.

d. Click Save.

e. Repeat Steps 2-a though 2-d for each order channel.

3. To override the default order channel for a revenue center:

a. Select the revenue center, click Setup, and then click RVC Parameters.

b. Select the Default Order Channel from the drop-down list.

This is the order channel that is active when a workstation operator begins a check at
this revenue center unless it is overridden at the workstation, by order type, or
manually changed.

c. Click Save.

4. To override the default revenue center order channel for a workstation:

a. Select the property, click Setup, and then click Workstations.

b. Double-click the workstation.

c. Click the Transactions tab.

d. Select the Default Order Channel from the drop-down list.

This is the order channel that is active when a workstation operator begins a check on
this workstation unless it is manually changed.

e. Click Save.

5. To override the default workstation order channel for an order type:
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a. Select the appropriate hierarchy level, click Setup, and then click Order Type
Parameters.

b. Scroll to the Default Order Channel column.

c. Select the Default Order Channel from the drop-down list.

This is the order channel that is active when starting a check with this order type. The
order channel set against the order type overrides all default order channels, and can
only be overridden by a manually entered order channel.

d. Click Save.

Display Order Channel on POS
If configured, the order channel displays:

• As text in the guest check header for TSR and bar workstations and tablets

• As a selection box on the Transaction page for QSR workstations and tablets

• As buttons on the Check/Transaction Functions pages for TSR and bar workstations and
tablets

• As a selection box on the Check Attributes page for mobile phones and handheld devices

• In the check header on the POS Journal Reports

1. Select the Enterprise, property, revenue center, or zone, click Setup, and then click
Format Parameters.

2. To display the Order Channel Name in the POS check detail and in the check header on
POS Journal reports, select 65 - Display Order Channel on POS Workstation/Device.

3. Click Save.

Configure Order Channels for POS Reports
You can configure an order channel to appear on Property and Employee Financial Reports.

1. Select the Enterprise or property, click Setup, and then click Report Parameters.

2. Click the Options tab.

3. To enable printing the order channel section on financial reports, select 12 - Print Order
Channel Breakdown on Financial Reports.

To exclude the order channel section on financial reports, deselect option 12.

4. Click Save.

Order Types
An order type is a sales category based on where the order is consumed, such as Dine In or
Take Out. You can set up to 32 order types for the enterprise. Order types control active tax
rates for a transaction, allocating a tax based on where the order is consumed. For example,
often Take Out orders are taxed differently than Dine In orders.

You can specify the order type for a transaction, which is the order type of the current round. If
the workstation operator changes the transaction order type, the order type of all menu items in
the current round changes to the selected order type, while the order type of the check remains
unaffected.
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Configure Order Type
You can configure order types using the following two EMC modules:

1. Order Types

2. Order Type Parameters

Two records are already created for Simphony Essentials: Dine In and Take Out.

Figure 9-2    Example of Order Types

1. Configure the order type:

a. Select the Enterprise, click Descriptors, and then click Order Types.

b. In the Text field, enter an order type name (for example, Drive Thru).

c. Click Save.

d. Repeat Steps 1-a though 1-c to add other order types as needed.

2. Configure the order type parameters for each order type:

a. Select the Enterprise, property, or revenue center, click Setup, and then click Order
Type Parameters.

b. Set the order type parameters as described in the following table:

Table 9-2    Order Type Parameters Options and Fields

Option/Field Description

1 - Print on Customer Receipt and
Guest Check

Select this option to print the order type name on
customer receipts and guest checks.

2 - Print on Order Printer Select this option to print the order type name on
order printers.
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Table 9-2    (Cont.) Order Type Parameters Options and Fields

Option/Field Description

4 - Do Not Post Transactions to Tip
Report Totals

Select this option to exclude sales for the order
type from Tip Report Totals.

6 - Transaction Cancel Default Select this option when starting orders without an
order type.
When a workstation operator begins a transaction
and cancels it before selecting an order type, the
POS client requires the workstation operator to
associate the check with an order type for posting
purposes. The POS client finds the first order type
that has this option selected and uses it.
Deselect this option to have the POS client use the
first order type record in the list to associate with
the check.

8 - Enable Routing Order by Order
Type

Select this option to control order routing by the
order type. The workstation order devices must be
set for all possibilities and use this as an override
to disable order devices. Order channel routing
takes precedence over order type routing if both
are set.

11 - Forgive Inclusive Tax Select this option to forgive the Inclusive Tax for
eligible Menu Items (Australian GST only).

13 - Hide Custom Tip Button Select this option to instruct the payment device to
hide the Custom Tip button (Guest Pay only).

14 - Hide No Tip Button Select this option to instruct the payment device to
hide the No Tip button (Guest Pay only).

Tax Mask Click the ellipsis point (...) button in the Tax Mask
column, select the tax rates for the order type, and
then click OK.
If you are creating an order type for a delivery
service provider, do not select tax rates in the Tax
Mask column.

Active Select Active for each order type that you want to
activate.

Service Level Time Set the Service Level Time (in minutes) for each
active order type.
If defined, the service level time establishes a lead
time that is required before an order can be ready
for pickup. For guests ordering online, the earliest
pickup time they can choose is based on the
current time plus the service level time.
If a check has an order channel and an order type,
both with service level times, the order channel
takes precedence.

Order Channel Select the Order Channel from the drop-down list
that will be assigned when starting a check with
this order type.
The order channel set against the order type
overrides all default order channels and can only
be overridden by a manually entered order
channel.
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Table 9-2    (Cont.) Order Type Parameters Options and Fields

Option/Field Description

Order Device Mask If option 8 - Enable Routing Order by Order
Type is selected, click the ellipsis point (...) button
in the Order Device Mask column, select the
order devices for the order type, and then click
OK.
Order Device Mask settings for the order channel
take precedence over order type settings if both
are set.

KDS Highlight Scheme Select the KDS Highlight Scheme color to display
menu items on the KDS.

Suggested Tip Percentages To configure suggested tip percentages (Tip% 1,
Tip% 2, Tip% 3), see Configure Guest Pay for more
information.

c. Click Save.

d. Repeat Steps 2-a though 2-c for each order type.

3. (Optional) To set the default order type for a revenue center:

a. Select the revenue center, click Setup, and then click RVC Parameters.

b. Select the Default Order Type from the drop-down list. This is the order type that is
active when a workstation operator begins a check.

c. Click Save.

4. (Optional) To override the default order type for a workstation:

a. Select the property, click Setup, and then click Workstations.

b. Double-click the workstation.

c. Click the Transactions tab.

d. Select the Default Order Type from the drop-down list.

e. Click Save.
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10
Discounts

You can activate a discount using the methods described in the following table:

Table 10-1    Discount Methods

Discount Method Description

Manual A workstation operator manually applies a discount to a
check by pressing a discount key. This is a traditional
discount method.

Automatic Simphony Essentials applies an automatic discount when
a transaction meets certain criteria. As a workstation
operator adds menu items to the guest check, the system
detects items that trigger a discount, and then applies the
discount to the check.

Coupon A coupon is an automatic discount with one difference:
the workstation operator must first apply the discount
(coupon) to the guest check.

Configure Discounts
1. Select the Enterprise, click Configuration, and then click Discounts.

2. Click the Insert icon ( ) on the toolbar.

3. In the Insert Record dialog, enter the Record Name, and then click OK.

4. Double-click the new discount record.

5. On the General tab, enter the customer-facing service charge name that will appear in
Simphony Transaction Services Gen 2 in the Consumer Display Name field.

6. Select the type of discount from the Activation Type drop-down list:

• 0 - Manual (Manually entered and applied)

• 1 - Automatic (Automatically applied, operator cannot enter)

• 2 - Coupon (Automatically applied, operator must enter)

7. (Optional) Enter the minimum menu item subtotal required on a check to apply the
discount in the Min Amount field.

8. To configure a manual discount, enter the following information. Otherwise, skip this step.

a. To use a percent discount, enter the percentage in the Percent field.

b. If configuring an open-priced discount (this prompts for the amount or percentage on
the POS), select option 1 - ON = Open; OFF = Preset and then enter the maximum
amount allowed for the discount in the Max Amount field.

c. If configuring a preset amount discount, select option 2 - ON = Amount; OFF =
Percentage and then enter the amount of the discount in the Amount field.

9. To make the discount available to the workstation operator, select Enabled.
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You can turn off temporary discounts by deselecting Enabled.

10. Select the Tax Class to use for the discount.

11. Select a Privilege Group to restrict the discount to only employees who are linked to the
same privilege group. Set the Privilege Group to 0 to allow all employees to use the
discount.

12. Select the method to determine how condiment menu items are discounted from the
Condiment Discountability drop-down list.

Condiments typically provide details to the cook preparing the menu item, such as a rare
steak and peppercorn sauce. The steak is the parent; the meat temperature and sauce are
the condiments.

If you select 0 - Use MI Class Option, the discounts only apply to parent items unless you
enable the Menu Item Class option 55 - Discounts Apply to Priced Condiments.

13. Select the Report Group to associate with the discount.

Report groups are subcategories that allow reports to show similar discounts grouped
together. You can set report groups from the Report Groups module, in the Reporting
section of the Property tab.

14. Select the Print Class to associate with the discount.

Introduction to Print Class Output contains more information.

15. Select the appropriate options for the discount. The following table describes the options
and indicates the Activation Types (Manual, Automatic, Coupon) that are available for each
option.

Table 10-2    Discount Options

Option Description Manual Automatic Coupon

1 - ON = Open;
OFF = Preset

Select this option to make the
discount open. The workstation
prompts the workstation operator to
enter the amount or percentage.
Deselect this option to use a preset
amount or preset percentage for the
discount.

Yes No Yes

2 - ON = Amount;
OFF = Percentage

Select this option to make the
discount an amount. Deselect this
option to make the discount a
percentage.

Yes No No
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Table 10-2    (Cont.) Discount Options

Option Description Manual Automatic Coupon

3 - This is an
Item Discount

Select this option to calculate the
discount based on the price of the last
menu item entered. Deselect this
option to calculate the discount based
on the discountable transaction
subtotal.
For automatic discounts, this option
controls the discount sorting and
consolidation on a check. When set,
each item in the Menu Item Award
Group shows the discounted amount
on customer receipts and on the
workstation. When deselected, all
items in the Menu Item Award Group
show a combined discounted amount
as one entry.

Yes Yes Yes

4 - Employee
Meal

Select this option to set the discount
as an Employee Discount. The
workstation prompts the workstation
operator to enter the employee
number or ID of the employee
receiving the discount.

Yes No Yes

5 - Reference
Entry Required

Select this option to require the
workstation operator to enter a name
or number when using the discount.

Yes No Yes

6 - Validation
Required

Select this option to print a validation
chit when the discount is applied.

Yes No Yes

7 - Limit
Discount to
Value in Amount
Field

Select this option to limit the amount
of a discount. Enter an amount in the
Max Amount field, which represents
the highest discount possible when
setting this option.

Yes No Yes

8 - If No Amount
is Entered, Use
the Full
Discountable
Amount

Select this option to control the open
amount discount calculation if the
workstation operator does not enter
an amount before pressing the
Discount button. In short, this option
allows you to set a discount as:
• A 100% discount (if the

workstation operator does not
enter an amount before selecting
the Discount button)

• An open amount discount (if the
workstation operator enters an
amount before selecting the
Discount button)

You must select option 2 - ON =
Amount; OFF = Percentage to
activate this option.

Yes No No
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Table 10-2    (Cont.) Discount Options

Option Description Manual Automatic Coupon

9 - Simple Item
Exclusivity

Select this option to apply the
discount to only one menu item. This
setting imposes a limit of one
discount per item and prevents
individual items from receiving a
discount more than once.
Deselect this option to have the
Exclusivity tab settings determine
how the discount interacts with other
discounts.

Yes Yes Yes

10 - Tender
Required (Only
for Subtotal
Discounts)

Select this option to require
workstation operators to tender the
transaction after applying a subtotal
discount. You must also deselect
option 3 - This is an Item Discount.

Yes No No

11 - Affects Auto
Service Charge
(Only Subtotal
Discounts)

Select this option to apply the
discount to Menu Item Itemizers that
allow Auto Service Charges. This
results in an adjusted Auto Service
Charge value based on the Itemizers
discounted. Deselect to keep the Auto
Service Charge unchanged.

Yes No No

14 - Do Not Allow
Subtotal
Discount While
Seat Filter is
Active

Select this option to disallow subtotal
discounts while seat filtering is active.
Deselect for item discounts or when
not using seat handling.

Yes No No

23 - Simple
Transaction
Exclusivity

Select this option to have the discount
apply to a single transaction. This
setting prevents the transaction from
receiving a discount more than once.

Yes Yes Yes

29 - Menu item
to use check
open time

Select this option to have a menu
item use the check’s open time
(instead of using the current time) to
determine effectivity of the discount.

Yes Yes Yes

30 - Selected
menu item to
include parent
menu item in
discount

Select this option to include a parent
menu item in the discount when the
workstation operator selects a child
menu item for the discount.

Yes Yes Yes

31 - Net
Automatic
Service Charge
Itemizer

Select this option to post the net value
of the menu item to the Automatic
Service Charge Itemizer, reducing the
Automatic Service Charge after the
discount is applied.
This option is available when you set
option 3 - This is an Item Discount
and option 12 - Add to Automatic
Service Charge Itemizer from the
Menu Item Classes module.

No Yes Yes
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Table 10-2    (Cont.) Discount Options

Option Description Manual Automatic Coupon

32 - Limit
Discount value to
value of
Discountable
Item

Select this option to limit the
discountable amount to the item or
award when the Amount Off exceeds
the item or award. For example, if the
Amount Off is $5.00 and the item or
award is $4.00, the discount is limited
to $4.00.

Yes Yes No

16. Click the Menu Levels tab.

17. In the Menu Level Configuration section, select the Active On Main Levels and Active
On Sub Levels on which the discount is active.

18. In the Main Level Popup and Sub Level Popup sections, select Transaction Default to
return the transaction to the default Main Level or Sub Level after the discount is pressed,
select 0 - Stay Down to keep the current transaction levels, or select one of the levels 1-8
to become active. Deselect Transaction Default to make the other levels active for
selection.

19. Click the Effectivity tab, and then select the dates, days, and times for the discount to be
in effect.

20. Click the Effectivity Groups tab.

Effectivity groups allow you to configure and package promotions so that the menu items
and their discounts are only available for a fixed period of time. If effectivity groups do not
exist, you must create one or more in the Effectivity Groups module. Configure Effectivity
Groups contains more information.

21. Click the Add Effectivity Record link.

22. Click the Select link adjacent to Effectivity Group, select the effectivity group, and then
click OK twice. The new effectivity record shows the discount name, Effectivity Status (for
example, Active or Future), Date Start, and Date End.

23. Click Save.

24. To set an automatic discount to apply to the revenue center:

a. Select the revenue center, click Setup, and then click RVC Parameters.

b. Click the Options tab.

c. Select 48 - Enable Automatic Discounts by Default.

Examples of the types of discounts that are available with this option include:

• All appetizers are 25% off

• All domestic beers are $3.00 during Happy Hour

• Buy an appetizer, get another one for 50% off

• Buy an entrée, get $2.00 off a dessert

d. Click Save.
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11
Effectivity Groups

You can configure periods of time when discounts and menu item prices can be used. These
are known as effectivity groups. For example, you can make menu item prices or discounts
available for New Year’s Day only.

Configure Effectivity Groups
1. Select the Enterprise, property, or revenue center, click Configuration, and then click

Effectivity Groups.

2. Click the Insert icon ( ) on the toolbar.

3. In the Insert Record dialog, enter the Record Name, and then click OK.

4. Double-click the new effectivity group record.

5. Click the Add link, and then select the Start Time and the End Time from the calendar.

6. Select Time Is Local if the start and end times represent the local time of the location/
property.

7. Click Save.

8. After creating the Effectivity Group, you need to associate the Effectivity Group with one of
the following types of records to make it active:

• Tender/Media

• Menu Item Price (in the Menu Item Maintenance module)

• Discount

• Service Charge

• Tax Rate

You can make the association in the record type. For example, to associate a discount
record with the Effectivity Group, open the Discounts module, and then select the
Effectivity Group in the Effectivity Group column.
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12
Service Charges

A service charge is the amount added to a sales transaction for a service rendered and is
posted to one of the following parties:

• The person or people providing the service (for example, a server or bartender, or a team
of servers)

• The House or the establishment providing the service

You can configure the following types of service charges:

• Service charges that report as Tips on employee tip reports

• Service charges that report as Service Charges on employee tip reports

• Service charges that are paid to the House

• Non-revenue service charges

Configure Service Charges
1. Select the Enterprise, click Configuration, and then click Service Charges.

2. Click the Insert icon ( ) on the toolbar.

3. In the Insert Record dialog, enter the Record Name, and then click OK.

4. Double-click the new service charge record.

5. On the General tab, enter information in the fields as described in the following table:

Table 12-1    General Tab Fields

Field Description

Consumer Display Name Enter the customer-facing service charge name that will
appear in Simphony Transaction Services Gen 2.

Percent Enter the service charge percentage.

Amount Enter the service charge amount. This field becomes
active only when you select option 2 - ON = Amount;
OFF = Percentage.

Pickup Tender/Media To associate a tender to the service charge for charged
tips and cash back, select the Tender/Media from the
drop-down list.

HALO Enter the High Amount Lock Out (HALO) value for the
service charge. This setting limits the amount
workstation operators can enter for the service charge.
To exceed this limit, the workstation operator must have
the 158 - Authorize/Perform Over HALO Amounts on
[Service Charge] Keys option set for the employee role.
When you set the value to 0, there is no HALO for the
service charge.
This field does not apply to automatic service charges.
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Table 12-1    (Cont.) General Tab Fields

Field Description

Print Class Select the Print Class for the service charge.
Introduction to Print Class Output contains more
information.

Tax Class To apply a tax class to the service charge, select a Tax
Class from the drop-down list.

Privilege Group Select a Privilege Group to restrict use of this service
charge to employees who are associated with the same
privilege group. You can set the field to 0 to allow all
employees to use the service charge.

Percent to Tips Paid Enter the percentage of a charged tip that posts to the
Tips Paid Tender/Media.

Report Group Select the report group to which this service charge
record belongs.
Report groups are subcategories that allow reports to
show similar service charges grouped and subtotaled
together. You can configure report groups from the
Report Groups module, in the Reporting section of the
Property tab.

6. Select the Service Charge options as described in the following table:

Table 12-2    Service Charge Options

Option Description

1 - ON = Open; OFF = Preset Select this option to make the service charge an open
service charge, prompting the workstation operator for
the amount or percentage. Deselect this option to use a
preset amount or preset percentage for the service
charge.

2 - ON = Amount; OFF =
Percentage

Select this option to make the service charge an amount
service charge. Deselect this option to make the service
charge a percentage service charge.

3 - Post to Charged Tips Total on
Tip Reports

Select this option to post the service charge to the Direct
Charged Tips total. This option records charged tips that
employees receive directly from customers. If you select
this option, workstation operators who use it must also
enter a charge payment using a tender with Tender/
Media option Post to Charged Receipts on Tip Reports
set.
Select either 3 - Post to Charged Tips Total on Tip
Reports or 11 - Do Not Post to Gross Receipts, but not
both.
Select either 3 - Post to Charged Tips Total on Tip
Reports or 4 - Post to Service Charges Total on Tip
Reports, but not both.
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Table 12-2    (Cont.) Service Charge Options

Option Description

4 - Post to Service Charges Total on
Tip Reports

Select this option to post the service charge to the
Service Charges total, but not the Total Tips or the Gross
F&B Receipts total. Deselect this option to post the
service charge to the Gross Food and Beverage Receipts,
but not to the Service Charges total. The Service Charges
total on tip reports meets the reporting requirements of
United States IRS Form 8027, which states that this total
should equal all tips that are paid to the employee as
wages, and are less than 10% of the transaction total.
Select either 3 - Post to Charged Tips Total on Tip
Reports or 4 - Post to Service Charges Total on Tip
Reports, but not both.

5 - Reference Entry Required Select this option to require the workstation operator to
enter an alphanumeric reference entry when using the
service charge.

6 - Validation Required Select this option to print a validation chit when the
workstation operator uses the service charge.

7 - Non-Revenue Service Charge
(No Post to Sales)

Leave this option deselected. This option is used to
create a service charge for gift card/certificate sales,
which are not supported with Simphony Essentials.

9 - Reset Itemizer(s) Select this option to reset service charge itemizers.
When set, service charges can only apply once to menu
items that post to the same service charge itemizers.
Deselecting this option allows multiple service charges
to apply to the same service charge itemizers.

10 - Service Charge Adds to Guest
Count

Select this option to increment the transaction’s guest
count by one every time the service charge applies to
the transaction. This option is often used for non-
revenue service charges that apply as cover charges.
Selecting the RVC Parameter option 8 - Use Number of
Seats for Guest Count overrides the setting of this
option. When the workstation operator presses the
Number of Guests key during a transaction, the guest
count no longer increments when the service charge
applies to the transaction. The workstation operator
must maintain the guest count manually from that
point.

11 - Do Not Post to Gross Receipts Select this option to prevent checks with this service
charge from posting to gross F&B receipts on tip reports.
This is intended for service charges that meet the United
States Internal Revenue Service’s definition of non-
allocable receipts (as defined in the IRS Instructions for
Form 8027). Deselecting this option allows the service
charge to post to gross F&B receipts on the tip reports.
Select either 3 - Post to Charged Tips Total on Tip
Reports or 11 - Do Not Post to Gross Receipts, but not
both.

12 - Item is Shareable Select this option to share the item between two or more
seats or two or more checks when using TouchEdit or
TouchSplit.
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Table 12-2    (Cont.) Service Charge Options

Option Description

13 - Cash Tips Select this option to add the Direct Cash Tips total on the
tip reports. Selecting option 3 - Post to Charged Tips
Total on Tip Reports or 4 - Post to Service Charges
Total on Tip Reports overrides this option.
This option is used in a cashier environment where the
guest leaves the table and pays the check directly with a
cashier. When paying the bill, the guest indicates to the
cashier to give the change to the server. After receiving
payment, the cashier can post a value to a Cash Tip
Service Charge. This Cash Tip Service Charge posts to the
employee’s Direct Cash Tips total on the Employee Tip
Report.

14 - Service Charge Used For
Stored Value Transactions

Select this option if the service charge is used for stored
value transactions.

17 - Use Floor Amount (Automatic
Service Charges Only)

Select this option to require a minimum value for the
automatic service charge. Then enter the minimum floor
amount in the Amount field, which is only active for
percentage service charges when you select option 17.
This option only applies to the service charge in revenue
centers where it is used as an automatic service charge.

18 - Gift Certificate Sold Select this option to create a service charge that can be
paid without posting to sales totals. (A tracking group
total can track the amount if necessary.) This option is
similar to 7 - Non-Revenue Service Charge, except that
menu items can be present on the check in addition to
the service charge. When you select this option, you
must configure the service charge as an amount. If a
tender requires a cashier link, posting a non-revenue
service charge also requires a cashier link. Selecting this
option dims option 7.

30 - Prorate Service Charges to
Menu Items

Select this option to prorate the service charge based on
the value of the menu items. This overrides the
requirement for the minimum guest count for a memo
check, if the minimum guest count requirement is met
for the entire check.

7. Click the Menu Levels tab.

8. In the Menu Level Configuration section, select the Active On Main Levels and Active
On Sub Levels on which the service charge is active.

9. In the Main Level Popup and Sub Level Popup sections, select Transaction Default to
return the transaction to the default Main Level or Sub Level after the service charge is
pressed, select 0 - Stay Down to keep the current transaction levels, or select one of the
levels 1-8 to become active. Deselect Transaction Default to make the other levels active
for selection.

10. Click the Effectivity Groups tab.

Effectivity groups allow you to configure and package promotions so that the service
charges are only available for a fixed period of time. If effectivity groups do not exist, you
must create one or more in the Effectivity Groups module. Configure Effectivity Groups
contains more information.

11. Click the Add Effectivity Record link.
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12. Click the Select link adjacent to Effectivity Group, select the effectivity group, and then
click OK twice. The new effectivity record shows the discount name, Effectivity Status (for
example, Active or Future), Date Start, and Date End.

13. Click Save.

14. To set an automatic service charge for the revenue center:

a. Select the revenue center, click Setup, and then click RVC Parameters.

b. On the General tab in the # Of Guests Before Auto Service Charge field, enter the
number of guests required to trigger the automatic service charge for a transaction.

If set to a value greater than 0, the automatic service charge is applied to the check
after the number of guests equals or exceeds the value entered in this field. You must
also select option 10 - Auto Service Charge Defaults to Off (step 15d below).

c. Click the Options tab.

d. Deselect 10 - Auto Service Charge Defaults to Off to apply the automatic service
charge set in the Tender Parameters module for each transaction.

If # Of Guests Before Auto Service Charge (step 15b above) is set to a value greater
than 0 (zero), selecting this option makes the Auto Service Charge default to off. When
a transaction has the number of guests specified in the # Of Guests Before Auto
Service Charge field, the Auto Service Charge becomes active. If # Of Guests
Before Auto Service Charge is set to 0 (zero), the workstation operator can apply the
service charge.

e. Click the Posting tab.

f. To round the service charge, select the appropriate rounding option:

• 13 - Round Service Charge % Entries: Select to round percentage service
charge amounts according to the Round Service Charge % to 0, 10 and Round
Service Charge % based on 10s digit option settings. Deselect to round the
amounts to the nearest least significant digit.

• 14 - Round Service Charge % to 0, 10: Select to round percentage service
charge amounts to the nearest 0 or 10 increment. Deselect to round the
percentage amounts to the nearest 0, 5, or 10 increment. You must also select
option 13.

• 15 - Round Service Charge % Based on 10s Digit: Select to round percentage
service charged amounts based on the second least significant digit. Deselect to
round the percentage amounts based on the least significant digit. You must also
select option 13. This option is also affected by option 14.

g. Click Save.
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13
Menu Items

Introduction to Menu Items
A menu item is the foundation of transactions. Anything ordered is a menu item. In restaurants,
food and drinks are menu items. In retail stores, shirts and hats are also considered menu
items. Therefore, any item being sold is a menu item.

Menu item configuration consists of a group of components that are assembled to make the
menu item function as needed. The following table shows the menu item components grouped
into two categories of tasks: reporting and behavior.

Table 13-1    Menu Item Components

Reporting Tasks Behavior Tasks

Major Group Menu Item Definition

Family Group Menu Item Class

Master Record Price Record

A single menu item can be broken down into six parts that create the whole.

Major Group

A major group is a product category and is the broadest reporting category. Common examples
of major groups are food, non-alcoholic beverages, liquor, beer, wine, and retail merchandise.
They are used to group items for revenue reporting, such as how much food was sold today or
this month.

Family Group

Family groups are smaller groups within the major group to which they belong. Typically, a
family group is a subset, or product sub-category, of a specific major group. Common
examples of family groups are appetizers, salads, entrées, desserts, vodka, gin, and t-shirts. A
family group is more specific in reporting tasks as it helps detail quantities such as burgers sold
or bottles of X brand of beer ordered.

The following figure illustrates an example of major groups and family groups.
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Master Record

Master records offer the sharpest level of reporting detail as they are the actual menu items
themselves. Examples of master records are Cheeseburger, Oracle Suds IPA, and specific
pieces of merchandise purchased by customers (hats or shirts). Master records are also the
bridge to the behavioral side of the menu item: menu item definition, menu item class, and
price record.

Menu Item Definition

Each master record can have up to 64 possible definitions. The definitions begin to diversify a
menu item, defining when the item is available by enabling the different menu levels, as well as
where the item is available. The definitions bridge to the reporting side of the menu item and
also link to the menu item class and to the menu item price.

Menu Item Class

The menu item class is the element of the menu item that defines whether the item requires, or
is required by, another item. For example, if the menu item being configured is a cheeseburger,
it will likely be configured with a menu item class that requires the guest to select a meat
temperature after selecting the burger. When the cheeseburger is ordered, the workstation
operator will be prompted to select the meat temperature menu items that were configured to
appear on the workstation at that time. In this example, the meat class can be used as the
class for any menu item that only requires a meat temperature. If an item requires a meat temp
and a cheese choice, that item needs a new class that requires two condiments instead of only
one. On the other hand, if the item being configured is a meat temperature such as rare, the
item might be given a class that presents itself on the workstation as an option when a burger
is ordered. All items that are meat temperatures receive the same class, meaning they all
behave the same way and appear for selection when the burger is ordered.
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Each menu item class is constructed to fit a business need, and each menu item definition
requires and is limited to a single menu item class, without which it does not appear on the
workstation.

Price Record

A menu item price is the amount charged for the sale of a menu item. In Simphony Essentials,
menu item prices are configured per menu item definition. Typically a definition has one price,
but a definition can be configured with multiple prices (for example, small/medium/large soda),
or with no price (common for condiments). Each menu item definition can have up to eight
price records. This allows flexibility in configuring a menu item, like ketchup, to be free in one
instance when it comes with a meal, and priced in another instance when it is ordered as extra
on the side. A beer can cost $3.50 during the day but only $1.50 during happy hour.

• Price Record #1: $3.50

• Price Record #2: $1.50

Prices are mandatory for reporting sold and prep counts, even if the price record is $0.00. If an
item does not have a price record, it does not appear on reports and does not deduct from
inventory counts. Prep or descriptive menu items, such as “Do Not Make”, “Sunny Side Up”,
and “Rare” typically do not receive price records.

Configure Major Group
A major group is a grouping of related menu items for reporting sales summaries. A major
group is the highest level of the reporting structure for categorizing menu items. Major groups
are considered the more general category of sales, while family groups are more specific.

A major group is usually a general category of similar menu items. Typical major groups are
Food, Non-Alcoholic Beverages, Liquor, Beer, Wine, and Retail Merchandise.

You can use major groups when running the Major Group Sales Report on the workstation.
Each major group also has a report group number associated with it. The report group
numbers are used to view subtotals of major groups on reports. By using report groups, users
can see sale subtotals.

1. Select the Enterprise, click Configuration, and then click Major Groups.

2. Click the Insert icon ( ) on the toolbar.

3. In the Insert Record dialog, enter the Record Name for the major group (for example,
Food), and then click OK.

4. Enter a number other than 0 (zero) in the Report Group field.

For example, you can enter 1 for the Food major group and enter 2 for the Non-Alcoholic
Beverages major group. When you enter 0 (zero), the menu item does not appear on
reports.

5. Click Save.

Configure Family Group
A family group is a grouping of related menu items for reporting sales summaries. Each menu
item is linked to a family and a major group. Family groups are often subsets of major groups.
For example, menu items linked to family groups Appetizers, Soups, Salads, Entrées, and
Desserts might also be linked to a major group called Food.

The following is a typical example of how family groups are configured:
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Food

• Appetizers

• Soups

• Salads

• Entrées

• Desserts

Non-Alcoholic Beverages

• Sodas

• Juices

• Smoothies

• Other

You can use family groups when running the Family Group Sales Report on the workstation, or
to sort items within other reports. Each family group also has a report group number
associated with it. The report group numbers are used to view subtotals of family groups on
reports.

1. Select the Enterprise, click Configuration, and then click Family Groups.

2. Click the Insert icon ( ) on the toolbar.

3. In the Insert Record dialog, enter the Record Name for the family group (for example,
Appetizers), and then click OK.

4. Enter a number other than 0 (zero) in the Report Group field.

Report Groups let you see family group food sales subtotals together in whichever way the
enterprise needs. For example, appetizers, soups, and salads may be Report Group
Subtotal 1; domestic and imported beers may be Report Group Subtotal 2.

5. (Optional) Select the Parent Major Group to which the new family group belongs.

By associating the family group and major group here, the application limits the family
group assignment for a menu item to those family groups linked to the item’s major group.

6. Click Save.

Configure SLU Group
A screen look up (SLU) is a button that gives workstation operators access to a list of items,
except the workstation shows each item in the list as a separate touchscreen button. When a
workstation operator presses a menu item SLU (for example, sandwiches), the workstation
shows all menu items belonging to that SLU. You can assign each menu item master record to
a maximum of 8 different SLUs.

The SLU names appear in various colors on workstation, automatically allocated by the
application.

1. Select the Enterprise, property, or revenue center, click Descriptors, and then click Menu
Item SLU Names.

2. Enter names for menu item screen look ups in the Text column.
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There is no sort priority; the SLU names appear on the workstation screen in number
order. Set up the SLU group names with plenty of space between the numbers to provide
flexibility when adding more.

Figure 13-1    Example of Menu Item SLU Names

3. Click Save.

4. Select the Enterprise, property, or revenue center, click Configuration, and then click
Menu Item Maintenance.

5. Search for the menu item.

Searching and Filtering Menu Items contains more information.

6. To assign a SLU group to the menu item, click the ellipsis point (...) button adjacent to the
menu item First Name, select the SLU, and then click OK.

7. Click Save.

Configure Condiment Group
Condiment groups directly impact menu item classes, and consequently the menu items
associated with them.

Condiments are menu items used to indicate preparation and other instructions for a menu
item. They are sometimes referred to as modifiers. Examples include salad dressings (a group
of condiments) such as Blue Cheese, Ranch, and Italian; meat temperatures (a preparation
instruction) such as Rare, Medium, and Well Done; and other instructions such as Sauce on
Side or No Sauce.

The individual condiments (Rare, Medium, and Well Done) are assigned to the condiment
group of meat temperatures, and the condiment group is then associated with menu items
through the menu item class.

1. Select the Enterprise, property, or revenue center, click Descriptors, and then click
Condiment Group Names.

2. Enter condiment group names (for example, Meat Temp or Cheese Choice) in the Text
field.

As a best practice, the condiment groups list should show all modifiers grouped by type.
Do not mix groups (for example, do not mix meat temperature and cheese choices)
together. Each collection of modifiers is usually its own group.

To accommodate changes in future menu offerings that may introduce new condiment
groups, you may want to leave open record rows between the condiment groups by setting
them up in non-contiguous order. This allows you to set up a new condiment group that will
be prompted for in the appropriate order if multiple condiment groups are required for a
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menu item. The order in which a condiment group appears here dictates the order in which
they appear on the workstation. If required, record 1 appears first, followed by 2, and so
on.

Enter the names of the modifier groups in a way that is easy to understand for workstation
operators and other employees.

3. Click Save.

4. Select the Enterprise, property, or revenue center, click Configuration, and then click
Menu Item Classes.

5. Double-click the menu item class.

6. Click the Condiment Groups tab. The list of condiment groups (entered in step 2)
appears.

• See also Configure Regular Menu Item Class - Requiring Condiments for more
information about making the condiment groups required or allowed for the menu
items to which the class is assigned.

• See also Configure Condiment Menu Item Class for more information about making
the condiment groups a member of menu items to which their class is assigned.

Introduction to Menu Item Classes
A menu item class defines the operating characteristics of the menu items assigned to it. Menu
item classes help determine many aspects of an item’s behavior, including:

• Order device or printer destinations

• Condiment requirements

• Taxes, discounts, and service charges that can apply

• Privilege options (which employees can order the menu item)

When setting a menu, locations separate menu items into groups dependent on behavior.
Menu item classes give those menu items the behavior. For example, if a certain group of
items require the workstation operator to select a meat temperature, all of those items could be
associated with the same class. Examples of the items could be a hamburger, a tuna steak,
and a prime rib. While hamburger, tuna steak, and prime rib are all different items, they are
prepared at the same preparation station in the kitchen, and all require a meat temperature
specification. Because of these similarities, they may be assigned to the same menu item
class.

If a group of items needs the workstation operator to select two modifiers, such as a meat
temperature and a cheese selection, they would receive a different class. Menu item classes
are based on what the items need, not what the item is.

The Menu Item Maintenance module is used to configure the two types of menu items
(Regular and Condiment), and each requires a menu item class. By default, every menu item
class is a Regular menu item class. A Regular class is used for menu items that appear on a
menu as any item that is ordered on its own by a guest. These could include a sandwich or
steak, a soda or a cup of coffee. In other words, a regular item is any item that is not a
condiment. A condiment is a menu item that modifies the regular menu item. An example is the
cheese selection for a sandwich. The sandwich is the regular menu item and the cheese
choice is the condiment. There are often multiple options when selecting condiments like
cheese. To make things easier, Simphony Essentials collects condiments together and places
them into a Condiment Group. In the cheese selection example, each type of cheese can each
be its own condiment menu item (Cheddar, Pepperjack, Provolone, and so on), and grouped
together because they share the same identifying quality: they are all selections of cheese.
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Together they can form a Condiment Group called “Cheese Choice”, and can all receive the
same menu item class. The class tells the menu items they are A) Condiments and B) part of
the same Condiment Group.

Among regular menu items, some require a selection of condiments to accompany them.
These items are given Required Classes. Using the meat temperature example, the
hamburger, tuna steak, and prime rib all receive Required Classes. This particular class tells
the application that in order to register as a complete item, each item needs a selection of a
meat temperature.

Regular Classes associated with menu items require no additional modifiers. These are called
by different names based on the person setting up your Enterprise, but you can think of them
as “Food No Prep” classes. For example, a hummus plate appetizer does not usually require
modifiers or prep, but it is still a regular item (not a condiment). The item can be ordered on its
own and does not modify another menu item.

Configure Menu Item Class
1. Select the Enterprise, property, or revenue center, click Configuration, and then click

Menu Item Classes.

2. Click the Insert icon ( ) on the toolbar.

3. In the Insert Record dialog, enter the Record Name for the menu item class, and then click
OK.

4. Double-click the new menu item class record.

5. On the General tab, configure the appropriate settings:

Table 13-2    General Menu Item Class Fields

Field Description

Tax Class Select the tax class to apply to the menu item
class. To leave the tax class blank, select 0 -
None.

Main Level Popup Select the Main Level of the transaction that
becomes active after ordering a menu item
from the menu item class.

Sub Level Popup Select the Sub Level of the transaction that
becomes active after ordering a menu item
from the menu item class.

Privilege Group Select a Privilege Group number to restrict
the use of menu items in the menu item class
to employees who are linked to the same
Privilege Group.
To enable all employees to order items in the
menu item class, select 0 (zero).

Sales Itemizer Select the Sales Itemizer that is associated
with this Menu Item Class.
The Sales Itemizer is often used for interface
(Property Management System) purposes, or
to replace the Subtotal on printed guest
checks and customer receipts. You can either
see the Subtotal, or Food, Liquor, Beer, and
Wine.
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Table 13-2    (Cont.) General Menu Item Class Fields

Field Description

Discount Itemizer Select the discount itemizer to determine
which discounts can apply to specific menu
items.

Srv Chrg Itemizer Select the Service Charge Itemizer that is
associated with this Menu item Class. The
Service Charge Itemizer is used to determine
which Service Charges can be applied to
specific menu items. Note that the automatic
service charge is unaffected by this setting;
only Menu Item Class Option 12 - Add to
Automatic Service Charge Itemizer affects
the Automatic Service Charge posting.

HALO Enter the High Amount Lock Out (HALO)
value for menu items in this Menu Item Class.
This field represents the total dollar amount
of the items that are being ordered, and it is
often used for Open Priced menu items. For
example, if this field is set to 50, the operator
is prompted to confirm items in this class if
they exceed 50.00. Note that the entered
value must contain all zeroes except for the
first digit. Valid values are: 2, 20, 200, 2000.
Invalid values are 45, 450, 405.
HALO is also often used for preset priced
menu items to safeguard against erroneous
entry. For example, the price of Coffee
is $1.00. A workstation operator could post 1
Coffee, 5 Coffees or 10 Coffees if someone is
getting coffee for their entire office. It is
unlikely that someone would order 100
Coffees ($100). It is likely that someone
ordering 10 Coffees inadvertently presses an
extra 0 when entering the quantity.

Condiment Order Type This setting describes how the condiment is
added to a check when it is ordered.
• 0 - Add: Select to create a new item on

the check even if it already exists for that
parent.

• 1 - Increment: Select to add the item if it
does not exist for the parent or
increments an existing one.

• 2 - Replace in Condiment Group: Select
to remove any items that exist in the
item’s member condiment group before
adding it (this simulates a radio button
effect).

• 3 - Replace in Master Group: Select to
remove any items that exist in the item’s
master group before adding it.

• 4 - Toggle: Select to switch the item on
and off.
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Table 13-2    (Cont.) General Menu Item Class Fields

Field Description

Pricing Calculation Select the calculation method to use for
pricing menu items in the class.
• 0 - Based on entered count: Select to

base the price on the amount entered.
• 1 - Based on sales count when sales

rounded up: Select to base the price on
the rounded up count.

Count Display Select the manner in which the amount
appears for a decimal item on the
workstation and printers.
• 0 - Show entered amount
• 1 - Show sales count amount with

entered count as reference
The count for an item can be entered as a
decimal. There are two counts kept for
an item; the entered amount, and the
sales count. The sales count is always the
entered amount if the entered amount is
a whole number. If the entered amount
is not a whole number then the sales
count is the entered amount, only
rounded up. For example, if a user enters
1.5, then the entered amount is 1.5 and
the sales count is 2. This field determines
whether the entered amount or the sales
count appears on workstations and
printers.

Count Entry Select the manner in which workstation
operators can enter the sales count of an item
in the class.

Print Group Enter the Print Group (1-99). The sorting
mechanism uses this value for receipt
printing, check detail, and order output
devices. When the items are set to use groups
for sorting, the items appear from lowest
group number to highest.
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Table 13-2    (Cont.) General Menu Item Class Fields

Field Description

Print Class Select the print class for the menu item class.
Menu items print based on the print class.
There are four basic print class output
destinations:
• Receipts: Printed at the workstation at

the end of a fast transaction. Typically
used in a QSR environment where
ordering menu items and tendering the
check is performed in the same service
round.

• Guest checks: Printed at the workstation.
Typically used in a TSR environment.
Checks usually include a table number or
guest name and are service totalled
several times before final tender.

• Order devices: Remote kitchen or bar
printers, or KDS devices. These devices
deliver the order to the production area
from the workstation.

• Journal: Not a physical device, but an
electronic file journal that provides audit
capabilities in the application.

The Print Class can link to a menu item class,
or directly to a menu item definition. When
linked to the definition, the Print Class
overrides the standard print class linked here
to the menu item class.
If the Condiment Prefix Type is set to
anything except 0 - Not a Prefix, prefix
condiments follow the same print class
setting chosen for the condiment with which
they are associated.

KDS Highlight Scheme Select the KDS Highlight Scheme color to
display menu items on the KDS.

Condiment Prefix Type Select the prefix type associated with the
condiment type.

Condiment Handling with Parent Item
Switching

Select from the following condiment
behaviors to use for default and other
condiments, when the parent item is
switched in Conversational Ordering. All
options are applicable when using
Condiment Prefixes.
• 0 - Condiments Remain Unchanged:

Condiment modifications will be
unchanged.

• 1 - Reset Default Condiments Only:
Only reset default condiments for a
menu item.

• 2 - Reset All Condiments: Reset all
condiment types.

Service Charge Group Select the Service Charge Group to apply to
this Menu Item Class. Select 0 - None for no
service charge.
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Table 13-2    (Cont.) General Menu Item Class Fields

Field Description

Pre-Production Chit Print Class Select a Print Class to print pre-production
chits to remote printers for the menu items
assigned to this Menu Item Class. Remote pre-
production chit printers are assigned in the
Print Classes module.

Allergen Class Select the Allergen Class for this menu item
class.

6. Click the Options tab, and then select the appropriate options.

Table 13-3    Menu Item Class Options

Option Description

1 - ON = Open-Priced Menu Items; OFF =
Preset Menu Items

Select this option to require workstation
operators to enter a price when adding a
menu item in the class. Deselect this option if
you are using preset prices.

2 - ON = Condiment Menu Items; OFF =
Regular Menu Items

Select this option to make this class a
Condiment class, meaning that any menu
item linked to this class also becomes a
condiment.

3 - Negative Priced Menu Items Select this option to have menu items in this
class post a negative price. This option causes
a minus sign (-) to appear before the price.

4 - Increment Seat Number With Sale of these
Menu Items

Select this option to increase the seat number
each time a workstation operator adds a
menu item in the class. This feature is not
available when seat filtering is active.

5 - Reference Entry Required Select this option to require workstation
operators to enter a reference entry when
adding menu items in the class. The text that
is entered outputs to order devices, checks,
receipts, and journals.

6 - Validation Required Select this option to print a validation chit at
the validation printer designated in the
Workstation module.

7 - Item Discounts May Be Applied to these
Menu Items

Select this option to allow menu items in the
class to be discounted with an item discount
(manual discount only).

8 - Allow Menu Items in this Class to be Non-
Priced

Select this option to allow menu items in the
class to be non-priced. By default, menu
items without a price record do not appear
on a workstation page. Any item that does
not need a price record, such as some
condiments, needs to have this option
enabled to appear on a workstation.
When selected, associated menu items can
have a price record, but it is also acceptable if
they do not have a price record.

9 - Condiment Changes Print Group of Parent
Menu Item

Select to force a parent menu item that is
modified by a condiment to use the Print
Group assigned to the condiment.
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Table 13-3    (Cont.) Menu Item Class Options

Option Description

10 - ON = Use Sub Level Pricing; OFF = Use
Main Level Pricing

Select this option to apply Sub Level pricing
to menu items assigned to the menu item
class.

11 - Add to Guest Count Select this option to increase the guest count
each time a workstation operator adds menu
items that are assigned to the class. When
this option is selected and the Guest Count
field is set to 0, Simphony increments the
guest count in the transaction by one.
If a workstation operator uses the Number of
Guests function key during a transaction, the
guest count no longer increments when
menu items in the class are added to the
check.

12 - Add to Automatic Service Charge
Itemizer

Select this option to add sales of the menu
items in this class to the Automatic Service
Charge itemizer. Automatic service charges
apply to all menu items associated with Menu
Item Classes where this option is enabled.

13 - Print Price on Order Chit Select this option to print the menu item
price on order devices. This option is
typically used with open-priced menu items.
Order Devices option Wrap Condiments
overrides this option.

14 - Do Not Put in Transaction Detail Select this option to prevent zero-priced or
non-priced menu items in the class from
printing, appearing, or posting.

15 - Weighed Items Select this option if all menu items in this
class are sold by weight.

17 - Print Name 1 and Name 2 on Checks Select this option to print the First Name and
the Second Name (from the Menu Item's
Definition record) of all menu items
associated with the class on guest checks. For
example, with wine menu items, the First
Name shows the name of the wine, while the
Second Name shows the Bin Number and the
type of wine.

21 - Require Number of Condiments to Match
Number of Parent Items

Select this option to require the number of
required condiments to match the number of
parent menu items ordered.

22 - On = Use Own Output Link; Off = Use
Parent's (Condiments Only)

Select this option to have condiments in this
class print to their own order devices.
Deselect to have condiments print to the
same order devices as the parent menu item,
provided that the menu item class has the
same order devices configured.

23 - Add Condiment Price to the Parent Item's
Price on Check Only

Select this option to add condiment prices to
the parent menu item's price on guest checks.

24 - LDS Items (International LDS Only) Select this option if all menu items in this
class can be ordered using an International
Liquor Dispensing System (ILDS). Deselect if
using a North American Dispensing System
(NALDS).
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Table 13-3    (Cont.) Menu Item Class Options

Option Description

26 - Keep Main Level With Repeat Rounds Select this option to enforce items in this
class to use the same main menu level that
was in effect during the most recent service
round when ordered using the Repeat Round
key. Deselect to use current menu levels.

27 - Keep Sub Level with Repeat Round Select this option to enforce items in this
class to use the same sub menu level that was
in effect during the most recent service
round when ordered using the Repeat Round
key. Deselect to use current menu levels.

28 - Print Main Level Prefix and Suffix Select this option to have the main level
prefix or suffix appear on the check detail
area and to print on order output devices,
guest checks, and customer receipts.

29 - Print Sub Level Prefix and Suffix Select this option to have the sub level prefix
or suffix appear on the check detail area and
to print on order output devices, guest
checks, and customer receipts.

30 - Sort Condiments by Print Group Select this option to sort condiment display
and printing tasks according to their Print
Group assignment.

31 - Prompt for Seat Number with Each Menu
Item

Select to prompt Enter Seat Number after
adding each parent item with this menu item
class. Deselect to supress the seat number
prompt. You can disable seat numbers for a
revenue center and use a condiment group
set with menu items named Seat 1, Seat 2,
and so on.

34 - Item is Beverage Select if all items in this Menu Item Class are
beverages. Use this option with Beverage
Control to track beverage usage.

35 - Fixed Price Meal Select this option to indicate all menu items
in the class are the priced (parent) portion of
a fixed price meal.

38 - Item is Shareable Select this option to allow menu items in the
class to be shared between two or more seats,
or two or more checks.

39 - Retail Item Select this option to designate all menu items
in this class as retail items. Retail items do
not post to Gross Food and Beverage receipts.
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Table 13-3    (Cont.) Menu Item Class Options

Option Description

41 - Consolidate Menu Items with
Condiments on Order Output

Select this option to consolidate parent menu
items on Order Device Output, and then to
print each condiment with its seat number to
which the condiment applies. (The Order
Device option, Print Seat Numbers with
Individual Items must be enabled). For
example, if this option is enabled, and an
operator orders Chicken Wings with
condiments ‘Extra’ and ‘Sauce’ on Seat 1, and
Chicken Wings with condiments ‘Without’
and ‘Bleu Cheese’ on Seat 2, then the Order
Device Output shows the following:
Seat 1,2: Chicken Wings
S1 Extra
S1 Sauce
S2 Without
S2 Bleu Cheese

42 - Consolidate parents with matching
condiments on Order Output

Select to consolidate parent menu items with
identical (matching) condiments.

49 - Participates in Menu Item Master
Switching

Select to switch a parent menu item based a
menu level change. All items switching based
on menu levels must belong to the same
Master Group, and each item's menu item
class has this option set. The menu item must
be set as a Condiment Prefix.

51 - Item must be complete before beginning
another item

Select this option to prevent workstation
operators from adding a second menu item
before completing the first item. This option
is not used with required condiments.

52 - Prompt to begin another item if this item
is incomplete

Select this option to prompt to move to the
next item before completing a menu item
order.

53 - Remove Item on Subsequent Press if
Ordering Type is Exclusive

Select this option to remove a condiment
item and revert the parent menu item to the
default state. The menu item must be set as a
Condiment Prefix.

55 - Discounts Apply to Priced Condiments
(parent items only)

Select this option to apply discounts to parent
items in this class and all priced condiments
associated with the items. Deselect to apply
discounts only to parent items. The menu
item must be a Condiment Prefix.

57 - Parent items appear on condiment order
devices (for condiments only)

Select this option to send the parent item to
the order devices set for this class. Deselect to
send parent menu items based on the menu
item class settings only. The menu item must
be set as a Condiment Prefix.

58 - Condiment order device programming
overrides that of parent

Select this option to allow the order devices
set for this condiment’s class to override the
order devices defined for the parent items.
The menu item must not be a Condiment
Prefix.
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Table 13-3    (Cont.) Menu Item Class Options

Option Description

59 - Allow Item Incomplete Based On Role Select this option to allow the employee to
add the parent menu item without the
required condiments. You must also select
Allow Incomplete Item in the Roles module
for the employee.

63 - Autofill Select this option to adjust the quantity to
satisfy the required condiments when adding
the condiment with a required condiment
group that has Min/Max set, and more than
one condiment is still needed.

65 - Support Enhanced Prefix Mode (Parent
Only)

Select this option to enable enhanced prefix
support for non-condiment menu items in
this class. Enhanced prefix support uses
condiment prefix items to describe
condiments, such as Extra or No.

69 - Prompt to lookup menu item definition
based on current menu levels (Repeat
Rounds)

Select this option to prompt the workstation
operator to look up a menu item definition
based on the current menu levels when a
repeatable menu item is unavailable. You
must also select options 26 - Keep Main
Level With Repeat Rounds and 27 - Keep
Sub Level With Repeat Rounds.

74 - Prevent Menu Items from Being Held Select this option to prevent menu items
belonging to this menu item class from being
held.

76 - Post Sales Count To KDS Reports Select this option to add the menu item count
to the Menu Item Count totals on KDS
reports.

77 - Only allow condiments with an active
price record

Select this option to have condiment items
with an active effectivity price record appear
in SLUs. When the effectivity record is
expired or has a future date, the condiments
are not available in SLUs.
You must also disable option 8 - Allow Menu
Items in this Class to be Non-Priced.

78 - Forgive Inclusive Tax Select this option to forgive the inclusive tax
for the Menu Item Class.

79 - Do not print unpriced condiments on
Guest Checks

Select this option to prevent unpriced
condiments from printing on guest checks
and customer receipts.
Option 79 applies to the menu item
condiments. For example, if there is no
charge for lettuce on a sandwich, you can
configure this condiment to not print. If there
is a charge for avocado on a sandwich, you
can configure this condiment to print.
You must also select 65 - Support Enhanced
Prefix Mode (Parent Only) for the main
menu item (such as a hamburger or chicken
sandwich) that can be modified with
condiments.
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Table 13-3    (Cont.) Menu Item Class Options

Option Description

81 - Use like item order routing Select this option for menu items in this class
to use the tender/media like item order
routing print class if the order contains only
items with this option set.

82 - Contains alcohol Select this option for menu items in this class
to be marked as containing alcohol.

7. Click the Condiment Groups tab.

There are three sections:

• Required

: Does the menu item require a condiment?

• Allowed

: Does the menu item allow condiments?

• Member

: Is the menu item a member of a group of condiments?

a. For Regular classes, select the Required Condiment Groups. These require a
selection to be considered a complete menu item.

b. To allow a condiment as an option for guests, select the Allowed Condiment Groups.
If extra condiments are an option, make sure the Condiment Group is allowed.

c. Select the Member Condiment Groups for the class.

For example, if the condiment class is Meat Temp, select Meat Temp from the Member
Condiment Groups list. The condiment menu items can be:

• Rare

• Medium Rare

• Medium

• Medium Well

• Well Done

8. Click Save.

Configure Regular Menu Item Class - Requiring Condiments
The following instructions help you configure a menu item class for menu items requiring a
condiment. Certain menu items require a selection of one or more condiment menu items. For
example, a cheeseburger may require the selection of both a meat temperature and a type of
cheese. The menu item class for the cheeseburger must be configured to require the members
of the two Condiment Groups to appear on the workstation for selection when the
cheeseburger button is pressed.

It is helpful to use a naming convention that allows users to distinguish between types of menu
item classes and to identify their purpose: what Condiment Groups they Require, Allow, or are
a Member of; what order devices they output to, and so on. You could use a shorthand letter at
the beginning of the Regular and Required and Condiment or Member classes:

• An upper case “R” for the classes requiring a condiment
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• A lower case “m” for classes that are members of Condiment Groups

1. Select the Enterprise, property, or revenue center, click Configuration, and then click
Menu Item Classes.

2. Click the Insert icon ( ) on the toolbar.

3. In the Insert Record dialog, enter the Record Name for the regular menu item class
requiring condiments, and then click OK.

An example is R-Meat Temp/Cheese Choice.

4. Double-click the new menu item class record.

5. On the General tab, configure the following settings:

Table 13-4    General Menu Item Class Fields

Field Description

Tax Class Select the tax class to apply to all menu items
that receive this class. To leave the tax class
blank, select 0 - None.

Print Class Select the print class to apply to all menu
items that receive this class.

6. Click the Options tab, and then select the appropriate options. See Configure Menu Item
Class for a description of each option.

7. Click the Condiment Groups tab.

a. In the Required Condiment Groups column, select the condiment groups that are
required for the menu items to which this class is assigned.

Using the R-Meat Temp/Cheese Choice menu item class example, the Meat Temp and
Cheese Choice Condiment Groups are enabled.

b. In the Allowed Condiment Groups column, select the condiment groups that are
allowed for menu items to which this class is assigned.

If these allowed condiment groups are disabled, the only condiments permitted with
menu items associated with this class are those being required.

8. Click the Forced Condiments tab.

You can edit the minimum and maximum number of condiment choices the workstation
operator can select. If a group (for example, Cheese Choice) is set to 0 (zero), the operator
is not required to make a selection. If set to 1, that is the minimum number of condiments
from that group that are required for selection.

a. In the Minimum column for a group, enter 1.

b. In the Maximum column for a group, enter the largest number of condiments allowed
for selection.

9. Click Save.

Configure Condiment Menu Item Class
The following instructions help you configure a condiment menu item class. Condiment classes
define the Condiment Group membership of menu items to which their class is assigned.
When a menu item requiring a condiment is selected in a transaction, the menu items
belonging to that Condiment Group appear.
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It is helpful to use a naming convention that allows users to distinguish between types of menu
item classes and to identify their purpose: what Condiment Groups they Require, Allow, or are
a Member of; what order devices they output to, and so on. You could use a shorthand letter at
the beginning of the Regular and Required and Condiment or Member classes:

• An upper case “R” for the classes requiring a condiment (priced menu items)

• A lower case “m” for classes that are members of Condiment Groups

1. Select the Enterprise, property, or revenue center, click Configuration, and then click
Menu Item Classes.

2. Click the Insert icon ( ) on the toolbar.

3. In the Insert Record dialog, enter the Record Name for the condiment menu item class,
and then click OK.

An example is m-meat temp.

4. Double-click the new menu item class record.

5. On the General tab, click the Print Class drop-down list and select the print class to apply
to all menu items that receive this class.

6. Click the Options tab, and select the following options:

• 2 - ON = Condiment Menu Items; OFF = Regular Menu Items

• 8 - Allow Menu Items in this Class to be Non-Priced

See Configure Menu Item Class for a description of all other options.

7. Click the Condiment Groups tab.

• In the Member Condiment Groups column, select the condiment groups to assign for
this condiment menu item class and its menu items.

8. Click Save.

Configure Regular Menu Item Class - No Condiments Required
The following instructions help you configure a menu item class for menu items that do not
require condiments. Many items that appear on a menu do not require modifiers, such as
appetizers and beer. These types of menu items need a special menu item class to tell the
items that they need no additional modifications to be marked as complete.

Often these classes are named “Food No Prep” or “Bar No Prep”, indicating that no further
preparation is needed.

1. Select the Enterprise, property, or revenue center, click Configuration, and then click
Menu Item Classes.

2. Click the Insert icon ( ) on the toolbar.

3. In the Insert Record dialog, enter the Record Name for the regular menu item class
without condiments, and then click OK.

An example is Food No Prep.

4. Double-click the new menu item class record.

5. On the General tab, configure the following settings:
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Table 13-5    General Menu Item Class Fields

Field Description

Tax Class Select the tax class to apply to all menu items
that receive this class. To leave the tax class
blank, select 0 - None.

Print Class Select the print class to apply to all menu
items that receive this class.

6. Click the Options tab, and select the appropriate options.

See Configure Menu Item Class for a description of all options.

7. Click the Condiment Groups tab.

For a No Prep class, the menu items require no modifiers and are also not members of a
Condiment Group, so you do not need to select Required Condiment Groups nor
Member Condiment Groups.

• In the Allowed Condiment Groups column, select the condiment groups that are
allowed for menu items to which this class is assigned.

When a menu item comes with a condiment, it needs to either require that condiment
(enabled in the Required column), or to have it allowed (enabled in the Allowed
column).

8. Click Save.

Introduction to Menu Levels
Menu levels are a customized way to indicate when menu items are available to workstation
operators. Menu levels determine which items within a transaction (menu items, discounts,
service charges, or tenders) can be accessed on a workstation at all times throughout the day.
There are two types of menu levels: main levels and sub levels. On the workstation, a main
level and a sub level are active at all times during any transaction. To make an item accessible,
it must be available on the current main and sub levels. Main and sub levels have two
functions:

1. They determine what items a workstation operator can and cannot access during a
transaction.

2. They can impact items, such as different prices, to be active at specific times (for example,
a Happy Hour price versus a regular menu item price).

Menu levels are often used to determine serving periods. Basic examples of menu levels are
Breakfast, Lunch, Dinner, and Happy Hour. If a location starts serving eggs at 6:00 a.m., but
stops at 11:00 a.m., as the kitchen changes to serving sandwiches the manager can use menu
levels to remove all egg items from the workstation screen. These items remain in the
database, but are not available to workstation operators at certain times.

Menu levels are also used to control sizing, meaning certain menu items only exist on a large
level, while others only exist on small or medium levels. Using menu levels for sizing allows
workstation operators to determine whether a cup or bowl of soup is ordered. You can apply
the concept of small and large to many items, such as a half sandwich or full sandwich, a glass
of wine or a carafe, a mug of beer or a pitcher, and an appetizer portion verses an entrée
portion. Workstation operators generally have manual control over the menu level that
determines item sizing.
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Menu levels are used to change pricing, such as Happy Hour level becoming effective at 4:00
p.m. on weekdays, where all beers have a reduced cost price record that is effective only when
that menu level is active. You can configure the application to manage these levels
automatically.

Two menu levels need to be active in order for menu items to appear on the workstation:

• Main level

• Sub level

The two levels work together to control the active items so that different combinations of levels
mean that different items can be active. For example, if main level 1 is called Regular and sub
level 1 is called Breakfast, only menu items and price records configured to be active on both
Regular and Breakfast levels are available when those two levels are active. If Regular is
active all day, but at 11:00 a.m., Breakfast switches to Lunch, active items only on Regular and
Breakfast are no longer available, while items on Regular and Lunch can be sold. The item’s
definition can have other levels active as well.

Menu levels are not an all-or-nothing feature; you can configure them as required. After you
configure menu levels, they can be activated in multiple places using a hierarchy of overriding
modules. If menu level defaults are specified in multiple modules, they are applied in the order
listed.

Menu Level Hierarchy

The following menu level hierarchy determines which setting controls the default transaction
menu levels:

Table 13-6    Menu Level Hierarchy

Hierar
chy
Numb
er

Enterprise Management Console (EMC)
Configuration

Description

1 Auto Menu Levels module The Auto Menu Levels table is the most
flexible of all menu level settings. It allows
for more complex menu manipulation. For
example, if a location has levels like
Breakfast, Lunch, Dinner, Happy Hour, and
Brunch, all with different menu items or
price records, the Auto Menu Levels table
controls them. Using the Auto Menu Levels
table, menu levels are configured to change
at specified times. There are 8 different
Auto Menu Levels, all of which can be
enabled on different days and times.
If the time of day falls during an active auto
menu level, the main or sub level that is
specified for that auto menu level is the
active level.
See Activate Auto Menu Levels for more
information.
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Table 13-6    (Cont.) Menu Level Hierarchy

Hierar
chy
Numb
er

Enterprise Management Console (EMC)
Configuration

Description

2 Transaction Menu and Sub Level Defaults The Default Main Level and the Default
Sub Level (configured in the RVC
Parameters module) become the default for
the revenue center as a whole. If this
setting is used, whenever a workstation
operator signs in to the revenue center,
these two menu levels will be active until
they are changed manually.
See Activate Default Menu and Sub Levels for
a Revenue Center for more information.

3
Defaul
t if no
levels
are
config
ured
for
use

Main 1 and sub 1 are always defaults If none of the other menu levels are
configured, the workstation defaults to
main level 1 and sub level 1 as the active
levels for the transaction. This is configured
in the Menu Level Sets module.
See Activate Main and Sub Level Defaults for
more information.

Activate Auto Menu Levels
Auto Menu Levels are sets of configuration that change the main and/or sub menu levels at
specific times of day. Each location can have 8 levels.

Each Start time must match the End time of the previous row, without gaps. The times must
cover a total 24-hour period. You must configure the times using a 24-hour clock.

1. Select the Enterprise, property, or revenue center, click Configuration, and then click
Auto Menu Levels.

2. In the Start column, enter the time at which the menu level becomes active.

For example, if Eggs become active at 6:00 a.m., enter 06:00.

3. In the End column, enter the time at which the menu level becomes inactive.

For example, if Eggs become inactive at 11:00 a.m., enter 11:00.

4. Select the Main Level, and then select the Sub Level.

5. Click the ellipsis point (...) button from the Options column.

6. Select 1 - This Entry is Active, select one or more of the following options that
correspond with the days that the menu level becomes active, and then click OK.

• 2 - Active On Sunday

• 3 - Active On Monday

• 4 - Active On Tuesday

• 5 - Active On Wednesday

• 6 - Active On Thursday
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• 7 - Active On Friday

• 8 - Active On Saturday

Each menu level time range must be marked active on the specific days it will need to
work. The Entry Active option is a quick way to turn off a specific menu level.

7. Repeat steps 2 through 6 for the remaining 7 levels.

8. Click Save.

Activate Main and Sub Level Defaults
The Menu Level Sets module contains the lowest menu level hierarchy. In Simphony
Essentials, there are two default Menu Level Sets already set up at the Enterprise level called
‘Main’ and ‘Sub’ with menu level entries of the same name. You can change these names and
add other records. They will appear in the workstation TSR and Bar workflows as shown
below:

Figure 13-2    Example of Menu Level Sets Names

1. Select the Enterprise, click Configuration, and then click Menu Level Sets.

The Type column specifies whether the Menu Level Set refers to the Main Levels, the Sub
Levels, or to the levels defined within the record. You can create an entry for the entire
Main Level Set and Sub Level Set in this module; this allows you to configure the Options
for Main and Sub levels.

2. Double-click the row for the level you are setting:

Two Menu Level Sets come with the application: Main and Sub.

a. To define main menu levels, highlight the Main row in the left pane.

b. To define sub menu levels, highlight the Sub row in the left pane.

c. To define menu levels for a custom level set, insert a new record, enter a custom level
set name, click OK, and then highlight the new custom level in the left pane.
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3. In the Menu Level Entries section, define the menu levels by entering the numbered level
field values.

You can use menu levels to specify menu item sizes, such as Small, Medium, and Large;
and serving periods, such as Breakfast, Lunch, Dinner, and Happy Hour.

a. Enter text into the Name field for reference purposes, regardless of whether it is being
used to identify specific uses like sizing or serving periods.

b. (Optional) Enter the Prefix or Suffix for each menu level. This information appears on
the check detail area and prints on guest checks and customer receipts.

a. To define a menu level as the default level for the menu level set, in the Options
column, click the ellipsis point (...) button adjacent to the default menu level, select 1 -
Default, and then click OK.

b. To define a menu level as an anonymous level for the menu level set, in the Options
column, click the ellipsis point (...) button adjacent to the anonymous menu level,
select 2 - Anonymous, and then click OK.

The default and anonymous menu levels are generic, and are typically used with $0.00
priced menu item definitions that have names such as [SIZE] Hot Drink or [TEMP]
Drink.

4. Click Save.

Activate Default Menu and Sub Levels for a Revenue Center
1. Select the revenue center, click Setup, and then click RVC Parameters.

2. On the General tab, select the Default Main Level, and the Default Sub Level.

3. Click the Options tab, and then set the main and sub menu levels as follows:

• To set the workstation to remain at the current main menu level after completing a
transaction, select 23 - Retain Current Main Level after a Transaction.

• To set the workstation to remain at the current sub menu level after completing a
transaction, select 24 - Retain Current Sub Level after a Transaction.

4. Click Save.

Configure Active Menu Levels for Menu Item Definitions and Prices
In order for a menu item definition to use sub level pricing (for example, Happy Hour), its menu
item class must have the Active On Level enabled.

1. Select the Enterprise, property, or revenue center, click Configuration, and then click
Menu Item Maintenance.

2. Search for and then double-click a menu item master record.

See Searching and Filtering Menu Items for more information.

3. If the menu item has multiple definitions, select a definition, and then click the General tab.

4. In the Menu Level Availability section, select the active main and sub levels for the item.

5. To set the menu item definition as active on all menu levels, click All.

6. To set the menu item definition as active on a custom menu level:

a. Click Menu Levels Tab, select a Menu Level Set, and then select the menu levels.

b. To set the definition as active on all custom levels, select Active on All Levels.
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7. If the menu item has multiple price records click Prices, and then select the Active Menu
Level for each price definition.

When menu items are assigned to a class which uses sub level pricing (Menu Item Class
option 10 - ON = Use Sub Level Pricing; OFF = Use Main Level Pricing is set), the
application lists sub levels.

8. Click Save.

Introduction to Menu Item Definitions
Menu item definitions are a required part of a menu item. Without them, the menu item does
not appear on workstation screens. Definitions are the behavioral hub of a menu item.

Definitions use menu level links to determine when a menu item is accessible to workstation
operators. By activating specific menu levels, the menu item is available to workstation
operators when the level is active.

Menu item definitions also tie price records and menu item classes to the menu item.

The following table shows an example of three different iterations of mac and cheese, all
behaving differently, all costing different prices, but all are reporting as mac and cheese. This is
possible because each menu item master record can have up to 64 individual menu item
definitions. These definitions are all available and configured in the Menu Item Maintenance
module, on the Definition tab.

Table 13-7    Defining Definitions

Definition and Availability
(Using Menu Levels)

Menu Item Class Price

Mac and Cheese – Lunch R – M&C Topping $8.00

Mac and Cheese – Dinner R – M&C Topping $10.99

Basic Mac and Cheese – Lunch
and Dinner Side

R – No Prep $3.99

If a menu item definition is not enabled on both the main or the sub level when those levels are
active, the item does not appear on the workstation screens. As each menu item can have up
to 64 definitions, making sure the correct levels are enabled in each definition is critical.

There are multiple ways to configure menu items, depending on how the enterprise needs the
menu item to behave and to report:

• Single menu item master with multiple definitions

• Multiple menu item masters, each with their own definition

• Single menu item master with definitions only available on sizing levels

An example of each method is described in the following paragraphs.

Single menu item master with multiple definitions

The menu item definition name appears on the workstation screen, not its master record. For
example, a restaurant serves the menu item Tomato Soup. When a guest orders soup, they
choose either a cup or a bowl size. Both the menu item definitions Tomato Soup-Cup and
Tomato Soup-Bowl appear on the workstation screen as two separate items, each with a
different price record. The menu item Tomato Soup appears on reports as the master record
name.
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Multiple menu item masters, each with their own definition

If the restaurant wants the cup and bowl to report separately, they may configure a separate
menu item master record for each—Tomato Soup-Cup and Tomato Soup-Bowl—with a single
definition and price for each master record.

Single menu item master with definitions only available on sizing levels

A single master record can also have multiple definitions. For example, a restaurant uses
menu levels for sizing. Instead of Breakfast, Lunch, and Dinner menu levels, they have menu
levels for Small, Medium, and Large. One definition is only available on the Small level,
another is only available on Medium, and so on.

The menu item class specifies whether the item is a regular menu item (such as a burger or
salad), or a condiment item (such as meat temperature or ketchup). This is how you can get a
master record, like bowl of soup, to behave both as an entrée on its own and as a side dish.
Each has its own menu item class associated with its own definition.

As for price records, each item definition can have up to eight price records, each controlled by
either the main or sub menu level. For example, a beer bottle can have two prices: one regular
price and one happy hour price. When the menu level changes from regular to happy hour, the
price record that is active on that level also changes.

However, a location may not want two definitions (regular and happy hour), but instead may
create a single definition with two prices. A price record is either active on the main or sub
level, but not on both levels. By default, price records operate on the main level. If needed, you
can open the Menu Item Classes module, click the Options tab, and change the price record to
operate on the sub level for the item’s definition by selecting 10 - ON = Use Sub Level
Pricing; OFF = Use Main Level Pricing.

Configure a Menu Item From Scratch
You can create a menu item from scratch for an item that is unique. If you have a new location
and there are no template records to use, at first you can add only a menu item master record,
and then add menu item definition and price records later.

Adding items from scratch is not the most efficient method to create new menu items. The
easiest and fastest way is to find a similar item and use it as a template for the new menu item.
The new item inherits the characteristics of the template. See Configure a Menu Item Using a
Template for more information about this method.

1. Select the Enterprise level, click Configuration, and then click Menu Item Maintenance.

2. Click the Search button in the lower left area.

3. If there is a list of existing menu items, click the record row where you want to add the
menu item.

Determine the organization method used in your system when configuring menu items as it
is helpful to try to use the same method. It is best to add the menu item in an area with
other similar items. For example, you can list all Specials together, all Sandwiches
together, and all Salads together.

4. Click the Insert icon ( ) on the toolbar.

5. Complete the following fields for the menu item master record in the Add Menu Items
dialog:

a. In the Select a task to perform drop-down list, select Add Master Records without a
Template.
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The application defaults to inserting the new menu item record into the next available
slot after the currently selected record. Verify the record number you are adding.

• To insert the menu item in the next available position, select Next Available
Position.

• To define the record number or range for the new menu item record or records,
select Record Number Or Range, and then enter the record numbers or ranges.

• To insert the menu item at the next available record number after the currently
selected record, select After currently selected record. For example, if you have
record #50 selected and records 51 through 53 also exist, the new men item is
created in record #54.

b. Enter the Name of the new menu item.

c. Verify the Major Group, Family Group, and Report Group (number between 1 and
99) for the menu item. Change these fields if needed.

Menu Item Reports sort and list subtotals by Report Group. When the Report Group
number is 0 (zero), the menu item does not show on Menu Item Reports.

d. Click OK. The new menu item master record appears in the list. Continue with the next
steps to configure the definition, class, price, and menu levels.

6. Double-click the new master record row to open it.

7. Click the Insert icon ( ) on the toolbar.

8. Complete the following fields for the menu item definitions and price records in the Add
Menu Items dialog:

a. In the Select a task to perform drop-down list, select Add Definition Records to this
Master.

The Master field shows the menu item master record to receive the new definition
records.

b. In the Definitions to Add list, select the definitions to create for the master.

Each master record is allowed up to 64 definitions, each with its own menu item class,
menu level, and up to eight price records. Each definition in the list needs to be
assigned to a menu item class and a price record (optional).

c. (Optional) To add up to eight price records when creating a definition, select Insert
Price Records.

d. If you are not using a definition template, select the Number of Price Records to
create for the definition, and then enter the default Price for the new price records.

If the Price field is empty, the application assigns a default price of $0.00, which you
can change later.

If using a definition template, the application copies the price records from the template
record.

e. Click OK, and then click Yes to confirm. The definition appears on the Definition List
subtab.

9. Click the General subtab.

10. To switch between multiple definitions without leaving the current view, select the Def
Sequence # from the drop-down list.

11. To change the menu item class, click the Select link adjacent to Menu Item Class, select
the appropriate menu item class, and then click OK.
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12. To change the print class, click the Select link adjacent to Print Class Override, select the
appropriate print class, and then click OK.

Menu items print based on the Print Class. Sometimes a single definition needs to print
somewhere different than all other items in its menu item class. You can create a new
Print Class and attach it directly to the menu item definition here in the Print Class
override.

13. In the Menu Level Availability section, select the Main Level Link and Sub Level Link.
Click the All link to select all menu levels for main or sub.

These menu levels specify when a menu item definition is available on a workstation.
Often restaurants make a definition available at all times, but adjust the price records to
become active based on the current menu level (for example, Happy Hour pricing versus
pricing during Lunch or Dinner).

14. To view the definition and price record, click the Prices subtab.

15. Click Save.

Configure a Menu Item Using a Template
You can configure a menu item using an existing menu item as a template. This is the easiest
and fastest method to create a new menu item. The new item copies the characteristics of the
template.

1. Select the Enterprise level, click Configuration, and then click Menu Item Maintenance.

2. Click the Search button in the lower left area.

3. In the list of existing menu items, find the item most closely related to the item you want to
create.

To locate the right item to use, pay attention to Major Groups, Family Groups, Menu Item
Definitions, Menu Levels, and Menu Item Classes. These characteristics will copy to the
new item. After creating the new item from a template, you can make adjustments.

4. Click the record row where you want to add the menu item.

If you select a record before clicking the Insert icon in the next step, that record appears
by default in the Template Record field. If you do not select a record, you can select the
Template Recordfrom the Add Menu Items dialog later.

5. Click the Insert icon ( ) on the toolbar.

6. Complete the following fields for the menu item master record in the Add Menu Items
dialog:

a. In the Select a task to perform drop-down list, select Add Master Record from
Template.

b. (Optional) To select a different template item, click the Select link adjacent to Master
to Copy.

c. Enter the Name of the new menu item.

d. Verify the Record Number assigned to the new menu item and change it if needed.

By default, the Record Number assumes the next available record after the template
menu item. You can override this number by specifying a different Record Number.

e. Click OK. The new menu item master record appears in the list.

f. To add another record number immediately, click Yes. Otherwise, click No.
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7. On the Master Records tab in the lower area of the screen, verify that the new menu item
record appears with the correct record number.

8. On the Definition Records tab in the lower area of the screen, verify that the new menu
item definition appears. You can scroll to the right to see more parts of the menu item
definition, and change any attribute of the new menu item, Menu Item Class, Major Group,
or Family Group as needed.

9. On the Price Records tab in the lower area of the screen, verify that the new menu item
price record or records appears. If the template item had two price records, the new item
has the same information. You can change the price record as needed.

Add Dietary Labels to Menu Item Masters
You can add special dietary labels (for example, Gluten Free, Vegetarian, Vegan, and Heart
Healthy) to menu items masters.

1. Select the Enterprise level, click Configuration, and then click Roles.

2. Double-click the employee record, and then click the EMC Modules tab.

3. In the bulk operations list, scroll to the Dietary Labels row, and ensure the necessary
operations are selected.

4. Click Save.

5. Select the Enterprise level, click Descriptors, and then click Dietary Labels.

6. Add dietary label records as needed. If you delete a dietary labels record, this will in turn
delete all dietary labels associated with a menu item.

The Use Template function is not supported in the Dietary Labels module.

7. Click Save.

8. Select the Enterprise level, click Configuration, and then click Menu Item Maintenance.

9. Search for and then double-click the menu item master record, and then click the Dietary
Labels tab.

10. In the Dietary Labels section, click Add, and then click ....

11. Select the desired dietary label for the menu item, and then click OK.

12. Repeat Steps 10 and 11 to add more dietary labels.

13. Click Save.

Configure Menu Tag Groups and Tags
A menu is a collection of menu items. Use a menu tag to associate a Simphony Essentials
menu item with an online ordering menu. Each online ordering provider must have a unique
menu tag in Simphony Essentials. Only the menu items with these tags are visible in the online
ordering application.

Simphony retains all tag activity (including add, edit, and delete) for use in auditing.

1. To add a tag group:

a. Select the Enterprise level, click Descriptors, and then click Tag Groups.

b. Click the Insert icon ( ) on the toolbar.

c. Add a new tag group record with the appropriate name, and then click OK.
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d. Click Save.

2. To add a tag:

a. Select the Enterprise level, click Descriptors, and then click Tags.

b. Click the Insert icon ( ) on the toolbar.

c. Add a new tag record with the appropriate name (for example, Online Only), and then
click OK.

You cannot duplicate tag names.

d. Select the Tag Group.

e. Click Save.

3. To edit a tag:

a. Select the Enterprise level, click Descriptors, and then click Tags.

b. Change the tag name in the Name column.

c. Click Save.

4. To delete a tag:

If you delete a tag that is associated with a menu item definition, the association is also
deleted.

a. Select the Enterprise level, click Descriptors, and then click Tags.

b. Highlight the tag record, click the delete icon
(

) on the toolbar, and then click Yes.

c. Click Save.

5. To associate a tag with a menu item definition, see Associate a Menu Item Definition with a
Tag for detailed instructions.

Associate a Menu Item Definition with a Tag
Menu tags need to be added in the Tags module before associating them with a menu item
definition. Configure Menu Tag Groups and Tags contains more information about adding tags.

You can use tags to filter and group menu item definitions. A menu item definition record can
be associated with more than one tag. The menu item master record must have at least one
menu item definition to enable the Tags tab in the Menu Item Maintenance module.

1. Select the Enterprise level, click Configuration, and then click Menu Item Maintenance.

2. Double-click the menu item master record corresponding to the definition to open it.

3. Click the Tags tab.

4. Click the Add link.

By default, the first tag from the Tags module appears.

5. To change the tag, click the ellipsis (…), select the new tag from the list, and then click OK.

6. To change the tag name, click inside the Tags column and edit the text.

7. If the menu item master record has more than one menu item definition, click the Next Def
Seq link, and then click the Add link again for another tag.
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8. Click Save.

Allergen, Nutrition and Consumer Advisory Information
Administrators can configure allergen, consumer advisory, and nutrition related menu item
content in the EMC. This information can be used in Oracle API interfaces to meet legal
requirements where necessary. The allergen, nutrition, and consumer advisory details are
supported in the Simphony Essentials Transaction Services (STS) Gen 2 configuration service
responses, such as self-service kiosks or Enterprise online ordering.

The allergen, nutrition, and consumer advisory content is configured for individual menu item
definitions. Each menu item definition can have multiple allergens and multiple nutrition entries
configured. One consumer advisory description is allowed per menu item definition.

The allergen, nutrition, and consumer advisory content is translatable. You can also change the
nutritional content unit of measure for each language translation.

Simphony Essentials does not support the % of Daily Value or Serving Size.

Allergen

Simphony Essentials contains a fixed list of allergens (for example, eggs, fish, peanuts, and
milk) in the Allergens module at the Enterprise level. Administrators can create an allergen
class using the Allergen Classes module, and then associate allergens to an allergen class.
Then the allergen class can link to a menu item class. You can override the allergen class at
the menu item definition level.

Nutrition

Administrators can configure nutritional values (for example, calories, total fat, saturated fat,
and sodium) for each menu item definition. The nutrition information is typically found on a
packaged goods label.

The Nutrition Names module provides a pre-defined list of nutrients available at the Enterprise
level. This is a reference list used for entering nutritional details and cannot be modified.

You can use the Nutrient Sets module, available at the Enterprise level, to create a set of
nutritional details that can be associated with a menu item definition. For example, you can add
nutritional content for a Chicken entrée to a Chicken nutrient set, with details of calories,
dietary fiber, carbohydrates, total fat and protein, and link this nutrient set to the menu item
definition for the Chicken entrée.

The Menu Item Definition module has a Nutrition tab that is used to add nutritional details
based on the defined nutrient sets. You can use the Nutrition tab to link Nutrient Sets to the
menu item definition.

Consumer Advisory

Typically, the consumer advisory description contains food safety warnings specific to
allergens. An example of a consumer advisory description is: Consuming raw or under-cooked
meats, poultry, seafood, shellfish, or eggs may increase your risk of foodborne illness. The
Consumer Advisory Description field is available in the Menu Item Definition module.

Configure Allergens
You can add an allergen (for example, Shrimp), and associate it with an allergen class (for
example, Seafood).

1. To add an allergen:
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a. Select the Enterprise level, click Descriptors, and then click Allergen Names.

The Allgergen Names module has several preset allergen names and codes. The
existing allergen names and codes cannot be edited or deleted; however, the text can
be translated.

b. Click the Insert icon ( ) on the toolbar.

c. Enter the allergen in the Record Name(s) field, and then click OK.

The system does not allow duplicate allergen names.

d. Click Save.

2. To add an allergen class:

a. Select the Enterprise level, click Configuration, and then click Allergen Classes.

b. Enter the allergen class in the Record Name(s) field, and then click OK.

You can configure the Allergen Classes module from either table or form view. In table
view, if more than one allergen is selected, allergens are listed and comma separated.

c. Based on the allergen class’ name, select the allergen you want to include in the class.

You can select more than one allergen. Switch to form view by using the toggle icon on
the toolbar

, or double-click the record.

d. Repeat steps 2a through 2c to add more allergen classes if needed.

e. Click Save.

3. To link the allergen class to a menu item class:

a. Select the Enterprise level, click Configuration, and then click Menu Item Classes.

b. On the General tab, select the allergen class in the Allergen Class field.

c. Click Save.

4. To override the allergen class at the menu item definition level:

a. Select the Enterprise level, click Configuration, and then click Menu Item
Maintenance.

b. Search Menu Item Definition records for items you wish to assign an allergen class.

Search and Filter Menu Items contains more information about searching.

c. On the record’s General tab, select the allergen class from the drop-down list that you
want to assign to the menu item class from the Allergen Class Override field, and
then click OK.

d. Click Save.

Configure Nutrition and Consumer Advisory Information
1. To translate nutrition names for menu items:

• Select the Enterprise level, click Descriptors, and then click Nutrition Names.

The EMC shows preset nutrient records. You cannot add nutrient records. The existing
nutrient names cannot be edited or deleted, but you can translate the nutrient names
in the Text column.
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2. To add nutrient sets:

a. Select the Enterprise level, click Configuration, and then click Nutrient Sets.

b. Click the Insert icon ( ) on the toolbar.

c. Enter the nutrient set name in the Name field.

d. Switch to form view by clicking the toggle icon on the toolbar

, or double-click the record. In the Nutrients section, click Add to insert and configure
nutritional information.

e. In the Nutrient column, click the ellipsis (…), select the nutrient type from the drop-
down list, and then click OK. Repeat this step for each nutrient you add to the record.

f. In the Unit of Measure column, select the appropriate measurable for each nutrient.
The available units are:

• Calories

• Kilojoules

• Grams

• Milligrams

g. In the Quantity column, enter the numerical value associated with each unit of
measure type.

h. Click Save.

3. To link the nutrient set to the menu item definition and add consumer advisory text:

a. Select the Enterprise level, click Configuration, and then click Menu Item
Maintenance.

b. Search Menu Item Definition records for items you wish to assign nutrition sets.

Search and Filter Menu Items contains more information about searching.

c. (Optional) Open a menu item definition record and enter text in the Consumer
Advisory Description text box (for example, May contain nuts).

d. Open a menu item definition record, and then click the Nutrition tab.

e. In the Nutrients section, click the Add link.

f. In the Nutrient Set column, click the ellipsis (…), select the nutrient set from the drop-
down list, and then click OK.

You can add more than one nutrient set to a menu item definition record.

g. Repeat steps 3a through 3f for each menu item definition record for which you want to
add nutrient sets.

Adding nutrient set to menu item definition records cannot be performed from table
view. You need to manually add each nutrient set to each individual menu item
definition record.

h. Click Save.
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Search and Filter Menu Items
The Menu Item Maintenance module allows you to search for menu items. Typically several
hundred menu item records are likely to exist. Searching and filtering allows you to work with
only the desired menu item records. By default, no items appear in table view.

1. Select the Enterprise level, click Configuration, and then click Menu Item Maintenance.

2. To view all records, click Search without entering search criteria.

Depending on the number of menu items, this step may take several minutes.

3. To view specific menu item records, enter information in the relevant search fields, and
then click Search:

• Record Type: Select the type of record to find (Menu Item Master, Menu Item
Definition, or Menu Item Price). When both a Menu Item Master and a revenue
center are selected, the application returns only master records with definitions in the
selected revenue center.

• Name Search: Enter the menu item name (partial or full) to search. Only records
containing the text in the name field for the specified language are returned. Menu
Item Definition and Price searches look for the text in either the Name 1 or Name 2
fields. Entering Shrimp Cocktail returns the specific record; a family group search on
Appetizers returns results more quickly.

• Major Group: Enter a major group number or a range of major group numbers to
include in the search.

• Family Group: Enter a family group number or a range of family group numbers to
include in the search.

• Object Number or Range: Enter an object number or range of object numbers to
include in the search.

• Show Master w/Defs Only: Select to show only menu item master records that
contain one or more definitions for this property. Deselect to show all menu item
master records for this level or higher.

• Map Menu Item Overrides: Select to show the Menu Item Override indicator, which
allows you to see other locations in the Enterprise where the item is configured.
Deselect to exclude the Menu Item Override indicator. As the system needs to check
the entire enterprise for the menu item, the search results will take longer to generate.
Therefore, set this option only when there is a specific need to see this information.

• Class: Enter a menu item class or range of menu item classes to include in the search
when querying menu item definitions or menu item prices.

• Sales Itemizer: Enter a sales itemizer or range of sales itemizers to include in the
search when querying menu item definitions or menu item prices.
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14
Guest Checks

A guest check contains a record of all sales on the check, from the guest’s initial menu item
order to final payment.

Configure Check Name Prompt for Bar Transactions
You can enable workstation operators to enter a check name when selecting the Begin Check
button in the bar workflow. This increases speed of service by allowing busy bartenders using
tabs to name checks more quickly when starting a transaction.

1. Select the Enterprise, property, revenue center, or zone, click Setup, and then click
Control Parameters.

2. Click the Options tab, and then select 72 - Prompt for Check Name in Essentials Bar
Workflow.

When option 72 is enabled, the Begin Check button on the workstation prompts for a
check name if no pre-authorization credit card payment is defined, or if the pre-
authorization did not return a name.

3. Click Save.

Allow Employees to Add or Transfer Checks
Transferring checks is a procedure that changes ownership of a guest check. Simphony
Essentials enables privileged workstation operators to transfer checks from another server to
themselves by employee number or by employee ID number. The Transfer Checks function
only transfers the ownership of the guest check; it does not transfer the check’s sales totals for
reporting purposes

Add Check means to combine two checks together while in a transaction.

1. Select the Enterprise level, click Configuration, and then click Roles.

2. Double-click the role type record (for example, administrator, manager or server).

3. Click the Operations tab, and then click the Guest Checks subtab.

4. Select the appropriate permission options for the user role:

• 45 - Authorize Transfer of Checks in the Same Revenue Center: Select to allow
employees with this role to transfer checks from another operator within the same
revenue center, and to authorize others to do so.

• 47 - Authorize Adding of Checks in the Same Revenue Center: Select to allow
employees with this role to add checks (to be in a check, and add another check to it)
within a revenue center, and to authorize others to do so.

5. Click Save.
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Configure Begin Future Order
You can configure checks to be sent to the kitchen at a specific date and time for Table Service
Restaurant operations. These are called Future Orders (sometimes called Autofire checks).

By default, the future orders feature is not active for Simphony Essentials. When you enable
future orders, the following changes occur in POS Operations:

• The Begin Future Order button appears on the POS Functions page.

• The Pickup Check dialog shows the Future Checks button.

• The Future Open Check Report button appears on the POS Reports page.

To enable Begin Future Order:

1. Select the revenue center, click Setup, and then click RVC Parameters.

2. Click the Autofire tab, and then configure the fields as described in the following table:

Figure 14-1    Autofire Tab

Table 14-1    Automatic Check Firing Fields

Fields and Options Description

(Optional) Autofire Employee To allow a specific employee to become the
owner of all checks, including those placed
using Transaction Services after the orders
fire, select a workstation operator, and then
click OK.
• If you select an Autofire Employee, all

sales totals post to the designated
workstation operator and the checks
appear under the Autofire Employee in
the Open Check Report.

• If you do not select an Autofire
Employee, the check operator remains
the owner of the check after the order
fires.
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Table 14-1    (Cont.) Automatic Check Firing Fields

Fields and Options Description

Autofire Workstation Select the workstation from which the orders
fire and print. The application uses this value
to determine the order output devices and
workstation printers to use when an order
fires.

Default Autofire Tender/Media Select a service total that workstation
operators can use with Future Orders.
This service total must be the same as the
Default Service Total Tender/Media set in
the Tender Parameters module, Simphony
Essentials tab. Create Payment Buttons
contains more information.

Backup Autofire Delay (Mins) Enter the amount of time (in minutes) that
the Future Orders workstation must try to
fire the orders.
After the Backup Autofire Delay time elapses,
if the Future Orders workstation is
unsuccessful at firing the order, the
workstation at which the check was
originally created tries to fire the order. If
both workstations fail, a memo chit prints
and a workstation operator must manually
fire the order.

(Optional) Maximum Days Enter the maximum number of days for
which workstation operators can schedule
orders to fire automatically.

(Optional) 2 - Print Guest Check at Time of
Autofire

Select this option if you want a guest check to
print when an order automatically fires to
order devices.
If you select this option, guest checks print at
the guest check printer assigned to the
autofire workstation.

3 - Enable Autofire in this Revenue Center Select this option to allow the revenue center
to create orders that fire automatically.

3. Click Save.

4. Select the Enterprise level, click Configuration, and then click Roles.

5. Double-click the role type for the employee who needs privileges to assign future checks.

6. Click the Operations tab, and then select the appropriate options.

7. Click the Guest Checks subtab, and then select the following privileges. The following
table describes the privileges corresponding to automatic check firing.

Table 14-2    Employee Guest Check Privileges for Automatic Check Firing

Privilege Description

183 - Begin Autofire Check using [Begin
Autofire Check] Key

Select this option to allow employees in this
role to create checks with orders that
automatically fire at a preset time using the
Begin Autofire Check function key.
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Table 14-2    (Cont.) Employee Guest Check Privileges for Automatic Check Firing

Privilege Description

184 - Authorize/Perform Pickup of Autofire
Check Belonging to Another Operator

Select this option to allow employees in this
role to pick up and edit checks with orders
that fire at a preset time from other
employees.

185 - Authorize/Perform Edit of Autofire Date/
Time

Select this option to allow employees in this
role to modify the date and time that orders
are set to automatically fire.

8. To allow employees in this role to generate the Autofire Open Check Report from the
workstation, click the Ad Hoc Reports subtab, and then select 31030 - Run Autofire
Open Check Report.

9. Click Save.

10. Select the Enterprise, property, or revenue center, click Descriptors, and then click
Autofire Check Offline Header.

11. From the Text column, enter the header lines to print on memo chits when future orders
fail to fire automatically.

12. To add a logo to the header, select Use Logo, click the ellipsis point (...) button from the
Logo column, select the logo from the list, and then click OK.

13. Click Save.

Introduction to Logo Printing
You can print the logo of your Enterprise, property, or revenue center on guest checks,
customer receipts, and credit card vouchers. Simphony Essentials only supports monochrome
bitmap image files. Use Microsoft Paint to convert an image to a monochrome bitmap. Adhere
to the following rules governing the size of your logo:

• The image area must not exceed 98,304 pixels. (Keep in mind that a logo that is 512 x 384
pixels exceeds 98,304 pixels.)

• The image width must not exceed 512 pixels.

• The image height must not exceed 384 pixels.

• The bitmap file must not exceed 8 kilobytes in size.

Simphony Essentials does not support logo printing on printers with multi-language cards.

Complete the following tasks to set up logo printing:

• Upload a logo to Simphony Essentials.

• Assign a logo to guest checks, customer receipts, and credit card vouchers.

• Set the printer to print the logo.

Configure Logo Printing
You need to upload the logo to Simphony Essentials, and then you can assign the logo to
guest checks and receipts.

1. Select the Enterprise level, click Configuration, and then click Print Logos.

2. Insert a new record, and then double-click it to open.
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3. Click Load Image.

4. Select the image, and then click Open to upload it. After the logo uploads, an image
preview appears.

5. Alternately, you can copy the image to your clipboard, and then click Paste Image to
upload it.

6. Click Save.

7. To print the logo on guest check headers, trailers, or customer receipts, see Configure
Guest Check Headers and Trailers, and Customer Receipt Headers for information.

Configure Guest Check Headers and Trailers, and Customer
Receipt Headers

Guest check headers and trailers are leading and trailing lines that print on guest checks.
Typically, the header lines include the name of the property or revenue center and address.
The trailer lines generally show gratitude or promotional information about upcoming events. At
hotels, guest check trailers are often configured to show room charge information for the
customer to complete. You can also set a header or trailer line to print logos rather than text.

Headers print automatically on guest checks. You must set trailers to print per tender/media
record.

This is a separate configuration from Configure Headers and Trailers for Printed POS Reports

1. Select the Enterprise, property, or revenue center, click Descriptors, and then click either
Guest Check Headers or Guest Check Trailers.

2. For each row, enter information in the following fields:

• Text: Enter the text to appear on the header or trailer.

• (Optional) Use Logo: Select this option to print a logo rather than text on the guest
check header or trailer. If you select Use Logo for an existing check header record
that has content in the Text column, that text no longer appears on printed guest
checks and customer receipts.

• (Optional) Logo: If you selected Use Logo, click the ellipsis point (...) button in the
Logo column, select the image you uploaded, and then click OK.

3. Click Save.

4. To assign text or a logo to customer receipts and guest check trailers, repeat these steps,
selecting the Guest Check Trailers and Customer Receipt Headers modules in Step 1.

You must also select 28 - Print Guest Check Trailer on Fast Transaction Customer
Receipt for tender records from the Tender/Media Printing options. If you do not set this
option, trailers do not print on customer receipts when the tender is used to close a fast
transaction.

5. To configure trailers to print for each tender media record, select the Enterprise or property,
click Configuration, and then click Tender/Media.

6. Double-click the tender record.

7. Click the Options tab, and then click the Printing Options subtab.

8. Set the appropriate options as described in the following table:
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Table 14-3    Trailer Printing Options for a Tender Record

Option Description

20 - Print Sales Itemizers Select this option to print the sales itemizer
lines on guest checks, customer receipts, and
memo checks when workstation operators
use the tender record. Deselect this option to
suppress printing of the sales itemizers.

21 - Print Summary Totals Select this option to print the summary totals
(subtotal, tax, amount due, and change due)
on guest checks, customer receipts, and
memo checks when workstation operators
press the key. Deselect this option to suppress
printing of the summary totals.

22 - Print Check Trailer Select this option to print the guest check
trailer lines at the end of the guest check.

28 - Print Guest Check Trailer on Fast
Transaction Customer Receipt

Select this option to print the guest check
trailer on the customer receipt when
workstation operators use the tender to close
a fast transaction. Deselect this option to
prevent the trailer from printing on customer
receipts.

9. Click Save.

Configure Headers and Trailers for Printed POS Reports
You can configure the printing of report headers and trailers for POS reports containing site
specific information. Audit procedures in certain countries require them to generate POS
reports containing such information. Printing information—such as the site’s business address
or logo—on report headers (or trailers) helps to identify the source (or location name) of the
data to which the report pertains.

This is a separate configuration from Configure Guest Check Headers and Trailers, and
Customer Receipt Headers.

1. Select the Enterprise, property, or revenue center, click Descriptors, and then click either
Report Headers or Report Trailers.

Note:

You can configure different report headers and trailers based on the scope your
reports are generated from, such as the Enterprise, property, or revenue center
level. For example, a property level report might contain different report headers/
trailers than a revenue center level report. If desired, configure the report
headers/trailers for each level.

2. From top to bottom, in ascending order, enter the information in the Text column as you
want the header to print on the report.

The Report Headers and Report Trailers modules each contain 12 lines which can be
configured. You cannot insert new lines.

3. To print your company’s logo, select the Use Logo check box on any line.

4. From the Logo column, click the ellipsis button (...), and then select the logo.
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This configuration supports logo printing using the same image rules as existing header
and trailer lines. See Introduction to Logo Printing for more information.

5. To create a blank space or a blank line between other header/trailer lines, define such lines
on a lower line number. These blank spaces and lines print only when the populated lines
are defined on a higher line number.

You can only print a blank line between two other lines, not at the end. For example, if you
define text on lines 1, 2, 3, and 5, there will be a blank line between 3 and 5. If you define
text on lines 1, 2, 3, 4, and leave line 5 blank, then line 5 will not count as a blank line on
the report.

6. Repeat Steps 1 through 5 to configure the Report Trailers module. The report trailer
appears near the end of the printed report.

7. Click Save.
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15
Gift Cards

Simphony Essentials release 19.5 added support for Oracle MICROS Gift and Loyalty’s gift
card functionality.

When the functionality is enabled, the POS client displays buttons for the following gift card
operations:

• Balance Inquiry

• Balance Transfer

• Cash Out

• Issue

• Redeem

• Reload

• Activate

There are two paths available for configuring Oracle MICROS gift cards on the POS. To
determine which path to follow, before setting up data, sign in to the EMC. Select the
Enterprise level, click Setup, and then click Stored Value Module.

• If there is a Stored Value record called iCare SVC, select this link: Gift Card Setup for New
Organizations.

• If there are no records or you are not sure which path to follow, select this link: Gift Card
Setup for Organizations Pre 19.5 Release.

After configuring the POS clients, follow this process to configure your gift card program: 
Configure Gift Card Program.

Gift Card Setup for New Organizations
Complete the following to configure Oracle MICROS gift cards for your Simphony Essentials
system.

Configure Gift Card Privileges
Privileges must be configured by role to enable users to access gift card functions.

1. Select the Enterprise, click Configuration, and then click Roles.

2. To enable users with this role to access gift card functions on the POS, click the
Operations tab, and then click the Stored Value Cards subtab.

3. Select the appropriate options. The following table summarizes the privileges associated
with gift card functionality.
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Table 15-1    Gift Card Privileges

Section Option Number Privilege Name Select This Option to
Allow Employees to...

Issue Functions 104 Authorize/Perform Issue
Stored Value Function

Issue a gift card

Issue Functions 105 Authorize/Perform Void
Issue Stored Value Entry

Void an issued gift card

Issue Functions 106 Authorize/Perform Issue
Stored Value Batch
Function

Issue a batch of gift cards

Issue Functions 107 Authorize/Perform Void
Issue Stored Value Batch
Entry

Void a batch of gift cards

Issue Functions 108 Authorize/Perform
Activate Stored Value
Function

Activate a gift card

Issue Functions 109 Authorize/Perform Void
Activate Stored Value
Entry

Void the activation of a
gift card

Issue Functions 110 Authorize/Perform
Activate Stored Value
Batch Function

Activate a batch of gift
cards

Issue Functions 111 Authorize/Perform Void
Activate Stored Value
Batch Entry

Void the activation of a
batch of gift cards

Reload and
Redeem Functions

112 Authorize/Perform
Reload Stored Value
Function

Reload (add credit) a
dollar amount to an
existing gift card

Reload and
Redeem Functions

113 Authorize/Perform Void
Reload Stored Value
Entry

Void a reload transaction

Reload and
Redeem Functions

114 Authorize/Perform
Redeem Authorization
Stored Value Function

Perform a redemption
authorization

Reload and
Redeem Functions

115 Authorize/Perform Void
Redeem Authorization
Stored Value Entry

Void a redemption
authorization

Reload and
Redeem Functions

116 Authorize/Perform
Redeem Stored Value
Function

Perform a redemption
transaction (use gift card
to pay some or all of a
check)

Reload and
Redeem Functions

117 Authorize/Perform Void
Redeem Stored Value
Entry

Void a redemption
transaction

Reload and
Redeem Functions

118 Authorize/Perform
Manual Redemption
Stored Value Function

Perform a manual
redemption

Reload and
Redeem Functions

119 Authorize/Perform Void
Manual Redemption
Stored Value Entry

Void a manual
redemption transaction

Chapter 15
Gift Card Setup for New Organizations

15-2



Table 15-1    (Cont.) Gift Card Privileges

Section Option Number Privilege Name Select This Option to
Allow Employees to...

Other Stored Value
Card Options

103 Authorize/Perform
Manual Entry of Stored
Value Card Number

Manually enter the gift
card account number

Other Stored Value
Card Options

124 Authorize/Perform
Stored Value Cash Out
Function

Debit some or all of the
remaining balance on a
gift card

Other Stored Value
Card Options

179 Authorize/Perform Void
Stored Value Cash Out
Function

Void a cash out
transaction

Other Stored Value
Card Options

125 Authorize/Perform
Stored Value Balance
Inquiry Function

Check a gift card balance

Other Stored Value
Card Options

126 Authorize/Perform
Stored Value Balance
Transfer Function

Transfer the balance
from one gift card to
another

4. Click Save.

Configure Stored Value Driver
1. Select the Enterprise, click Setup, and then click Stored Value Driver.

2. Double-click the iCare SVC record to open it.

3. Click the Configuration tab.

4. Scroll to the end of the page, and enter the path to Gift and Loyalty in the Web Address
field (including location, port number and service path).

Use the following format: https://[GiftLoyaltyLocation]:
[GiftLoyaltyPortNumber]/ws/services/StoredValueService. This web address is case-
sensitive and cannot contain spaces.

5. Click Save and close the Stored Value Driver module.

6. Select the property, click Setup, and then click Stored Value Driver.

7. Right-click to the left of the object number of the iCare SVC record, select Override
Record and then select Use Existing Record.

8. Select iCare SVC, and then click Yes.

9. Double-click the record to open it.

10. Click the Configuration tab.

11. Scroll to the end of the page, and then enter the Login and Password.

These fields are specific to the property, not the Enterprise.

12. Click Save and close the Stored Value Driver module.

Configure Stored Value Module
1. Select the Enterprise, click Setup, and then click Stored Value Module.

2. Double-click the iCare SVC record to open it.
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3. Click the Configuration tab.

4. Enter the Currency ISO Code (three alpha characters) that represents the currency being
used (for example, USD). See www.currency-iso.org/en/home/tables/table-a1.html for a list
of Currency ISO 4217 codes.

5. Enter the Language ISO Code (two alpha characters) that represents the language being
used (for example, EN). See www.loc.gov/standards/iso639-2/php/code_list.php for a list of
Language ISO 639–1 codes.

6. Click Save.

Enable the Gift Card Interface
1. Select the Enterprise, click Setup, and then click Interfaces

2. Insert a record for Stored Value as the System Name.

3. Double-click the new interface record to open it.

4. On the General tab, select 5 - Stored Value in the Interface Type drop-down list.

5. Click the Options tab, and then select 12 - Gift and Loyalty SVC Interface.

6. Click the Properties tab, and then select the gift card locations.

7. Click Save.

Gift Card Setup for Organizations Pre 19.5 Release
Complete the following to configure Oracle MICROS gift cards for your Simphony Essentials
system. If information in a step is already set up, continue to the next step.

Configure Gift Card Privileges
Privileges must be configured by role to enable users to access gift card functions.

1. Select the Enterprise, click Configuration, and then click Roles.

2. To enable users with this role to access gift card functions on the POS, click the
Operations tab, and then click the Stored Value Cards subtab.

3. Select the appropriate options. The following table summarizes the privileges associated
with gift card functionality.

Table 15-2    Gift Card Privileges

Section Option Number Privilege Name Select This Option to
Allow Employees to...

Issue Functions 104 Authorize/Perform Issue
Stored Value Function

Issue a gift card

Issue Functions 105 Authorize/Perform Void
Issue Stored Value Entry

Void an issued gift card

Issue Functions 106 Authorize/Perform Issue
Stored Value Batch
Function

Issue a batch of gift cards

Issue Functions 107 Authorize/Perform Void
Issue Stored Value Batch
Entry

Void a batch of gift cards
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Table 15-2    (Cont.) Gift Card Privileges

Section Option Number Privilege Name Select This Option to
Allow Employees to...

Issue Functions 108 Authorize/Perform
Activate Stored Value
Function

Activate a gift card

Issue Functions 109 Authorize/Perform Void
Activate Stored Value
Entry

Void the activation of a
gift card

Issue Functions 110 Authorize/Perform
Activate Stored Value
Batch Function

Activate a batch of gift
cards

Issue Functions 111 Authorize/Perform Void
Activate Stored Value
Batch Entry

Void the activation of a
batch of gift cards

Reload and
Redeem Functions

112 Authorize/Perform
Reload Stored Value
Function

Reload (add credit) a
dollar amount to an
existing gift card

Reload and
Redeem Functions

113 Authorize/Perform Void
Reload Stored Value
Entry

Void a reload transaction

Reload and
Redeem Functions

114 Authorize/Perform
Redeem Authorization
Stored Value Function

Perform a redemption
authorization

Reload and
Redeem Functions

115 Authorize/Perform Void
Redeem Authorization
Stored Value Entry

Void a redemption
authorization

Reload and
Redeem Functions

116 Authorize/Perform
Redeem Stored Value
Function

Perform a redemption
transaction (use gift card
to pay some or all of a
check)

Reload and
Redeem Functions

117 Authorize/Perform Void
Redeem Stored Value
Entry

Void a redemption
transaction

Reload and
Redeem Functions

118 Authorize/Perform
Manual Redemption
Stored Value Function

Perform a manual
redemption

Reload and
Redeem Functions

119 Authorize/Perform Void
Manual Redemption
Stored Value Entry

Void a manual
redemption transaction

Other Stored Value
Card Options

103 Authorize/Perform
Manual Entry of Stored
Value Card Number

Manually enter the gift
card account number

Other Stored Value
Card Options

124 Authorize/Perform
Stored Value Cash Out
Function

Debit some or all of the
remaining balance on a
gift card

Other Stored Value
Card Options

179 Authorize/Perform Void
Stored Value Cash Out
Function

Void a cash out
transaction

Other Stored Value
Card Options

125 Authorize/Perform
Stored Value Balance
Inquiry Function

Check a gift card balance
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Table 15-2    (Cont.) Gift Card Privileges

Section Option Number Privilege Name Select This Option to
Allow Employees to...

Other Stored Value
Card Options

126 Authorize/Perform
Stored Value Balance
Transfer Function

Transfer the balance
from one gift card to
another

4. Click Save.

Set Offline and Printing Options for Gift Cards
1. Select the Enterprise, click Configuration, and then click Stored Value.

2. Insert a record named Stored Value, and then click OK.

3. Double-click the record to open it.

4. Select the following options:

• 1 - Support Offline Transactions

• 2 - Always Print Stored Value Results (print a chit after the operation)

5. Click Save.

Import and Configure Stored Value Driver
1. Select the Enterprise, click Setup, and then click Stored Value Driver.

2. Insert a record named iCare SVC, and then click OK.

3. Double-click the record to open it.

4. On the General tab, click the Import from a file link.

5. Browse to [Drive Letter]:\Program Files\Oracle Hospitality\EMCClient, select
StoredValueCommandModule.dll, and then click Open.

6. Click the Configuration tab.

7. In the Assembly/Class section, enter OHGL in each of the following fields:

• Module ID

• Display Name

• Description

8. In the iCare Driver Properties section, select True in the Ignore Server Certificate field.

9. In the Web Address field, enter the path to Gift and Loyalty, including location, port
number and service path.

Use the following format: https://[GiftLoyaltyLocation]:
[GiftLoyaltyPortNumber]/ws/services/StoredValueService. This web address is case-
sensitive and cannot contain spaces.

10. Click Save and close the Stored Value Driver module.

11. Select the property, click Setup, and then click Stored Value Driver.

12. Right-click to the left of the object number of the iCare SVC record, select Override
Record, and then select Use Existing Record.
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13. Select iCare SVC, and then click Yes.

14. Double-click the record to open it.

15. Click the Configuration tab.

16. Scroll to the end of the page, and then enter the Login and Password.

These fields are specific to the property, not the Enterprise.

17. Click Save and close the Stored Value Driver module.

Import and Configure Stored Value Module
1. Select the Enterprise, click Setup, and then click Stored Value Module.

2. Insert a record, enter iCare SVC as the name, and then click OK.

3. Double-click the iCare SVC record to open it.

4. On the General tab, click the Import from a file link.

5. Browse to [Drive Letter]:\Program Files\Oracle Hospitality\EMCClient, select
StoredValueCommandModule.dll, and then click Open.

6. Click the Configuration tab.

7. In the Assembly/Class section, enter OHGL in each of the following fields:

• Module ID

• Display Name

• Description

8. Enter the Currency ISO Code (three alpha characters) that represents the currency being
used (for example, USD). See www.currency-iso.org/en/home/tables/table-a1.html for a list
of Currency ISO 4217 codes.

9. Enter the Language ISO Code (two alpha characters) that represents the language being
used (for example, EN). See www.loc.gov/standards/iso639-2/php/code_list.php for a list of
Language ISO 639–1 codes.

10. Click Save.

Create Gift Card Service Charges
Create the following three service charge records to be used for gift card transactions:

• Gift Card Issue

• Gift Card Reload

• Gift Card Activate

1. Select the Enterprise, property, or zone, click Configuration, and then click Service
Charges.

2. Insert a service charge record named Gift Card Issue (use number 100 if not already
used), and then double-click it to open.

3. On the General tab, select the following Service Charge options:

• 1 - On = Open; Off = Preset

• 2 - On = Amount; Off = Percentage

• 14 - Service Charge Used For Stored Value Transactions
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• 18 - Gift Certificate Sold

Ensure that all other options are disabled.

4. Click Save.

5. Repeat steps 2 through 4 to create Gift Card Reload (number 200 if not already used)
and Gift Card Activate (number 300 if not already used) service charge records.

6. Write down the record numbers (shown in the # column) for each of the three service
charges. These numbers are used when configuring the gift card program, which occurs in
an upcoming step.

Create Gift Card Tenders
Create the following two Tender/Media records to be used for gift card transactions:

• Gift Card Redeem

• Gift Card Cash Out

The following table provides a summary of information to be entered in the steps that follow.

Table 15-3    Summary of Gift Card Tender Information

Tab Field or Option Gift Card Redeem Gift Card Cash Out

General Name Gift Card Redeem Gift Card Cash Out

General Record Number 500 * 600 *

General Key Type 1 - Payment 3 - Pickup

Options, Printing
Options

8 - Print Customer
Receipt

Enable

21 - Print Summary
Totals

Enable

3 - Assume Paid in Full Enable

66 - Tender Media
Used for Stored Value
Transactions

Enable Enable

68 - Mask Account
Number

Enable

* Use this number if it is not being used; otherwise use another number.

1. Select the Enterprise or property, click Configuration, and then click Tender/Media.

2. Insert a record, name it Gift Card Redeem (use number 500 if not already used), and then
click OK.

3. Double-click the record to open it.

4. On the General tab, select 1 - Payment from the Key Type drop-down list.

5. Click the Options tab, and then click the Printing Options subtab.

6. Select 8 - Print Customer Receipt and 21 - Print Summary Totals.

Ensure that all other options are disabled.

7. Click the Ops Behavior subtab, and then select the following options:

• 3 - Assume Paid in Full
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• 68 - Mask Account Number

• 66 - Tender Media Used For Stored Value Transactions

Ensure that all other options are disabled.

8. Click Save.

9. Insert a record, name it Gift Card Cash Out (use number 600 if not already used), and
then click OK.

10. Double-click the record to open it.

11. On the General tab, select 3 - Pickup from the Key Type drop-down list.

12. Click the Options tab, click the General subtab, and then select 66 - Tender Media Used
For Stored Value Transactions.

Ensure that all other options are disabled.

13. Click Save.

14. Write down the record numbers (shown in the # column) for each of these two tenders.
These numbers are used when configuring the gift card program, which occurs in an
upcoming step.

Enable the Gift Card Interface
1. Select the Enterprise, click Setup, and then click Interfaces

2. Insert a record for Stored Value as the System Name.

3. Double-click the new interface record to open it.

4. On the General tab, select 5 - Stored Value in the Interface Type drop-down list.

5. Click the Options tab, and then select 12 - Gift and Loyalty SVC Interface.

6. Click the Properties tab, and then select the gift card locations.

7. Click Save.

Configure Gift Card Program
After configuring the POS clients, follow this process to configure a basic gift card program.

Configure Role
1. Sign in to Simphony Home with your credentials. This user must have hierarchy

administration privileges.

2. From the Dashboard, click the application navigation icon
(

) at the top left of the page to view the side panel menu.
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Figure 15-1    Dashboard

3. Select Administration, and then click Roles.

4. Select your role, and then click Portlets.

Figure 15-2    Role and Portlets Selection

 

 

5. Select Assign Portlet, and then select the following Gift and Loyalty portlets:

• G&L Account Administration (Portlet)

• G&L Gift, Payment, and Loyalty Configuration (Portlet)
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Figure 15-3    Gift and Loyalty Portlets Assigned

6. Select all the privileges for both portlets, and then click the blue Assign Portlet button to
assign the options.

Figure 15-4    Select Portlet Privileges
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Figure 15-5    Assign Portlet

7. Sign out and sign in again. From the Dashboard, click the application navigation icon
(

), select Gift and Loyalty, and the new Gift and Loyalty options appear in the side panel.

Configure Organization
1. Select G&L Gift, Payment, and Loyalty Configuration, select Initial iCare GPL Setup

and Configuration, and then select Organization Configuration.

2. On the Main tab, ensure that iCare is selected in the Interface Type drop-down list.

Figure 15-6    Organization Main Page for Interface Type Selection

3. Click Save.

Configure DB Sync Schedule
1. Select G&L Gift, Payment, and Loyalty Configuration, and then select Initial iCare GPL

Setup and Configuration.

2. Select DB Sync Schedule to schedule the database synchronization jobs to transfer
information from the Enterprise Back Office database to the Gift and Loyalty database.

Chapter 15
Configure Gift Card Program

15-12



Figure 15-7    DB Sync Schedule Link

3. Add the sync records described in the following table if they do not exist, or change them if
they exist. You also need to enter the Server Name for your server and the sync frequency
information for each sync type record.

Table 15-4    DB Sync Types and Frequencies

Sync Type Sync Frequency

Sync All Configuration Sync now.

Sync Org Levels Sync daily at 4:00 a.m.

Sync Revenue Centers Sync daily at 4:00 a.m.

Sync RTA Org Levels Sync daily at 4:00 a.m.
Run manually (Sync Now) after adding a new
location if that location needs to process Gift
Cards in the same business day.

Sync iCare Transactions Run once daily after Point-of-Sale End of Day
operations.

Sync iCare Customers Run once daily after Point-of-Sale End of Day
operations.

AGGREGATE_TRANSAC Run once daily after Point-of-Sale End of Day
operations.

Sync Locations Sync daily at 4:00 a.m.
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Figure 15-8    Add Sync Types and Frequencies

4. Click Save.

Create Gift Card Program
To create a basic gift card program:

1. Sign in to Simphony Home with your credentials.

2. From the Dashboard, click the application navigation icon
(

) at the top left of the page, select Gift and Loyalty, select G&L Gift, Payment, and
Loyalty Configuration, select Programs, Cards, Coupons and Rules, and then select
Programs.

3. Click Add.

4. On the General tab, select Gift or Debit Card from the Program Type drop-down list.

5. Enter an identifying Program Name and Public Name, and optionally enter
a Description for comments or notes regarding the program.

6. Enter an identifying code up to 10 alphanumeric characters in Program Code. This code is
not made public.

7. Select the default currency type used by the program from the Currency Type drop-down
list.

8. Leave the Default Coupon Code blank.

9. Select Same type, amount, and check from the Credit Reversal and Debit Reversal
drop-down lists.

10. For programs with a limited duration, select the date range that the gift/debit program is
active using the Effective From and Effective To date selection fields. Leave the fields
blank if the program has an indefinite duration.

11. Leave the other defaults.
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Figure 15-9    General Gift or Debit Card Program Defaults

12. Click the Gift or Debit/Credit/Award Programs tab.

13. To allow customers to cash out a gift card:

a. Select Allow Cash Out.

b. Enter a Cash Out Limit to set an upper limit to the amount that can be cashed out.

Figure 15-10    Gift or Debit/Credit/Award Programs

14. Select the following check boxes:
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• Reserve for Auth

• Allow Reload

15. Select Allow Partial Redeem to allow the Point-of-Sale to redeem the total value of the
card when it is used for a check with a higher value.

For example, when applying a gift card with $5 remaining to a $10 check, if this option is
enabled, the system applies the $5 from the card to the check. If this option is not enabled,
the system shows an insufficient balance error, and the balance must be manually
redeemed.

16. Select Do Not Allow Issue/Reload and Redemption on Same Check to prevent issuing,
reloading, and redemption actions to be performed on the same check.

17. Enter a Maximum Account Balance to set an upper limit on the amount that can be
stored on a card at any time.

18. Enter a Transaction Limit to set an upper limit to the amount that can be issued or
reloaded to a card in a single transaction. Oracle Hospitality recommends entering a value
to prevent input errors.

19. If required, enter a Max Redeem Amount/Day, Max Redeem Amount/Day Part, or Max
Redeem Amount/Visit to set an upper limit to the reward amount that can be redeemed
by day, day part, or visit.

20. Leave the other defaults, and click Save.

Create Gift Card Rules
Programs require at least one card rule, which defines the type of cards that work for the
program. Gift cards for Simphony Essentials have a single iCard rule.

1. From the Dashboard, click the application navigation icon
(

) at the top left of the page, select Gift and Loyalty, select G&L Gift, Payment, and
Loyalty Configuration, select Programs, Cards, Coupons and Rules, and then select
Card Rules.

2. Click Add.

3. Enter an identifying name in the Rule Name field.

4. Select Is this an iCard?.
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Figure 15-11    Create Card Rules Page

5. Leave the other fields, which are required for foreign cards.

6. Click Create. Gift and Loyalty generates the iCard Program Number.

Assign Rules to Programs
After creating a gift card rule, you can assign it to a program and to locations.

1. Sign in to Simphony Home with your credentials.

2. From the Dashboard, click the application navigation icon
(

) at the top left of the page, select Gift and Loyalty, select G&L Gift, Payment, and
Loyalty Configuration, select Programs, Cards, Coupons and Rules, and then select
Programs.

3. Select the card program, and then click Edit Card Rules.

4. Select the rule, and then click Edit.

5. Select the location or select All Locations if the gift card is to be used everywhere.
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Figure 15-12    Edit Card Rules Page

6. Click Save.

Create Gift Card Numbers
After creating a card program and card rule, generate card numbers for a specific program and
rule. Gift and Loyalty uses card numbers as the account numbers.

1. Sign in to Simphony Home with your credentials.

2. From the Dashboard, click the application navigation icon
(

) at the top left of the page, select Gift and Loyalty, select G&L Account Administration,
and then select Create Card Numbers.

3. Select the Program to create card numbers for.

Figure 15-13    Create Card Numbers Page

4. Enter the amount that can be issued to the card in Preset Denomination.

5. If the field is not automatically populated, enter the first number to assign in First Account
Number.
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6. Enter the number of account numbers that you want to generate in Number of Accounts.

7. Click Create. The numbers will appear in a window and can be copied into a notepad if
required.

You can print cards with these numbers, and then issue customer accounts using these
numbers. This process does not forego the need to issue the cards before they are active,
and you must avoid duplicate cards.

Review Existing Card Numbers
1. Sign in to Simphony Home with your credentials.

2. From the Dashboard, click the application navigation icon
(

) at the top left of the page, select Gift and Loyalty, select G&L Account Administration,
and then select View Created Card Numbers.

3. Select the line with the set of numbers for your program, and then click View. A list of the
card numbers appears.

4. Scroll to the end of the list of numbers and make note of the last card number. You must
enter a higher number when creating your next batch of cards.

Manage Existing Accounts
If required, you can enter a name and phone number against an account number so that the
gift card balance is accessible by name or phone from the POS. You can also see the status of
your accounts here.

1. From the Dashboard, click the application navigation icon
(

) at the top left of the page, select Gift and Loyalty, select G&L Account Administration,
and then select Manage Existing Accounts.

2. Select Find Account Number.

3. To list the status of your accounts, enter the start of the account number in the search field,
and then click Find.
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Figure 15-14    Enter Account Number

4. To assign a name and phone number, select the account number line, and then click
Manage.

Figure 15-15    Select Account Number Line

5. Select Edit Account Information.

6. Enter First Name, Last Name, and Phone Number.
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Figure 15-16    Edit Account Name and Phone Number

7. Click Save.

Configure Point-of-Sale Touchscreen Keys
Gift and Loyalty Point-of-Sale (POS) keys need to be activated, and some need to be
associated with the tender types and service charge records in the Simphony EMC.

1. Sign in to Simphony Home with your credentials.

2. From the Dashboard, click the application navigation icon
(

) at the top left of the page, select Gift and Loyalty, select G&L Gift, Payment, and
Loyalty Configuration, select Programs, Cards, Coupons and Rules, and then select
POS Configuration.

3. To activate a function, select the function, click Edit, and then select Active.

The following functions need to be active for gift cards if they are being used:

• Balance Inquiry

• Balance Transfer

• Cash Out

• Activate

• Issue

• Redeem

• Redeem Auth

• Reload

4. To allow a function to be used when the system network is offline, select the function, click
Edit, and then select Allow Offline.

5. Click Save.

6. To associate the Activate POS key to the Simphony EMC Gift Card Activate service
charge record:

a. Select the Activate line, select Edit POS Key, and then edit the record.

b. Select Service Charge in the POS Key Type drop-down list.
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Figure 15-17    Edit POS Key for Activate Service Charge

c. Enter a Description.

d. Enter the POS Key Number. This must be the same as the Gift Card Activate
service charge record number in the Simphony EMC. (For new Simphony Essentials
19.5 organizations, the number is 300.)

e. Click Save.

7. To associate the Issue POS key to the Simphony EMC Gift Card Issue service charge
record:

a. Select the Issue line, select Edit POS Key, and then edit the record.

b. Select Service Charge in the POS Key Type drop-down list.

c. Enter a Description.

d. Enter the POS Key Number. This must be the same as the Gift Card Issue service
charge record number in the Simphony EMC. (For new Simphony Essentials 19.5
organizations, the number is 100.)

e. Click Save.

8. To associate the Reload POS key to the Simphony EMC Gift Card Reload service
charge record:

a. Select the Reload line, select Edit POS Key, and then edit the record.

b. Select Service Charge in the POS Key Type drop-down list.

c. Enter a Description.

d. Enter the POS Key Number. This must be the same as the Gift Card Reload service
charge record number in the Simphony EMC. (For new Simphony Essentials 19.5
organizations, the number is 200.)

e. Click Save.

9. To associate the Cash Out POS key to the Simphony EMC Cash Out Gift Card tender
record:
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a. Select the Cash Out line, select Edit POS Key, and then edit the record.

b. Select Tender in the POS Key Type drop-down list.

Figure 15-18    Edit POS Key for Cash Out Tender

c. Enter a Description.

d. Enter the POS Key Number. This must be the same as the Cash Out Gift Card
tender record number in the Simphony EMC. (For new Simphony Essentials 19.5
organizations, the number is 600.)

e. Click Save.

10. To associate the Redemption POS key to the Simphony EMC Redeem Gift Card tender
record:

a. Select the Redemption line, select Edit POS Key, and then edit the record.

b. Select Tender in the POS Key Type drop-down list.

c. Enter a Description.

d. Enter the POS Key Number. This must be the same as the Redeem Gift Card tender
record number in the Simphony EMC. (For new Simphony Essentials 19.5
organizations, the number is 500.)

e. Click Save.
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16
Dining Room Table Numbers

Configure Dining Table Numbers
Table numbers are required for TSR operations. You need to configure the table numbers in
the restaurant so that servers can start a check using one of these table numbers. The table
number appears on the workstation home page beside the open check.

1. Select the revenue center, click Setup, and then click Tables.

2. Click the Insert icon ( ) on the toolbar.

3. On the Insert Record dialog, leave the default values and click OK. A record is created for
Table 1.

To create a specific table number or numbers, enter a value in the Record number or
range field.

4. Repeat steps 2 and 3 to create the required number of tables.

5. (Optional) Change the Name field to describe the table (for example, 1 or One).

The table name appears on the workstation and represents the local facing name or
number used to differentiate the table from others. Values in the Name field can be:

• All numeric

• All alpha

• Alpha and then numeric

6. Click Save.
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17
Hardware

Add a Workstation
Simphony Essentials supports up to five POS workstation client devices per location/property.
Simphony Essentials is supported on POS workstation client devices running Linux and
Android operating systems. The Microsoft Windows operating system is not supported on a
POS client device for Simphony Essentials.

1. Select the property, click Setup, and then click Workstations.

2. Click the Insert icon ( ) on the toolbar.

3. In the Insert Record dialog, enter the Record Name, and then click OK.

4. Double-click the new workstation record.

5. On the General tab, enter information in the following fields:

Table 17-1    General Workstation Settings

Field Description

Type Select the type of workstation from the drop-down list:
• 2 - Workstation Client: Workstations and Android

devices
Select this option for the Oracle MICROS Workstation 6
Series, the Oracle MICROS Workstation 310, and
Android devices.

• 3 - POSAPI Client: Simphony Transaction Services
• 7 - Castle S1F2: Adyen Castles S1F2 Android payment

devices

Language Select the default language of the workstation. This is the
language that appears on the workstation’s Sign On screen.
If an employee has a different default language set, the
employee sees their default language after signing in to the
workstation.

Log Verbosity Select the logging verbosity for the workstation. Select 0
(zero) for minimal logging. Higher log verbosity provides
more information in the log file, which may be helpful in
troubleshooting issues.
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Table 17-1    (Cont.) General Workstation Settings

Field Description

Workstation Class Select the service type:
• 1 - Table Service Restaurant: Workstations and larger

Android landscape tablet devices
• 2 - Quick Service Restaurant: Workstations and larger

Android landscape tablet devices
• 3 - Bar: Workstations and larger Android landscape

tablet devices
• 4 - Mobile Table Service Restaurant: Adyen Castles

S1F2 Android payment devices and smaller Android
portrait devices (such as mobile phones)

• 5 - Mobile Quick Service Restaurant: Adyen Castles
S1F2 Android payment devices and smaller Android
portrait devices (such as mobile phones)

If a workstation is incorrectly configured (for example,
Workstation Class 1 - Table Service Restaurant is selected
for a mobile phone device), the page Configuration Error
Incorrect Workstation Class configured appears before the
sign in page on the POS client device. This error also
appears on workstations and tablets if an incorrect
Workstation Class is selected. Workstations and tablets use
the non-mobile Workstation Classes. To resolve this error,
correct the Workstation Class, and then click Update
Database And Redraw Page on the POS Client device.
Alternatively, close the application on the device and
change the Workstation Class at a later time.

Enable Simphony Transaction
Services

These options become active after you select 3 - POSAPI
Client from the Type field. Select the appropriate option to
enable Simphony Transaction Services.

Database Update Frequency Enter the number of seconds for the workstation to receive
changes.
The value in this field overrides the Property Parameter’s
Database Update Frequency setting.

Check Inactivity Timeout Enter the number of seconds before the workstation shows
the message (Do you need more time?), prompting the
workstation operator to cancel the transaction. When you
enter 0 (zero), the message does not appear.

Check Inactivity Dialog
Timeout

Enter the number of seconds that the workstation shows the
Inactivity dialog before automatically cancelling the
transaction. This field is inactive when you set the Check
Inactivity Timeout value to 0 (zero).

Report Timeout Enter the number of seconds the workstation waits for a
response from the Reporting and Analytics server before
showing a communication failure notice.

Offline Threshold Enter a number between 0 and 99 to represent the signal
strength percentage at which devices go offline. Devices will
go offline when the signal strength is at or below this
percentage value. For example, if the Offline Threshold is
set to 90 (90%), and the device’s current signal is 89%, the
device will go offline. When the signal is detected above
90%, the device reconnects online.
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Table 17-1    (Cont.) General Workstation Settings

Field Description

Reconnect Threshold Enter a number between 0 and 99 to represent the signal
strength percentage at which devices recover online after
being in an offline state. Devices will go online when the
signal strength is at or above this percentage value. For
example, if the Reconnect Threshold is set to 80, and the
device’s signal strength is 85%, the device will go online.

Service Host ID This field become active after you select 3 - POSAPI Client
from the Type field. Select the service host on which the
POS API client runs.

Address / Host Name Enter the IP address or host name of the service host where
the workstation application runs.

Subnet Mask Enter the subnet mask of the service host where the
workstation application runs.

Default Gateway Enter the default gateway of the service host where the
workstation application runs.

Is Windows Service Select this option to allow the service host to start as a
Windows service. The service host service starts on
Microsoft Windows startup with other Microsoft Windows
services. The workstation starts only when the workstation
operator signs on to the operating system.
If you select this option, you need to change the ports of the
services being run (for example, Check and Posting Service
(CAPS) and Kitchen Display System (KDS) Controller) in
addition to the workstation. Use the EMC modules to change
the ports.
If a non-POS workstation is required to run on the service
host, it must run on a different port than the workstation
port.
You can also set the service host to run as a Microsoft
Windows service from the Service Host module (rather than
from the Workstations module). If you set this option in the
Service Host module, you do not need to change the ports of
the services being run as the device is not intended to run
the workstation.

Resolution Cols Enter the number of Resolution Columns for the
workstation’s display. The default value is 0 (zero).

Resolution Rows Enter the number of Resolution Rows for the workstation’s
display. The default value is 0 (zero).

Location From Top Enter the number of pixels from the top where the
workstation window is placed on the display screen.

Location From Left Enter the number of pixels from the left where the
workstation window is placed on the display screen.

6. Click the Printers tab.

7. Click the Select link next to each printer type that you need to configure, select the printer,
and then click OK.

8. Click Save.
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Enable a Third Party Mobile Device Management (MDM) to Distribute
Simphony POS Client Software

You can use a third party Payment Service Provider (PSP) and its proprietary external Mobile
Device Management (MDM) platform to distribute Simphony Essentials software to Android
devices. The Third Party Managed Device option is only available for use with the following
types of POS workstations:

• 1 - Mobile

• 2 - Workstation Client

• 6 - Tablet Client

1. Select the property, click Setup, and then click Workstations.

2. Select an Android workstation record that has Type 1 - Mobile, 2 - Workstation Client, or
6 - Tablet Client.

3. Click the Options tab, and then click the Hardware/Cash Drawer subtab.

4. Select 68 - Third Party Managed Device.

Enabling this option allows a third party PSP to ensure the device’s CAPS and Service
Host versions are compatible and in sync. When the option is enabled, if the device’s
CAPS version does not match the Service Host version, the customer is prompted to
upgrade (or downgrade) the Simphony Essentials application version on the device.

5. Click Save.

Introduction to Print Class Output
You can use a Print Class to configure the output for Discounts, Service Charges, and Tender
Media. This enables multiple records with a single Print Class, meaning you can define the
output settings once rather than separately for each record.

A Print Class is automatically created for every Discount, Service Charge, and Tender Media
record. The Print Class field automatically defaults to the Print Class created for these records
on the General tab in the Discounts, Service Charges, and Tender/Media modules.

There are four basic print class output destinations:

1. Receipts

Receipts print at the workstation at the end of a fast transaction. They are typically used in
a quick service restaurant (QSR) environment where ordering menu items and tendering
the check is performed in the same service round.

2. Guest Checks

Guest checks print at the workstation. They are typically used in a table service restaurant
(TSR) environment. Checks usually include a table number or guest name and are service
totalled several times before final tender.

3. Order Devices

Order devices are remote kitchen or bar printers, or KDS devices. These devices deliver
the order to the production area from the workstation.

4. Journal
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The journal is not a physical device, but an electronic file journal that provides audit
capabilities in the application.

Configure Printer
Printers and order devices are critical types of hardware that allow communication between
various areas of a restaurant, such as the kitchen and dining room or bar.

1. Select the property, click Setup, and then click Printers.

2. Insert a printer record, name the printer, and then click OK.

3. Double-click the printer record to open it.

4. Select the Workstation from the drop-down list.

5. Select the Printer Type from the drop-down list.

Select Epson Bluetooth Printer for all Bluetooth printers.

6. If the roll printer is a thermal printer, select Thermal printer in the Printer Options section.

7. Enter the number of lines to advance the guest check or customer receipt after printing the
trailer text in the Trailing Line Feeds field.

The value in this field defaults to the recommended trailing line feeds for the printer
communication type, as listed in the following table. You can change the default value.

Table 17-2    Trailing Line Feeds per Printer Communication Type

Printer Communication Type Trailing Number of Lines

Bluetooth 1

Ethernet 1

Integrated Device Network (IDN) 1

Serial 6

OPOS 6

8. (Optional) To set the printer to print logos, select Enable Logo Printing. Simphony
Essentials does not support logo printing on printers with multi-language cards.

When configuring Epson TM-P60 and TM-T88 Ethernet Thermal printers, configure the
logo to print in the center of the guest check or customer receipt by selecting the paper
size of the printer from the Center Logo Using drop-down list.

• Epson TM-P60 Ethernet Thermal printers: Set the paper size to 2 1/4" (58mm) Paper.

• Epson TM-T88 Ethernet Thermal printers: Set the paper size to 3 1/8" (80mm) Paper.

Introduction to Logo Printing contains more information about setting up logos to print on
guest checks and customer receipts.

9. To allow the printer to be selectable by workstation operators (typically used with mobile
POS client devices), select Destination Printer.

Bluetooth printers are not selectable.

10. Configure the appropriate values for the printer type. Specific fields become active based
on the printer type you selected.

The following table lists the printer types and indicates information for each applicable field.
Enter or select information for the fields based on the printer you are configuring. Fields
denoted as Not applicable are not needed for the printer type.
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Table 17-3    Printer Configuration by Printer Type

Field Roll Printer Slip Printer IP Printer Bluetooth Printer

COM Port Select the
communications
port for the
printer.

Select the
communications
port for the
printer.

Not applicable Not applicable

Baud Rate Select the baud
rate for the
printer.

Select the baud
rate for the
printer.

Not applicable Not applicable

Parity Select the parity
for the printer.

Select the parity
for the printer.

Not applicable Not applicable

Data Bits Select the data
bits for the
printer.

Select the data
bits for the
printer.

Not applicable Not applicable

Stop Bits Select the stop
bits for the
printer.

Select the stop
bits for the
printer.

Not applicable Not applicable

PIN Not applicable Not applicable Not applicable Set the four-digit
passkey that
must be entered
into the device
before printing.

ID Not applicable Not applicable Not applicable (Optional) Enter
the Bluetooth ID
of the printer.
You can leave
this field blank to
allow
configuration
from a mobile
device when
using different
printers per
event.

Number of
Columns

Not applicable Not applicable Not applicable This setting
determines the
report width so
that guest checks
and reports print
with center
alignment. By
default, the
width is set to 32
columns.
Select 40 for
Bixolon SPP-
R300, SPP-R310,
and R310iK
Bluetooth
printers.
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Table 17-3    (Cont.) Printer Configuration by Printer Type

Field Roll Printer Slip Printer IP Printer Bluetooth Printer

Address Not applicable Not applicable Enter the IP
address or
hostname of the
printer. If you
are using the
printer for
banquet checks,
enter the
hostname.

Not applicable

Port Not applicable Not applicable Enter the port
number for the
IP printer.

Not applicable

11. Click Save.

12. Select the property, click Setup, and then click Workstations.

13. Double-click the workstation to open it.

14. Click the Printers tab.

15. Click the Select link to set the appropriate Printer for each type of print job. Click the Set
for All Destination Printers link to set the same printer for each type of print job.

The printer defined here (primary or backup) always appears in the Destination Printers list
on the POS workstation, even if you do not add it to the Destination Printer Group. 
Create, Edit, and Remove Printer Groups contains more information.

Assign the same printer model and format for the backup printer to ensure that checks
format properly on other printers.

16. Click the Select link and assign each printer type to a Destination Printer Group. Click
the Set for All Destination Printers link to set the same printer type for all destination
printer groups.

Selecting a Destination Printer Group overrides the printer selected for the printer type.

Printers with the option Selectable as Destination Printer set belong to a default
Destination Printer Group called All Destination Printers.

If you define a Destination Printer Group for the Backup Printer, the workstation operator
is prompted at the time of printing for both the primary printer (if it has a group defined) and
the Backup Printer.

17. Click Save.

18. Select the Enterprise, property, or revenue center, click Setup, and then click Format
Parameters.

19. Click the Configuration tab, and then enter the appropriate information in the following
fields:

Table 17-4    Print Output Configuration

Field Description

Lines on First Page Enter the maximum number of lines to print
on the first page of the guest check before
prompting for a new check to begin a new
order receipt.
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Table 17-4    (Cont.) Print Output Configuration

Field Description

Lines on Other Pages Enter the maximum number of lines to print
on successive pages of the guest check before
prompting for a new check to begin a new
order receipt.

Line Feeds Before First Page Enter the number of lines to advance before
printing the guest check header. You can add
extra space for the check so it appears
properly in custom check presentation
binders.

Line Feeds Before Other Pages Enter the number of lines to advance before
printing begins on the next successive page.
The line feeds set here are included in the
number configured for the Lines on Other
Pages field. For example, if you set this field
to 5 and set Lines on Other Pages to 30, the
pages have 25 lines of text.

Minimum Lines Per Roll Check/Receipt Enter the minimum number of lines to print
on guest checks and customer receipts. Blank
lines are added after printing to achieve the
minimum.
Use this field if you want guest checks and
customer receipts that are printed on a roll
printer to have a minimum length in order to
fit into guest check covers.

Number of Guest Check Information Lines Enter the number of detail lines (0 through
30) that can be entered in a System Interface
Module (SIM) dialog box.

Print Tax Invoice after Sales Threshold Enter the sales threshold needed to pass for a
tax invoice to be printed for a customer.

Print Customer Information after Sales
Threshold

Enter the sales threshold needed to pass for
customer information to be printed for a
customer.

Customer/Trade Identity Label Enter the label information to be presented
on the top of a bill after a maximum sales
threshold is met. This label is either a
customer’s name (written in the field as
Customer Name) or a Trade Identity Label.
In the case of Australia Goods & Services Tax
requirements, the trade identity label for
Australia is ABN. This information must be
present on a bill after the maximum
threshold is met. The information is never
stored, and the label can be changed.

20. Click the Options tab.

21. Select the appropriate printing options:

• 57 - Do Not Print Change/Payment Due in Double Wide: Select this option if you do
not want double-wide formatting on the Change Due line of a receipt or the Total Due
line of a check.

• 58 - Do Not Consolidate Current Round Items in Printed Guest Check: Select this
option if you do not want to combine identical items which are ordered in multiples in
the current round when printing a receipt.
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• 61 - Show Asterisk (*) indicator for Menu Item where Inclusive Tax was forgiven
on screen: Select this option if you want to display an asterisk on the receipt to
indicate that the inclusive tax was forgiven for a menu item.

22. Click Save.

Create, Edit, and Remove Printer Groups
If the location is large and has many printers disbursed over a wide area, you may find it useful
to configure a limited list of printers that are selectable by workstation operators. The
workstation operator can select a printer that is nearby from the list on the workstation (a
mobile tablet device), and optionally set this printer as the default printer for future print jobs.
When a workstation operator selects a default destination printer, the selection automatically
resets at Start of Day.

A default printer group named All Destination Printers exists in the Printer Groups module.
You cannot change this default printer group. If you do not create printer groups, all printers
with the option Destination Printer (set in the Printers module) belong to the All Destination
Printers printer group. The All Destination Printers default printer group is useful for
locations that need only one group of destination printers.

1. Select the property, click Setup, and then click Printer Groups.

2. Insert a printer group record, name the printer group, and then click OK.

3. Double-click the printer group record to open it.

4. To add a printer to the printer group, click the Add link, click the ellipsis button, and then
select the printer.

You can add any printer to any printer group, regardless of the Destination Printer option
setting. You can add one printer to multiple printer groups.

5. Repeat Steps 1 through 4 for to create more printer groups and to add printers to the
groups.

6. To delete a printer from a printer group, select the printer, and then click the Delete link.

7. Click Save.

8. To edit a printer group, highlight the record, change the values, and then click Save.

9. To remove a printer group, highlight the record, and then click Delete on the toolbar.

Configure Printer Order Device
You can configure order chits to send to a printer at the kitchen when checks are service
totalled on a workstation.

1. Select the revenue center, click Setup, and then click Order Devices.

2. Insert an order device record for the printer (for example, Kitchen Hot Printer), and then
double-click the record to open it.

3. On the General tab, select 1 - Remote from the Device Type drop-down list, select 0 -
Printer from the Primary Device Type drop-down list, and then select the appropriate
printer record from the Device drop-down list.

4. If you have a backup printer, select the Backup Device from the drop-down list.

5. From the Order Device Redirect drop-down list, select the printer order device that you
created in Step 2.
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6. From the Menu Item Printing drop-down list, select the items to route to this KDS:

• 0 - All Items: Select to route all menu items.

• 1 - Only Items with Condiments: Select to route only menu items with condiments.

• 2 - Only Items without Condiments: Select to route only menu items without
condiments.

7. From the Condiment Sort Type drop-down list, select how to sort the condiments on the
order chits. Condiment sorting only works if you have set Menu Item Classes option 30 -
Sort Condiments by Print Group for the parent menu items.

• No condiment sorting: Select to list condiments in the order in which they are entered
on the check by the workstation operator. Allowed condiments sort in the order
assigned in Condiment Sets, if configured.

• Sort allowed condiments: Select to sort only allowed condiments based on the print
group. The sort order configured for allowed condiments in Condiment Sets is
discarded. If required condiments are ordered in between allowed condiments, the
required condiments remain in the same position in which order they were ordered.

• Sort all condiments: Select to sort all condiments based on the print group,
regardless of condiment type.

8. Configure the following Print Settings:

Table 17-5    Order Devices Printer Settings

Field Description

Max # Lines per Chit Enter the maximum number of lines (0 to 99)
to print on each page of an order chit. Oracle
MICROS roll printers print 6 lines per inch.

Sort/Consolidation Method Select the parent menu item sort and
consolidation method for this order device.

Language Select the primary language for the order
device. This field only shows the languages
that are assigned to the property in the
Property Parameters module.

Language 2 To print the output in a second language,
select the secondary language.

Language 3 To print the output in a third language, select
the third language.

Line Feeds Before Order Enter the number of lines to advance before
printing the order on order chits.

Line Feeds After Order Enter the number of lines to advance after
printing the order on order chits.

9. Click the Options tab, and then select the appropriate printer options as described in the
following table:
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Table 17-6    Order Devices Printer Options

Option Description

1 - On = Print Trans Emp Name and #; Off =
Print Chk Emp Name and #

Select this option to print the employee name
and number of the transaction operator on
the order chit. Deselect to print the employee
name and number of the check operator.

3 - Print Dopplebon Select this option to print a separate order
chit for each menu item in the current
service round (dopplebon style). Deselect to
print one order chit for all menu items in the
current service round (the default printing
style).

4 - Print Dopplebon Summary Select this option to print an order summary
chit before printing an order's dopplebon
order chits. Deselect to suppress dopplebon
summary chit printing

6 - Print Seat Numbers with Individual Items Select this option to print seat numbers with
each individual menu item.
If the order device is set to consolidate (Sort/
Consolidate Method on the General tab), the
seats print as a Seat Header above the detail
item.

7 - Print Revenue Center Name on Orders Select this option to print the revenue center
name with each order sent to this order
device. The name prints in double-wide
characters. Deselect to suppress printing the
revenue center name.

9 - On = Print void marker before Void; Off =
Print Void in Red

Select this option to print a VV VOID VV
line, in red or inverse, in front of voided
menu items. Deselect to print voided items in
red, without the VV Void VV line.

10 - Print Condiments in Red (Overrides Print
Class Settings)

Select this option to print condiments in red
ink or in inverse. Deselect to print
condiments in red/inverse or in black,
depending on the Print Class Red/Black
option setting.

11 - Print Both Menu Item Names Select this option to print both names entered
for a Menu Item Definition on the order chit.
Deselect to print only one name.
When this option is deselected, the name that
prints is determined by the Menu Item
Definition's Menu Item Class option Print
Name 2 on Order Output Instead of Name
1.

13 - Print Guest Check Info Lines Before
Header on Order Device

Select this option to print guest check
information lines before the order device
header.

14 - Print Guest Check Info Lines After
Header on Order Device

Select this option to print guest check
information lines after the order device
header.

15 - Print Guest Check Info Lines After Trailer
on Order Device

Select this option to print guest check
information lines after the order device
trailer.
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Table 17-6    (Cont.) Order Devices Printer Options

Option Description

16 - Print Secondary Items See Configure Secondary Printing for more
information.

21 - Exclude Voids Select this option if you do not want voids of
previous round items to be sent to the
kitchen.

22 - Intersperse Different Languages If you are printing in more than one
language, select this option to print the menu
item in each language before printing any
condiments. For example, the output will be
menu item name in language 1, menu item
name in language 2, 1st condiment in
language 1, 1st condiment in language 2.

24 - Print Dining Course Header Select this option to print a dining course
header and to group the menu items by
dining course.

25 - Format Prefix On Separate Line Select this option to print the prefix on a
separate line above the condiment. Deselect
to print the prefix on the same line as the
condiment that it modifies.

26 - Print Single Wide Select this option to print orders in single-
width characters.
This supports longer menu item names, but
has the drawback of not being as readable
from a distance.

10. Click Save.

11. Select the property, click Setup, and then click Workstations.

12. Double-click the workstation record for which to assign the printer order device, and then
click the Order Devices tab.

13. Select the printer order device from the Order Device Output list, and then click Save.

Configure Secondary Printing
Secondary printing enables workstation operators to print menu items to additional printers as
secondary items. A secondary item is one that is part of the same order, but prepared at
another Prep Station. This allows the prep cook to know what other items accompany the dish.
For example, a house salad is a primary item on the cold line, but a secondary item on the hot
line. When secondary printing is enabled, the cook reading the chit from the hot printer sees
the items necessary for preparation at the hot line and also any items being prepared by other
cooks that were added to the check at the same time. This feature allows the kitchen to
synchronize orders for delivery. For example, pizza and chicken wings are set to print to the
hot printer, and house salad is set to print to the cold printer. If the cook who prepares the
salad does not know that the chicken wings and pizza go with the salad order, the cook might
prepare the salad immediately. This can cause the salad to get warm or wilt, possibly having to
be remade.

Secondary items print in a smaller font at the bottom of the order chit.

1. Select the revenue center, click Setup, and then click Order Devices.

2. Double-click a printer order device record, and then click the Options tab.
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3. Select the appropriate options that apply to secondary printing, and then click Save:

Table 17-7    Secondary Printing Options

Option Description

16 - Print Secondary Items Select this option to allow this order device to
print items sent from other printers as
secondary items.

17 - Broadcast Secondary Print Jobs to All
Printers

Select this option to send all items
programmed to print at this order device to
other printers to print as secondary items.
Items print only at other printers that have
16 - Print Secondary Items enabled.

18 - Print Secondary Printer Header Select this option to print the name of the
printer from which the secondary items are
being broadcasted.

19 - Print Secondary Items in Red Select this option to print secondary items in
red.

20 - Suppress Blank Lines Between
Secondary Items

Select this option to remove extra line
spacing between secondary items on order
chits.

Configure Cash Drawer
1. Select the property, click Setup, and then click Workstations.

2. Double-click the workstation to be used with the cash drawer.

3. Click the Transactions tab.

4. Select the number of Cash Drawers (0, 1, or 2) that are physically installed at the
workstation.

5. In the Cash Drawer Beep Timeout field, enter the number of seconds the cash drawer
can be open before the workstation begins beeping. If you set this value to 0 (zero),
beeping does not occur.

6. In the Cash Drawer Notify Timeout field, enter the number of seconds the cash drawer
can be open before the workstation posts a message to the journal log file. If you set this
value to 0 (zero), the message does not post to the journal log.

7. Click the Options tab, and then click the Hardware/Cash Drawer subtab.

8. Select the appropriate cash drawer options.

Table 17-8    Cash Drawer Options for Workstation

Option Description

3 - Require Cash Drawer to be Closed Before
New Transaction

Select this option to require the workstation
operator to close the cash drawer before
beginning a new transaction. Deselect this
option to allow transactions to begin while a
cash drawer is open.
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Table 17-8    (Cont.) Cash Drawer Options for Workstation

Option Description

4 - Assign Cash Drawer By User Workstation Select this option to allow workstation
operators to assign themselves to the cash
drawer using the function key Assign Cash
Drawer. Only the workstation operator
assigned to the drawer can open it.

7 - Use Other Cash Drawer for Other
Currency

Select this option if two cash drawers are in
use for the workstation and one is dedicated
to foreign currency.

9. Click Save.

10. Select the Enterprise, property, or revenue center, click Setup, and then click Control
Parameters.

11. Click the Options tab.

12. Select the appropriate cash drawer options.

Table 17-9    Cash Drawer Options for Control Parameters

Option Description

23 - Open Drawer Only if Balance Due is 0.00 Select this option to prevent a tender/media
key from opening the cash drawer unless the
balance due is $0.00. Deselect this option to
allow a tender/media key to open the cash
drawer even if there is a balance due on the
transaction.
If the transaction’s subtotal is $0.00 and you
set 36 - Do Not Open Cash Drawer if
Subtotal is 0.00, the setting of option 23 is
irrelevant.

33 - Employee ID Required With [No Sale]
Key

Select this option to prompt for the signed-on
workstation operator’s employee ID after
pressing the No Sale key. Deselect this option
to allow workstation operators to use the No
Sale key any time a privileged employee is
signed on.
This feature is used by staydown operators
(such as bartenders or sales clerks) who
typically walk away from the workstation,
and by prompting for employee ID,
mischievous persons cannot open the drawer.

36 - Do Not Open Drawer if Subtotal is 0.00 Select this option to prevent the cash drawer
from opening for transactions in which the
subtotal is $0.00. Deselect this option to allow
the cash drawer to open whenever a
workstation operator uses a tender/media key
that is configured to open the drawer.
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Table 17-9    (Cont.) Cash Drawer Options for Control Parameters

Option Description

42 - Always Open Cash Drawer if Change Due Select this option to allow the cash drawer to
open when there are no tenders on the check
that should usually open the drawer. The
transaction must have change due, and the
current tender must not be configured to
open the drawer.
This option is typically used for Tender/Media
records such as gift certificates, where change
is issued only if the gift certificate exceeds the
value of the transaction (thus, the drawer
should be opened to issue change), but the
drawer remains closed when the gift
certificate does not exceed the transaction’s
total.

65 - Allow open of Cash Drawer on Service
Charge

Select this option to allow the cash drawer to
open for transactions where the service
charge has a value greater than $0.00, but the
subtotal is $0.00.
If you selected 36 - Do Not Open if Subtotal
is $0.00, you must also select this option to
allow the cash drawer to open for service
charge only guest checks.

13. Click Save.

14. Select the Enterprise, click Configuration, and then click Roles.

15. Double-click the role to open it.

16. Select the role type, click the Operations tab, and then click the Miscellaneous subtab.

17. Select the appropriate options for cash drawer privileges.

Table 17-10    Cash Drawer Privilege Options

Option Description

17 - Authorize/Perform unassignment of cash
drawer from others

Select this option to allow employees in the
employee class to use the Unassign Cash
Drawer function key to unassign cash
drawers from other workstation operators.
Do not select this option for every employee;
set it only for management employee classes.
Setting this option allows workstation
operators in the employee class to use the
function key Assign Cash Drawer.

34 - Authorize Open Cash Drawer Using the
[No Sale] Key

Select this option to allow employees
associated with the role to open the cash
drawer outside of a transaction using the No
Sale key, and to authorize non-privileged
employees to do so.

88 - Authorize Cash Drawer Reconnection Select this option to allow employees
associated with the role to authorize a cash
drawer cable reconnection on a workstation.

18. Click Save.
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Configure Magnetic Stripe Reader
Workstation operators scan magnetic stripe cards using a magnetic stripe reader (MSR)
attached to a workstation. Magnetic cards are commonly used as:

• Credit cards

• Gift cards

• Employee identification cards

1. Select the property, click Setup, and then click Workstations.

2. Double-click the workstation to be used with the MSR.

3. Click the Options tab, and then click the Display/Security subtab.

4. Select the appropriate MSR security options.

Table 17-11    MSR Security Options

Option Description

12 - Mag Card Entry Required for Employee
ID

Select this option to allow all employee ID
entries at the workstation to be made by
swiping a magnetic employee ID card. The
workstation does not accept an employee ID
number entered through the keyboard or
touchscreen.

50 - Mag Card or Fingerprint Scan Required
for Employee ID

Select this option to allow all employee ID
entries at the workstation to be made using a
fingerprint scan or by swiping a magnetic
card. That is, employees must swipe a card or
scan a fingerprint.

51 - Mag Card and Fingerprint Scan Required
for Employee ID

Select this option to allow all employee ID
entries at the workstation to be made using a
fingerprint scan and by swiping a magnetic
card. That is, employees must both swipe a
card and scan a fingerprint.

5. If you are using an encrypted MSR, complete the following steps:

a. Click the Hardware/Cash Drawer subtab.

b. Select 55 - Enable Encrypted Magnetic Stripe Reader Support.

After you select this option, you cannot turn it off. Before setting this option, ensure that
the credit card processor or gateway supports encryption functionality.

6. Click the Devices tab.

7. Click Add, and then select a magnetic stripe reader from the Select Peripheral Device
Type drop-down list.

8. Select the COM Port Settings (if necessary), and then click OK.

9. Click Save.

Configure Barcode Reader
A barcode is an optical machine-readable representation of data. Barcodes are used to quickly
order items. Workstation operators scan barcodes using barcode scanners attached to
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workstations. When a barcode is scanned, the workstation software processes the data and
matches it with a menu item configured in the Simphony Essentials database.

1. Select the Enterprise, property, or revenue center click Configuration, and then click
Barcodes.

2. Insert a barcode record.

3. In the Barcode column, enter the numeric value that the barcode represents.

4. Click the ellipsis point (...) button in the Master column, select the master menu item
record to be ordered when the barcode is entered, and then click OK.

5. In the Definition column, select the Menu Item Definition (belonging to the selected Menu
Item Master) to be ordered when the barcode is entered. If you select 0 - All Definitions,
the workstation determines which definition to order at the time the barcode is entered,
based on active menu levels and other criteria.

This column is only active when you set the Menu Item Master column to a value other
than 0 - None.

6. In the Price # column, select the Menu Item Price (belonging to the selected Menu Item
Definition) to be ordered when the barcode is entered. If you select 0 - All Prices, the
workstation determines which price to order at the time the barcode is entered, based on
active menu levels and other criteria.

This column is only active when you set the Menu Item Definition column to a value other
than 0 - All Definitions.

7. In the Alternate Price column, enter the price to charge for the item when the barcode is
entered.

This value is used only when you set a value greater than 0.00; if the value is 0.00, the
price from the Menu Item Price record is used.

8. In the Alternate Prep Cost column, enter the prep cost to use for the item when it is
ordered by the barcode.

This value is used only when you set a value greater than 0.00; if the value is 0.00, the
prep cost from the Menu Item Price record is used.

9. Click Save.

10. Select the Enterprise or property, click Setup, and then click Barcode Format Sets.

11. Insert a barcode format set record, and then double-click it.

12. Click Add.

13. In the Input Length field, enter the number of digits in the scanned barcodes.

14. In the Returned Start field, enter the first digit to use in the numeric value to return.

15. In the Returned Length field, enter the number of digits to read as the numeric value to
return.

16. Click Save.

17. Select the property, click Setup, and then click Workstations.

18. Double-click the workstation to be used with the barcode reader.

19. Click the Transactions tab.

20. Select the Barcode Format Set for the workstation to use.

The Barcode Format Set determines how the workstation reads barcodes of various
lengths.
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21. Click the Devices tab.

22. Click Add, and then select the barcode reader from the Select Peripheral Device Type
drop-down list.

23. Select the COM Port Settings (if necessary), and then click OK.

24. Click Save.
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18
Kitchen Display System (KDS)

When a property (location) is added to the enterprise, one KDS controller record is
automatically added in the EMC for the property. One Expo Station is allowed for each
property, plus up to five Prep Stations per property.

Configure KDS Controller
1. Select the property, click Setup, and then click KDS Controllers.

2. Double-click the KDS controller record to open it.

3. On the General tab, change the Name if needed.

The KDS Controller ID value is automatically generated by the system and you cannot
change it.

4. Set the fields and options as described in the following table:

Table 18-1    KDS Controller General Settings

Fields and Options Description

1 - Prevent Chit Bump on Expo Display if Chit
Exists on Prep Display

Select this option to prevent a chit from being
bumped from an Expo Display if the chit still
exists on one of the Prep Displays.

4 - Expo-only Items Display as Done Select this option to change the status of
menu items that do not go to Prep Stations to
Done when they fire.

12 - Recall to Original Position Select this option to have recalled orders
appear in their original position before being
bumped. When deselected, recalled orders
appear first on the display.

Display Language Select the language. The default is set to
English.

Enable Reset All Time Select this option and then set the daily time
when the KDS Controller deletes all data.
Deselect this option to have the KDS
Controller retain all data and not reset.

5. Click the Service Host tab, click Select adjacent to the Service Host field, select a
service host from the list, and then click OK.

6. Click Save.

Configure KDS Display
1. Select the property, click Setup, and then click KDS Displays.

2. Double-click the KDS display record to open it.
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3. (Optional) On the General tab, change the Number, Name, KDS Controller, and IP
Address.

4. Select the KDS Tool Bar from the drop-down list.

5. Select the orientation type for the display in the Display Orientation drop-down list.

6. Set the options as described in the following table:

Table 18-2    KDS Display Options

Option Description

1 - Enable Item Select Select this option to allow kitchen staff to
select items on the chit.

6 - Disable Item Double Touch Bump Select this option to prevent kitchen staff
from bumping items from KDS Displays using
double touch.

7 - Allow Remote View Select this option to allow other KDS Displays
to remotely view orders on this display.

8 - Allow Remote Actions Select this option to allow other KDS Displays
to perform Done, Recall, and Review actions
on this display while in Remote View.
To enable other KDS Displays to remotely
view orders, but prevent them from
performing actions on this display, select 7 -
Allow Remote View, and deselect 8 - Allow
Remote Actions.

7. Click the Display tab.

8. Set the Display Screen Options:

• Display Type: Select the type of KDS Display (2 - Expo or 3 - Prep).

• Tool Bar Position: Select the location of the tool bar on the display.

9. Set the Chit Display Options as described in the following table:

Table 18-3    KDS Chit Display Options

Field Description

KDS Chit Layout Style Select the type of layout for the order chits on
the display. Depending on the chit layout
style that you select, the Order Type Font
drop-down list becomes active.
To preview the chit layout styles, click Help,
and then select the chit style.
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Table 18-3    (Cont.) KDS Chit Display Options

Field Description

Serpentine Mode Select the arrangement of order chits on the
display:
• 0 - TSR: Select to arrange the KDS with

the number of vertical columns set in the
Chit Columns drop-down list. Incoming
orders appear starting from the top left
corner, filling the first column, then
spilling into the top of the next column,
and so on. TSR Mode only works on PC-
based KDS Displays.

• 1 - Horizontal: Select to arrange the KDS
with the number of horizontal rows set
in the Chit Rows drop-down list.
Incoming orders appear from left to
right, row by row, starting from the top
left corner and moving across.

• 2 - Vertical: Select to arrange the KDS
with the number of vertical columns set
in the Chit Columns drop-down list, and
using the Chit Rows drop-down list set
the number of rows to appear. Incoming
orders appear starting from the bottom
right corner, moving up and then moving
to the left.

Menu Item Font Select the font size for menu items to appear
on the display.

Order Type Font Select the font size for the Order Type text to
appear on the display.

10. Click Save.

Assign KDS Controller to Revenue Center
1. Select the property, click Setup, and then click RVC Configuration.

2. Double-click the revenue center for which you want to assign the KDS Controller.

3. On the General tab, select the KDS Controller from the drop-down list.

4. Click Save.

Configure KDS Order Device
1. Select the revenue center, click Setup, and then click Order Devices.

2. Double-click the record of an order device to open it.

3. On the General tab, select 1 - Remote from the Device Type drop-down list, select 1 -
KDS from the Primary Device Type drop-down list, and then select the appropriate KDS
Display record from the Device drop-down list.

4. If you have a backup printer, select it from the Backup Device drop-down list.

A backup device can only be configured as a printer device. A configured printer for a
backup device only works for a KDS when the KDS Controller or Service Host is down; it
does not work when the Restaurant Display Controller (RDC) is offline or powered off.
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5. In the Order Device Redirect drop-down list, select the KDS order device that you
selected in Step 4.

6. In the Condiment Sort Type drop-down list, select the method for sorting condiments on
the order device:

• No Condiment Sorting: Select to list condiments in the order in which they are added
to the check by the workstation operator.

• Sort Allowed Condiments: Select to sort only allowed condiments. Required
condiments remain in the same position in which order they were ordered; required
condiments are not sorted.

• Sort all condiments: Select to sort all condiments.

7. In the Menu Item Printing drop-down list, select which items to route to this KDS:

• All Items: Select to route all menu items.

• Only Items with Condiments: Select to route only menu items with condiments.

• Only Items without Condiments: Select to route only menu items without
condiments.

8. (Optional) Change the Language.

9. Click the KDS tab, and then set the following:

Table 18-4    Order Devices KDS Fields

Field Description

First Alert Timeout If you are using the KDS Coursing function,
enter the time in seconds when course 1
items display the first alert and second alert
respectively.
Chits showing a first alert are shaded yellow,
while the chits showing a second alert are
shaded red.

Second Alert Timeout If you are using the KDS Coursing function,
enter the time in seconds when any course
except course 1 displays the first and second
alert respectively.
Chits showing a first alert are shaded yellow,
while the chits showing a second alert are
shaded red.

Primary Runner Chit Printer Select a printer where runner chits print
when orders are bumped from the KDS
device.

Backup Runner Chit Printer Select a printer where runner chits print
when orders are bumped from the KDS
device if the application cannot establish
communication to the primary runner chit
printer.

New Order Notification Timeout (seconds) Enter the length of time in seconds that
newly added items flash on the screen. When
this threshold is reached, items appear
normally.

10. Click the Options tab, and then select the appropriate KDS Options as described in the
following table:
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Table 18-5    Order Devices KDS Options

Option Description

1 - Enable KDS Consolidation Select this option to consolidate identical
items with different modifiers onto one line,
preceded by the quantity on the KDS Display.

3 - Single Item Per Sub-Order Select this option to show every item on an
order on its own chit. This option is enabled
for KDS Menu Item Prep Timing.

4 - Print on Prep Done Select this option to print a runner chit when
the order is marked as Done at a Prep Station.
Only items from this Prep Station print.

5 - Print on Expo Done Select this option to print a runner chit when
the order is marked as Done at the Expo
Station.

6 - Print on All Prep Done Select this option to print a runner chit when
an order is complete at all Prep Stations and
before the order is bumped from the Expo
Display.

7 - Sort by Seat Select this option to sort check detail by seat
number. Deselect this option to have items
display in the order in which they were
ordered.

14 - Multiple Condiments Per Line Select this option to display condiments in a
continuous line on each order chit. Deselect
this option to print each condiment on a
separate line beneath the referenced menu
item.
To compress the condiments into a single
line, you must not print condiments in red.

15 - Display New Order Notification Select this option to make new orders flash
when appearing on the KDS Display.

22 - Match Voids with Order Chits Select this option to have voided order chits
appear directly in front of the order it relates
to.

24 - Print check on Expo Done Select this option to print a check or receipt
at the Runner Chit printer when the order is
bumped from the Expo.

28 - Use Deli Chit Format for Runner Chits Select this option to print the order number
using a larger and bold font on the top and
bottom of runner chits.

31 - Always Show Quantity Select this option to show the quantity for
every condiment ordered on a KDS display,
even if the quantity is 1. When set,
condiments must be added to the check
singly, that is, without using the on screen
numeric key pad for multiple condiment
orders. You must deselect option 1 - Enable
KDS Consolidation for this feature to work.
When deselected, the quantity is implied
from the item preceding it on the order chit.

11. Click Save.
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Configure KDS Highlight Schemes
The following KDS Highlight Schemes are automatically created for every organization:

Table 18-6    KDS Highlight Schemes

Number Name Foreground Color Background Color

1 Black / Yellow Black #FFFF80

2 Black / Red Black #FF0000

3 Black / Blue Black #0080FF

4 Black / Orange Black #FF8000

5 Black / Pink Black #FF80C0

6 Black / Green Black #80FF00

7 Black / Purple Black #FF00FF

8 Black / Olive Black #808000

1. Select the Enterprise, property, or revenue center, click Configuration, and then click
Menu Item Classes.

2. Double-click the appropriate menu item class to open it.

3. In the Kds Highlight Scheme drop-down list, select the highlight color scheme.

4. Click Save.

5. Select the Enterprise, property, or revenue center, click Setup, and then click Order Type
Parameters.

6. Click the KDS Highlight Scheme column arrow adjacent to the appropriate order type,
and then select in which color to show the order type label on KDS chits.

7. Click Save.

8. Repeats Steps 1 through 7 to add more highlight schemes for other menu item classes.
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19
Reporting and Data

The following Simphony Essentials reports are accessible at the workstation. These reports do
not require configuration.

Figure 19-1    Reports Available for TSR
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Figure 19-2    Reports Available for QSR and Bar

Enable VAT Reports
You can show or hide value added tax (VAT) reports on the Reports page in Simphony
Essentials Edition.

1. Select the Enterprise, property, or revenue center, click Setup, and then click Control
Parameters.

2. Click the Options tab.

3. To show the VAT reports, select 71 - Enable VAT Reports. To hide the VAT reports,
deselect this option.

4. Click Save.

Enable Fiscal Reports
If fiscal is installed for customers in the following countries, you can enable fiscal buttons to
appear on the Linux workstations within the location/property.

• Sweden

• Mexico

• Brazil

• Puerto Rico

• Colombia
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• Peru

• Panama

Fiscal functionality is not supported on Android devices.

1. Select the property, click Setup, and then click Property Parameters.

2. Click the Simphony Essentials tab.

3. To enable fiscal buttons for a location, select the country in the Fiscal Location drop-down
list. If the property does not require fiscal reporting, select None.

If you select a fiscal location, the relevant buttons and fiscal functionality are activated for
the selected location.

4. Click Save.
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20
Auditing

You can use the Audit Trail module to view additions, changes, and deletions made through
the EMC and through PMC Procedures. In addition, the Audit Trail reports on successful and
failed logins to EMC, PMC Report takers, Key Manager activity, and Audit Trail purges.

In almost every module, you can audit an individual record or a group of similar records. The
results usually show the record or records at a specific position. For example, consider the
following actions:

1. Add a Tender Media record at Object Number 1234.

2. Change the record’s name to Cash.

3. Delete the record.

4. Add a new record at Object Number 1234.

5. Change the record’s name to MasterCard.

After performing these steps, the Audit This Record results show all five of the changes (not
just the changes for steps 4 and 5). Although the first Tender Media record was deleted, it is
considered “this record” for functional purposes. In short, all records at the same object
number are treated as “this record” and are included in the results.

Use Audit Trail
You must have the privilege to access the audit trial at the Enterprise or property level. When
an Audit Trail report is taken, the activity is logged to the Audit Trail. All Audit Trail Reports
taken are logged as an Enterprise level activity. You can use the Audit Trail two different ways:
to view the history of a specific record or to perform a general search throughout the entire
system.

1. Select the Enterprise or property, click Tasks, and then click Audit Trail.

2. To perform a quick search on the Search tab:

a. Select the timeframe from the All Changes In drop-down list.

b. Click the Run Quick Search button.

When you perform a quick search, the application ignores the values in the standard
search fields.

3. To perform a standard search, enter or select information in the following fields, and then
click the Search button.

Table 20-1    Audit Trail Standard Search Fields

Field Description

Application Select an application from the drop-down list.
Depending on your selection, the Module
drop-down list is active or dimmed. For
example, when you select EMC, the Module
drop-down list shows a list of EMC modules.
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Table 20-1    (Cont.) Audit Trail Standard Search Fields

Field Description

Module Select a module from the drop-down list. This
field is active only when the Application
selection allows a choice of modules.
Depending on your selection, the Object
Numbers field is active or dimmed. For
example, when you select EMC from the
Application drop-down list and Discounts
from the Module drop-down list, the Object
Numbers field becomes active.

(Optional) Object Numbers Enter an object number or range to retrieve
results based on specific records only. Leave
this field blank to have the Audit Trail find all
object numbers.

Operation Select an operation from the drop-down list.
This field is active based on a combination of
the Application and Module selections.

Zone/Location Select a location.
When you open the Audit Trail from the
Enterprise level, this field allows a selection
of any property or revenue centers. When
you open the Audit Trail from the property
level, this field allows a selection of revenue
centers within the property.

Employee Click the Select link, select an employee, and
then click OK. When you select a specific
employee, only changes made by that
employee are included in the results.
Click the Me link to include only the logged-in
employee.

Date Range Select the date range to use to query the
Audit Trail.
Select User-Defined to activate the Start and
End fields.

(Optional) Start and End To narrow your query to a specific date or
date range, select the start and end dates and
times.
Select All Dates to include all dates in the
query.

(Optional) Old/New Values Enter text for use in the query. This can be
useful in finding a specific change to a
record, such as when a Hamburger item was
renamed to Cheeseburger.

Preserve Previous Results Select this option to merge the search results
with the previous search results, instead of
overwriting them. Deselect this option to see
only the results of the most recent search.

4. If the number of results that will be returned exceeds the pre-set thresholds for Audit Trail
results (for example, 10,000 records or more), the application prompts you to confirm the
action.

5. To view the search results for a quick search or a standard search, click the Results tab.
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a. To save the results, click the Save to Disk button, select the directory, and then click
the Save button.

b. To copy the results into another application (such as Notepad or email) without storing
the information, click the Formatted Results button, and then click the Copy button.

6. To manually remove old records from the Audit Trail table in the database, click the Purge
tab.

The Purge tab is visible only at the Enterprise level, and you must have the Purge Audit
Trail privilege.

7. Select the date before which the records will be purged, and then click the Purge button.
For example, if you select 9/1/2016, the application deletes all records from September 1,
2016 and earlier.

Records are deleted based on the UTC date of the Audit Trail record.

In addition to this manually initiated purge, the Data Transfer Service (DTS) purges Audit
Trail records automatically.

Use Audit This Record
1. Select the Enterprise or property, and then open a module that contains at least one

record.

2. Highlight one or more records, right-click inside the first column, and then select either
Audit This Record (single record) or Audit Selected Records (multiple records). The
Audit Record tab shows the information for the selected records.

Alternatively, from the EMC toolbar, click Edit, and then select Audit This Record.

3. To run specific queries on the selected record or records, click the Show Advanced
Options link.

4. Use the same search parameters that are available in the Audit Trail module. See Use
Audit Trail for more information.
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21
Administrator Procedures

This chapter contains information and instructions to perform administrative operations and
tasks. These include:

• Using the Client Application Loader (CAL) to update workstations and software versions

• Submitting data import and export job requests

Client Application Loader (CAL)
The Client Application Loader (CAL) allows seamless distribution, installation, and
maintenance of Simphony Essentials software from a CAL server to all POS client
workstations and service hosts. The CAL stores software packages in the transaction
database, providing a central storage location. The CAL enables POS clients to:

• Obtain a list of configured workstations from the CAL servers.

• Establish unique workstation IDs and network configuration (either Dynamic Host
Configuration Protocol (DHCP) or static Internet Protocol (IP) based on the information
received from the CAL server).

CAL packages are a method of distributing software to the POS clients through an installation
script. Rather than having to manually install software on a POS client workstation, a CAL
package automates this process over the network. This increases the efficiency of deploying
and upgrading POS client software on the workstation.

Update POS Client Workstations
1. The POS client workstation device periodically checks for application updates.

2. The CAL installs the packages according to the deployment order specified in the CAL
Packages module. The workstation device might restart several times.

Update Software Version
Changing the deployment package version causes the new version to immediately start
deploying to the POS client workstation device. Depending on the Action To Take (Install or
Skip), the system may begin immediate deployment.

1. Select the Enterprise, click Setup, and then click CAL Packages.

2. Expand the Simphony subgroup in the left pane, and highlight the CAL package to deploy.

You need to deploy the following packages in the order listed:

a. CAL Client

b. Service Host Download

c. Service Host

3. Click the Deployment Schedules tab.

4. Highlight the CAL package.
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5. Click Change Package Version.

6. In the Choose CAL Package to upload drop-down list, select the appropriate package
version for deployment, and then click OK.

7. In the Deployment Type drop-down list, select the type of deployment:

• 1 - Property/Enterprise: Click the ellipsis point (...) button and select one or more
properties where the package downloads.

If you select this deployment type, the CAL package deploys to all service hosts at the
same time.

• 2 - Specific Service Host: Click the ellipsis point (...) button, and then select one or
more service hosts or POS client workstations where the package downloads.

8. In the Action To Take field, select 0 - Install.

You can configure multiple deployment schedules for the same CAL package. Simphony
Essentials uses the most granular deployment when given multiple deployment schedules.
For example, if you configure a deployment schedule for a workstation and for the
property, Simphony uses the workstation device deployment. If you configure a CAL
package deployment for a property with 0 - Install and a deployment for a workstation
device with 1 - Skip, the CAL package is not installed on the workstation device.

9. (Optional) In the Effective From field, select the start date when the CAL packages
automatically stop installing, and select the stop time (in 24-hour format).

You can use this field to schedule Simphony Essentials upgrades.

10. (Optional) In the Effective To field, select the date when the CAL packages automatically
stop installing, and select the stop time (in 24-hour format).

To keep the installations perpetual, do not set an Effective To time.

11. Click Save.

Install the Android Service Host
The Android Service Host APK is an Android package file used to distribute and install the
POS service host application software on a device running the Android operating system.

• Starting with Simphony Essentials version 19.4, you do not need to use CAL to install,
upgrade, or downgrade the Android Service Host. This section describes the steps
required to install the Android Service Host using Simphony Essentials version 19.3.1 and
later.

• If you are using Simphony Essentials version 19.3 or earlier, you need to use CAL to install
or upgrade the Android Service Host. See the Oracle MICROS Simphony Client
Deployment Guide—specifically Installing CAL on the Android Device—for instructions
to install the Android Service Host using Simphony Essentials version 19.3 or earlier.

Install the Android Service Host APK for the first time on a new Android mobile device. Login
credentials are required for the Simphony EMC and the mobile device in order to install the
Android Service Host for the first time.

To install the Android Service Host on Simphony Essentials 19.4 and later:

1. In the EMC, select the property, click Setup, and then click Workstations.

2. Click the insert icon

on the toolbar.
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3. Enter the Android device name, and then click OK.

4. Double-click the new Android device record.

5. On the General tab, select 2 - Workstation Client in the Type drop-down list.

For Adyen Castles devices, select 7 - Castles Tech S1F2. See Add a Workstation for
more information.

6. Select the Workstation Class for the device.

Smaller devices, such as mobile phones, use 4 - Mobile Table Service Restaurant or 5 -
Mobile Quick Service Restaurant. Larger Android devices, such as tablets, use 1 - Table
Service Restaurant, 2 - Quick Service Restaurant, or 3 - Bar. See Add a Workstation for
more information.

7. Enter the IP adress or host name of the service host where the workstation device
application runs in the Address / Host Name field.

8. Click the Options tab, click the Offline/Misc subtab, and then enable the following
options:

• 17 - Allow Offline Operations

• 45 - Exclude this Workstation from EMC Module Version Validations

9. Click Save.

10. Using the mobile device on which you want to install Android Service Host, access the
Simphony Web Portal (SWP) by opening a web browser and entering the following
address: https://[ServerName]/SimphonyApp.

11. Enter the User Name, Company, and Password, and then click the Login button.

Depending on your organization, there may not be a Company field.

12. Click Downloads.

If you are using a small device in portrait mode, you may have to scroll to the right to see
the Downloads option.
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Figure 21-1    Welcome to Simphony Page with Downloads Option

On some devices, you need to expand a menu to see the Downloads option.
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Figure 21-2    Welcome to Simphony
Page with Expand Icon

Figure 21-3    Welcome to Simphony
Page with Expand Icon and Downloads

13. In the Download Type drop-down list, select Simphony Point of Sale Client Install
(Android).

14. In the Version Download Type drop-down list, select the Simphony Essentials version.

15. Click the Download button to download the .apk file.

16. Navigate to the Downloads folder, locate the AndroidServiceHost.apk file that you
downloaded, and click it to install the application.

17. Click Continue or Install. When the .apk installation is complete, the message App
installed appears beneath a check mark.

18. Click Open in the lower right area, and then click Allow. The Oracle MICROS Simphony
launch page appears briefly.
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Figure 21-4    Oracle MICROS Simphony Launch Page

19. Enter one of the following:

• Cloud Code: Enter the cloud code from your welcome letter to connect to Simphony
Essentials.

If you enter more than five characters, the following message appears: Incorrect Cloud
Code, please try again.
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Figure 21-5    Cloud Details

• Server Name: Enter the URL to connect to the server.

This entry field is free format. If you enter a decimal point, a list of common domain
suggestions appears. You can select one of these domains rather than manually
entering it.
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Figure 21-6    Server Details

20. (Optional) To view the Server Port and EGateway information, click Advanced. This
information may be required for support purposes and should not be changed.
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Figure 21-7    Advanced Server Settings

21. When the Cloud Code or Server Name (entered in Step 19) is valid, the Next button
becomes active. Click Next.

22. In the Enter Simphony Credentials dialog, enter your User Name, Enterprise Name, and
Password, and then click Next. The Service Host APK is authenticated with the Simphony
server.

Depending on your Simphony Essentials system, the Enterprise Name may not appear.
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Figure 21-8    Enter Simphony Credentials

23. If prompted, select the location, and then click Next. Otherwise, continue to the next step.

This page does not appear for Adyen S1F2 devices. If there is only one location, this page
does not appear.
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Figure 21-9    Select Location

24. Select a workstation device that shows either In Use or Available, and then click Next.
When you select a workstation, it is highlighted in blue.

In Use means the device has already been through the CAL process.

This page does not appear for Adyen S1F2 devices.
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Figure 21-10    Select Workstation

25. On the Confirm Workstation Identity page, check the information shown, and then click
Confirm and Start Point of Sale to start Simphony Essentials.
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Figure 21-11    Confirm Workstation Identity
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Figure 21-12    Starting Simphony Essentials

Check and Posting Service (CAPS)
The Check and Posting Service (CAPS) is a required service that runs for each
property. CAPS acts as the bridge between the Enterprise and the property, providing
resiliency and increasing system performance. As workstation operators perform transactions
and other operations on POS clients, CAPS stores the information and then posts in real-time
to the Enterprise. Each property must have CAPS configured because without it, information
occurring on the POS clients does not post to the Enterprise.
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Schedule a Reload Check and Posting Database
You can schedule a full reload of the Check and Posting (CAPS) database for a property. Data
in the CAPS workstation database will be deleted and replaced with new data when the reload
is run, so access to the option needs to be restricted to support users only. (In the Roles
module Actions tab, enable the Tasks action only for the support user role.)

The reload can be scheduled to run once during the next restart. This is a safe time to perform
a restart without affecting POS operations when the database content is being removed and
replaced. The new reload function is an emergency tool used to recover from data issues such
as:

• CAPS being offline when database synchronization changes have been purged

• When a reload cannot be run from the front end (such as for CAPS running as a Service
on a client)

• When the Enterprise Egateway and CAPS are not on the same LAN or VPN

The Reload Check and Posting Database function is performed once on the next restart of
CAPS. This task is not repeated during each startup.

1. Select the property, click Tasks, and then click Tasks.

2. Click the Reload Check and Posting Database button, and then click OK to confirm. The
Reload Database dialog shows the status as Pending or Idle, which indicates the status of
the reload database task. The default value is Idle (not scheduled).

3. To cancel a pending operation, click the button again and confirm the cancellation.

Simphony Web Portal (SWP)
The Simphony Web Portal (SWP) is a website that enables administrators and managers to:

• Import and export Simphony Essentials data

• Download the setup packages (.exe or .apk) for the EMC client and CAL

You can access the SWP using valid Simphony Essentials EMC logon credentials.

Application programming interface (API) documentation is also located in the SWP:

• https://[ServerName][:Port Number]/ImportExportApi/DataService.svc/web/Help

• https://[ServerName][:Port Number]/ImportExportApi/SecurityService.svc/web/Help

The port number is only necessary if the default https port (443) is not used.

Start SWP
You need EMC logon credentials to access the SWP.

1. Change the Internet Explorer Compatibility View settings to allow Import/Export buttons
and features to be visible:

a. Open Internet Explorer, and then press the Alt key.

b. Select Tools and then select Compatibility View settings.

c. Deselect Display intranet sites in Compatibility View.

d. Close Internet Explorer.
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2. To turn off Enhanced security configuration:

a. Open Control Panel, and then select Program and Features.

b. Select Turn Windows features on or off. Server Manager is selected.

c. Click Configure IE ESC.

d. Select Off for the Enhanced security configuration for Administrators and Users, and
then click OK.

e. Restart Internet Explorer.

3. Open any web browser and enter the following address: https://[ServerName]/
SimphonyApp.

4. Enter the User Name and Password, and then click the Login button.

5. On the Welcome to Simphony page, select one of the following pages:

• Import/Export: Import or Export data in comma-separated values (CSV) format. 
Import and Export of Data – Usage contains more information.

• Downloads: Download setup packages for CAL or the EMC client. Download CAL and
EMC Client Setup Packages contains more information.

Download CAL and EMC Client Setup Packages
You can download the setup packages (.exe or .apk) for the EMC client and CAL.

1. On the Downloads page, select the Download Type from the drop-down list:

• Client Application Loader (CAL) – Windows: Select this option to download the CAL
package for a device running the Microsoft Windows operating system.

• Client Application Loader (CAL) – Android: Select this option to download the CAL
package for a device running the Android mobile operating system.

• Enterprise Management Console (EMC): Select this option to download the EMC
client package.

2. Click the Download button.

Update EMC Client
After downloading the EMC client setup package (EMCSetup.exe), you can update the EMC to
the latest Simphony Essentials version. EMCSetup.exe contains all files required by EMC to
function. The InstallShield Wizard for EMCClient starts after the download completes, and it
installs all individual files in the EMCClient folder on the device.

1. Click the buttons to proceed through the InstallShield Wizard.

The default installation path for the EMC client is C:\Program Files\Oracle
Hospitality. You can change this path if needed.

2. Double-click the EMC icon on the desktop.

Figure 21-13    EMC Desktop Icon
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3. Log in to the EMC.

If a newer version exists, EMC automatically downloads the latest files, and then updates
itself. A progress bar indicates the duration of the login and update operation. You will be
prompted to log in again after completion of the updates.

Import and Export Data – Configuration
The Simphony Import/Export Service allows you to:

• Import and export Simphony Essentials application data in a comma-separated values
(CSV) format, to or from spreadsheet applications

• Import configuration data into the Simphony Essentials application database that can be
called by external systems, such as a web service application programming interface (API)

• Export configuration data from Simphony Essentials that can be called by external
systems, such as an on premise inventory management application

The main benefits of this service are:

• Allows you to load configuration data in bulk (for example, making a large number of price
changes for menu items, which reduces the amount of time it takes to configure systems)

• Allows third parties to integrate with customer databases (either self-hosted or hosted
within an Oracle facility), without providing direct access to the application file server or
database

• Allows third parties to build custom interfaces

Import/Export Service Components
The Import/Export Service is comprised of four components, plus a Microsoft Windows service.
The following table lists the components and their capabilities.

Table 21-1    Data Import/Export Service Components

Component Functionality

EGateway URL Provides access to the Simphony Essentials
configuration for self-hosted and Enterprise hosting
center environments.

Web Service (REST API) Assists developers with programmatic integration
and the development of third-party application
programming interfaces (API).

Web Service (SOAP API) The SOAP API has the same functionality as the REST
API, except this web service is constructed using the
SOAP format rather than the REST format.

Simphony Web Portal (SWP) This web application enables you to:
• Import and export data manually
• Download and store data securely in a database
• Export data automatically using the scheduler
• Review the status of completed import and

export jobs
• Access a Help page that provides additional

database and API details
The SWP is available for all users with Simphony
Essentials EMC logon credentials.
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Table 21-1    (Cont.) Data Import/Export Service Components

Component Functionality

Oracle Hospitality Simphony Data
Request Processing Service (Microsoft
Windows Service)

This Microsoft Windows service runs as part of
throttling and scheduling processes (rather than on
demand servicing requests).

Configure Import/Export Service Privileges
You need to configure privileges to allow the appropriate employees to view and access the
Import/Export service from the Simphony Web Portal (SWP).

1. Select the Enterprise level, click Configuration, and then click Roles.

2. Select the role, and then click the EMC Modules tab.

3. Scroll down to the Import/Export setting (located within the File column under the
Enterprise Modules section). The View setting controls the visibility of the Import/Export
service on the SWP toolbar for staff assigned this role.

4. To enable visibility of the Import/Export service from the SWP, select the View checkbox
and Save.

5. To hide the Import/Export service from the SWP, leave the View checkbox unselected. This
is the default setting.

Configure Import/Export Service Date and Time Format
Before configuring the Import/Export Service, you must have the appropriate EMC Enterprise
privileges assigned to you.

1. Select the Enterprise level, click Setup, and then click Enterprise Parameters.

2. Click the Applications tab.

3. In the Default Date Time Format drop-down list, select the date and time format to use
when processing import and export requests.

4. Click Save.

Configure Task Schedules for Export Reliability
When upgrading Simphony Essentials, the Dbupgrade automatically creates two tasks for
Export Reliability: one for Workstation (WS) and one for Check and Posting (C&P), but only if
these tasks have never existed. The tasks are called ‘Daily WS Export Reliability with
recurrence’ and ‘Daily C&P Export Reliability with recurrence’. Default values are used for
these tasks.

New locations created after the upgrade require task schedules to be created manually.
Schedules of an existing organization can be used as a template.

1. Select the Enterprise level, click Configuration, and then click Task Schedules.

2. Insert a new record for one of the following data export reliability tasks:

• Daily WS Export Reliability with recurrence

• Daily C&P Export Reliability with recurrence
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3. Double-click the record to open it.

4. On the General tab, in the Service Type drop-down list, select one of the following,
depending on the export reliability task created in Step 2:

• 7 - Workstation: Select this option for Daily WS Export Reliability with recurrence.

• 8 - Check and Posting: Select this option for Daily C&P Export Reliability with
recurrence.

5. Select 7 - Export Reliability as the Task Type.

6. The Task Data field must be blank. Changing important details of the scheduler (such as
Task Data), results in the scheduler not running.

7. In the Duration (seconds) field, enter 120 seconds. This is the amount of time needed for
the task to run.

8. Click the Select link adjacent to the Time Zone field. Select the correct time zone from the
list, and then click OK.

9. In the Schedule Type drop-down list, select the frequency to run the export reliability tasks
as 4 - Recurring - Daily:

10. In the Duration section, click the Enabled check box, select a Start date of 1/1/2000 and
select No end date.

11. Click the Recurrence tab.

12. In the Daily Frequency section, select Occurs every, and enter:

• 45 minutes starting at 00:05 and ending at 23:10 for the Workstation task.

• 60 minutes starting at 00:15 and ending at 23:20 for the Check and Posting task.

13. Click Save.

14. Repeat Steps 1 through 13 to create the other Data Export Reliability task schedule.

Increase Import File Size
Complete these steps if the Enterprise requires you to import files larger than the default 4MB
size.

1. Browse to [Drive Letter]:\MICROS\Simphony2\SimphonyImportExport\WebApp\ and open
the Web.config file.

2. Add the following line within a comment:

<httpRuntime targetFramework="4.5" />
3. Uncomment the following line:

<httpRuntime targetFramework="4.5" executionTimeout="240"
maxRequestLength="10243"/>

4. Enter the maximum import file size for the maxRequestLength parameter in Kilobits. By
default, this value is set to 10 MB.

5. Save the changes.

Import and Export Data – Usage
Administrators can create and submit data import and export job requests through the
Simphony Web Portal (SWP). Exporting data from one application and importing it to another
saves time for the administrator or manager. This process allows the data to be functional and
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saleable on the new system’s POS client workstations. The Import/Export Service enables
administrators to:

• Import and export data manually

• Export data automatically using the scheduler

• Review the status of completed import and export jobs

• Access a Help page that provides additional database and application program interface
(API) details

Import/Export Prerequisites

• Use a spreadsheet application (for example, Microsoft Excel) that can receive database
export and import requests. Data export requests are usually set to output to files that are
formatted with comma-separated values (CSV).

• Obtain Simphony Essentials EMC logon credentials to access the SWP.

• You must have the privilege to access the database and run the Simphony Import/Export
Service.

• Install a Secured Sockets Layer (SSL) certificate to establish a secure connection.

• Change the Internet Explorer Compatibility View settings to allow Import/Export buttons
and features to be visible. See Start SWP for instructions.

Create Export Schedule
You can extract information from the Simphony configuration database on demand or you can
schedule a recurring export job. You can then import this information into an inventory
management system.

Integrated menu items can be imported and exported at the Enterprise level only. Single menu
item objects (that is, Menu Item Master, Menu Item Class, Menu Item Definition, and Menu
Item Price) can be imported and exported at other levels. Other objects (for example, Discount,
Employee Class, and Major Group to name a few) can be imported and exported at various
levels.

Create a schedule to run an export job on a recurring basis (for example, weekly or monthly).
You can create schedules only for exporting files. You cannot create a schedule to import files.

Perform the following steps in the Simphony Web Portal (SWP):

1. Click Import/Export.

2. Click Schedules.

3. Click Add Schedule.

4. In the Name field, enter the export schedule name.

5. Select a Start Date when the export begins.

6. In the Time of Day field, enter the time when the export runs (use 24-hour time in the
format hh:mm).

7. Select the frequency of the export schedule:

• To run the export on a specific day each week, select one or more days of the week.
For example, to set the export to occur every Tuesday, select Tuesday.
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• To run the export on a specific date each month, enter one or more dates (separated
by commas) in the Dates to Run field. For example, to set the export to occur on the
3rd and the 15th day of each month, enter 3, 15.

8. Select Active, and then click Create.

9. To disable an active schedule from the Schedules page, click the Disable link adjacent to
the appropriate schedule.

You can deactivate a schedule, but you cannot delete it. When you deactivate a schedule,
export jobs associated with that schedule do not process.

Generate File to Export
Perform the following steps in the Simphony Web Portal (SWP):

1. Click Import/Export.

2. On the Import/Export Request Parameters page, select the Export option.

3. In the Hierarchy Selection area, select one or more hierarchies (Enterprise, property, or
revenue center), and then use the arrow buttons to include hierarchies in the export.

Select Include Inherited prior to selecting a hierarchy to include children in the selection.

You can export an integrated menu item (fully configured menu items) Object Type at the
Enterprise level only; if you select the property or revenue center levels, you will receive an
error later.

4. In the Parameter Selection area, select the Language in which to export the data.

5. (Optional) In the Date Since field, select the date from which to export information.

The Date Since applies to both new and modified information. For example, select
08/01/2020, to export information that was new or modified since August 1, 2020. For the
most recent export, select the current date.

When a date is selected in the Date Since field, any record for that object that has been
changed (either directly or as a result of another update) will be exported once, no matter
how many times it has been changed since the selected date.

6. Select the Format for the export file:

• Excel Compatible CSV (ANSI): Select this option to edit the file using Excel, Notepad
or Notepad++. This option is only available for the English language.

• International CSV (UNICODE): Select this option to edit the file using Notepad or
Notepad++. This option is available for all character sets and languages.

• Pipe Delimited (UNICODE): Select this option to edit the file using Unicode. This
option is available for all character sets and languages.

7. (Optional) Change the Schedule for your export.

• To export the file immediately, ensure that the Schedule field shows Process
Immediately. This is a one-time export request.

• To schedule the export, select the recurrence and time schedule from the Schedule
drop-down list.

If no schedules exist, nothing appears in the Schedule drop-down list. See Create Export
Schedule for more information about schedules.

8. (Optional) Enter the Request Name.
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This can be a description of the activity (for example, Exporting Menu Items for Enterprise
A).

9. Select the type of information to export from the Object Type drop-down list.

The information in the Mandatory Columns field automatically appears based on the
Object Type you selected. The column names appear in the exported file and show the
type of data to be exported. You cannot change the values in this field.

10. Select the Data Level:

• Selected Hierarchy: Select this option to export only the current level of hierarchy. For
example, if you selected the property in the Hierarchy Selection without Include
Inherited to export discounts, the export only includes discounts that are created for
this property, not those created at the Enterprise level or revenue center.

• Selected Hierarchy With Ancestors: Select this option to export the current level of
hierarchy and the higher levels (parent level). For example, if you created discounts at
the property level, selecting this option exports discounts created for the property and
the Enterprise levels.

• Selected Hierarchy With Inherited: Select this option to export the current level of
hierarchy and the lower levels (child levels). For example, if you created discounts at
the property level, selecting this option exports discounts created for the property and
the revenue center levels.

• Selected Hierarchy With Ancestors And Inherited: Select this option to export all
levels of hierarchy (for example, Enterprise, property, and revenue center levels).

11. In the Columns field, select the information to export. Use Ctrl + Select or Shift + arrows
to highlight multiple column names.

All columns are selected by default. The information in the Columns field is a subsection
of the Object Type selection.

12. (Optional) In the Object Range Filter field, enter the object number of the Object Type
you selected in step 9.

You can also enter a range of object numbers using a dash between the numbers.

13. (Optional) In the Sort By field, add one ore more sort options for the results.

14. Click the Submit Request button.

15. To refresh the page, click the Refresh link.

16. To view scheduled exports, click + adjacent to the ID and the Request Name.

17. Click the Download link for the export request, and then click the Open button.

18. (Optional) Change the file as necessary (insert, update, or delete) using a text editor, such
as Notepad, rename the file, and save it in a different location.

When you export a file, the application assigns SimphonyExport.csv as the file name.
Rename each exported file to keep them organized before importing the files.

Prepare Single Menu Item Data Files for Import
Because there are relationships between the databases and menu items, you must import
single menu item data files in a specific order. Importing single menu item data files out of
order causes the import job to fail and an inability to add the new menu items on the POS
client workstations. If you are importing integrated menu items (fully configured menu items),
skip this section.
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After you export the required menu item data files but before you import the files, ensure that
certain values contained in the prospective import files match in specific columns and rows.

1. Open the export file that contains the Menu Item (MI) Master data, and record the value of
the Id column and the corresponding MenuItemName for each menu item to be imported.

2. Open the export file that contains the MI Class data.

a. Record the name of each MI Class located in the Name column. Remaining on the
same row, scroll to the ObjectNumber column and record the corresponding values
there, which are associated with each MI Class name.

b. Review the prospective MI Class import data to ensure that all fields are configured in
order for the menu items to function as expected.

3. Open the export file that contains the MI Definitions data.

a. Enter the ObjectNumber values from the MI Class data file into the MenuItemClass
column for each MI Definition.

b. Enter or verify that the values in the MenuItemMasterId column in the MI Definitions
file match the values of the Id column in the MI Master data file. This holds true for
menu items that have multiple definitions.

c. For items with multiple definitions, ensure that the DefinitionSequence column is
numbered in sequential order.

4. Open the export file that contains the MI Price data.

a. Enter or verify that the values in the MenuItemDefID column in the MI Price data file
match the values of the Id column in the MI Definitions data file. This holds true for
menu items that have multiple prices.

b. For items with multiple prices, ensure that the PriceSequence column is numbered in
sequential order.

Import Menu Item Files
The default maximum size of an imported file is 4 MB.

Perform the following steps in the Simphony Web Portal (SWP):

1. Click Import/Export.

2. On the Import/Export Request Parameters page, select the Import option.

3. In the File Path field, click Browse, select the file to import, and then click Open. When
you import single menu item data files, do so in the following order:

a. Menu Item Master (Select this file first, and then continue with Step 4.)

b. Menu Item Class

c. Menu Item Definitions

d. Menu Item Price

4. Select the Language.

5. Select the Format for the file:

• CSV: Select this option to edit the file using Excel, Notepad or Notepad++. This option
is only available for the English language.

• Pipe: Select this option to edit the file using Unicode. This option is available for all
character sets and languages.
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6. (Optional) Enter the Request Name.

This is a description of the activity (for example, Importing Menu Items for Property A).

7. Select the type of information to import in the Object Type drop-down list.

The information in the Mandatory Columns and the Columns fields automatically
appears based on the Object Type selected. The column names appear in the imported
file and show the type of data to be imported. You cannot change the values in these
fields.

8. Click the Submit Request button.

9. Click the Download link for the import request, and then click the Open button.

If you see an error in the Download Link column for the import request, click Help, scroll
down to the Object Info section and locate the object type you selected. Click + adjacent to
the object type. The Additional Notes column indicates the reason for the error.

10. Click the Refresh link to refresh the page.

11. Save the imported files using a text editor, such as Notepad.

12. Repeat Steps 1 through 11 to import each menu item data file (Menu Item Master, Menu
Item Class, Menu Item Definitions, Menu Item Price).
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